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Foreword 

Malawi Railways is presently undergoing a process of restructuring i order to become moreefficient, viable aid commercially oriented. The railway and Government of Malawi haverequested technical and financial assistance from a multi-donor group, led by the World Bank,
to assist with continued restructuring of Malawi Railways. 

In advance of a final joint donor appraisal mission, expected to occur in April 1994, a consulting
team fielded by Abt Associates Inc. was requested to undertake a number of technical analyses
in support of project preparation and appraisal. 

The consulting team was funded by USAID/Malawi through the Privatization and DevelopmentProject, in which Price Waterhouse is the prime contractor and Abt Associates is asubcontractor. Technical direction was provided to the team by USAID/Zimnbabwe (specifically,
SARP -- the Southern Africa Regional Program) and the World Bank's Task Manager, inaddition to USAID/Malawi. The in-country work was carried out duing March, 1994.
 

The consulting team consisted of: 
 Mr. Anthony Davis, Team Leader (Abt Staff); Ms. NoreenMcCarthy, Legal Expert (Abt Consultant); Ms. Jill Murdoch, Human Resources/Institutional
Expert (Abt Consultant, on loan from Transmark); Mr. George Howson. Procurement Expert(Abt Consultant); Ms. Ellen Bobronnikov, MIS Expert (Abt Staff); Dr. Gregory Michaels,
Environment Expert (Abt Staff); and, Mr. Samir Zaman, Social/Impact Specialist (Abt Staff). 

Preliminary drafts of the Technical Working Papers which resulted from the above analyses are
contained in this volume. They are presented in the following order: 

1. Legal Review and Assessment; 

2. Human Resources Development Report; 

3. Procurement Report; 

4. Management Information Systems Development and Training; 

5. Environment Assessment; and 

6. Beneficiary Impact Assessment. 
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TECILNICAL WORKING PAPER 

LEGAL REVIEW AND DRAF' AGREF,ENTS 

I. INTRODUCTION 

In support of project design and appraisal of the Malawi Railways Restnicturing Project.a Consultant Team fielded by Abt Associates, Inc. was asked to prepare selected technicalworking papers. One of the papers requested involved an appraisal of the legal aspects of
restructuring the railway. This report outlines the findings of that appraisal. 

11. SCOPE OF WORK 

The main tasks of the legal component of the studies included consideration of three areasof review. The first concern was appraisal and revision of the railway's present corporatestructure, with a view toward removing it as a statuary body and preparing it future privatesector participation. The second was a Memorandum of Understanding between the Government
of Malawi and the railway regarding the operation of the railway as a commercial enterprise.The third task involved a bi-lateral agreement between Malawi and Mozambique concerning
cooperative operation of the two railways. 

Il. METHODOLOGY 

To prepare this appraisal, Noreen McCarthy, a Senior Legal Expert, worked on theproject in Malawi for a two-week period, following an initial preparation period in Washington,D.C. During the time period in Malawi, Ms. McCarthy worked closely with Mr. Savjani,
counsel to the railway and expert on Malawi corporate law. The legal review task was
conducted under the direction of the Team Leader, Anthony Davis of Abt Associates. 

As part of the analysis, a range of interviews were conducted with railway management,
government officials from the related agencies, and one reprczentative from another statutorybody in the transportation sector, Air Malawi (See, Appendix C: List of contacts). In addition,a comprehensive review of relevant laws was undertaken to ascertain the present legalenvironment and to evaluate the necessity for legislative amendments, if any (See, Appendix B: 
Bibliography). 



Each of the three areas of appraisal are discussed in detail below. 

IV. CORPORATE STRUCTURE 

Malawi Railways has the objective of becoming commercially viable and a self-supporting
enterprise on core railway operations. To facilitate this, the railway is considering amendingits corporate structure to allow for greater autonomy and efficiency, and to provide the basis foreventual private sector participation. In this respect, corporate structure refers to the legal statusof the company, its articles of association, its decision-making powers and legal reportingobligations, and the overall legal environment in which it operates. Accordingly, the ConsultantTeam has reviewed the corporate structure and relevant laws as they currently exist andevaluated possible alternatives which may be more conducive to achieving the company's goals. 

A. Present Structure 

Malawi Railway Limited is currently a private limited company incorporated in theUnited Kingdom, and a wholly owned subsidiary of the Malawi Railway Holdings Company,
a corporate body created in Malawi by statute. The holding company holds virtually all of theshares of Malawi Railways Limited (417,675) on behalf of the Government of Malawi. 
Nominees hold an insignificant amount. 

Virtually all of the shares of the holding company are in turn owned by the Government
of Malawi, as expressly provided in the Malawi Railway Hold'igs Company Act. 

Malawi Railway Limitec wholly owns the Central Africa Railway Company Limited,which is a separate legal entity incorporated in the U.K. and is effectively dormant. This company owns only a short section of the track within Malawi that is south of Nsanje and is no 
longer operating as separate company. 

The fact that Malawi Railway Limited is incorporated as a private company limited byshares means that it may restrict the right to transfer its shares, that the maximum number ofits members (shareholders) excluding employees is 50, and that it may not make a publicinvitation to purchase shares. In addition, liability of the members is limited to the amount of 
unpaid shazms. 

Malawi Railway Limited is also a statutory company under the jurisdiction of theDepartment of Statutory Bodies. Although Malawi Railways Limited was not created by statute,it was declared to be a statutory body by the Department of Statutory Bodies in the Audit andFinance Act (Cap. 37:01). In practice, it is treated as a statutory body and heavily controlled 
by the Government. 
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With respect to its reporting requirements, the management at the railway report to the
Board of Directors. The Board of Directors report to the Department of Statutory Bodies.
the Department of Statutory Bodies 

and 
in general reports to the Office of the Cabinet and thePresident. Some issues, such as the sale of land or assets, are customarily decided at the level 

of the Office of the President. 

With respect to its financial status, Malawi Railways Limited is currently insolvent, but,
has not declared bankruptcy or received any court order to liquidate. 

Implications of the Present Structure 

Under the present legal structure and statutory framework, the railway is owned andcontrolled by the Government of Malawi and limited in its ability to operate as an independent
commercial entity. Decisions with respect to day-to-day operations and long-term development
plans are primarily made by the Government or must be approved by the Government. 

This is by virtue of tle fact that all of the shares of the railway are held on behalf of the
Government through a statutorily created holding company which gives significant control to the
Government. This statute effectively acts as the legal instrument for defining the Articles ofAssociation and gives details on who the Directors shall be and what their obligations are.
Government is also involved in the decisions of the company by the far-t that Malawi Railways
Limited was declared a "statutory body" under the direct jurisdiction of the Department of
Statutory Bodies and is heavily regulated by that Department. 

The following identifies the specific laws which directly affect the railway's ability to 
operate commercially. 

(i) Malawi Railway Holdings Company Act. 

Through this statute, Parliament instructed the Government to transfer all of its present
and future shares in Malawi Railway Limited to Malawi Railway Holdings Company. Itcontains numerous provisions regarding incorporation and management of the company.
Notably, the Chairman and Board of Directors are to be appointed by the "Minister" and the
Board must include at least three Government representatives. (The "Minister" is not defined
in this statute, however the Audit and Finance Act defines it as the person "charged by the
President"). The Board is specifically required to perform its functions "subject to the special
or general directions of the Minister" and is precluded from exercising any borrowing powers
without prior written consent of the Minister. 

(ii) Audit and Finance Act. 

Malawi Railway Limited is specifically declared to be a statutory body under this law.
The Act defines a statutory body as any corporate body declared to be by the Minister.one
Special financial reporting is required under the law such as bi-annual reports of profit and loss, 
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as well as major expenditures. Government funding is provided to the railway through this act. 
and any surplus funds are returned to the Government. 

Because Malawi Railways Limited is a statutory body. the Department of Statutor-
Bodies determines the members of the Board of Directors, the tariffs to be charged (although 
as of last year this was relaxed), the routes and schedules, whether it provides passenger or
freight services, who its management will be. how much they will be paid and what pay scale
will be employed by the company for all employees. With respect to senior staff at the railway.
the Board of Directors must first receive approval of the Department before it can extend an 
employment offer. 

(iii) Statutory Bodies (Control of Contracts). 

This law deals with Government control of commercial contracts involving statutory
bodies. Malawi Railways Limited is included on the schedule of statutory bodies attached to this
law. Te statute states that any company, whether incorporated in Malawi or not, may be 
identified as a swtutory body. 

This law prohibits the railway from entering into any commercial contract which the
Minister has deemed to be "in the public interest" to control, without prior written approval of 
the Minister. The only standard for disapproval is that the Minister determines that the contract
would not be "in the public interest." Even with respect to those contracts which are approved,
the Minister may attach any conditions concerning the parties or the terms as he deems to be "in 
the public interest." 

There are criminal penalties (MK2,000 or two years in prison) for any company officer
who enters into a contract without prior written approval of the Minister. The contract is void 
with respect to the other party and cannot be enforced. 

Evaluation 

The current structure facilitates Government subsidization of railway's activity and its
ability to raise capital and assume debt. However, it also provides ample scope for the railway
to be run on non-commercial basis at the discretion of the Government and enables the 
Government to make many of the railway's business decisions on a non-commercial basis. As
noted above, for example, the standard used for approval of commercial contracts is stated as
"in the public interest." The Board of Directors, and consequently the management, are
required to act in accordance with the Minister's direction, regardless of the commercial 
consequences. The railway's first obligation could be interpreted as being to provide a public
service as directed by the Government, and not to operate as a commercial enterprise. 

In particular, the railway's corporate structure and the relevant legal/regulatory
framework in which it operates affect several key areas of the railway's operation. These
include the freedom to pay competitively, the freedom to charge based on a cost recovery basis, 
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and the freedom to choose profit-making routes. 

With respect to labor, for example, most of the work force is subject to the Government 
pay scale and regulated by the Minister. Flexibility for providing remunerative incentives tomaintain and attract a skilled work force is absent. Broader discretion with respect to financialincentives, such as merit-based pay and profit sharing, would enable the railway to make
decisions which may better attract and maintain a qualified and efficient work force. 

Another important aspect which is heavily regulated by Government under the currentstructure concerns ratesthe and services provided by the railway. While historically theGovernment has controlled the tariffs charged by the railway, the Government has recently liftedits control according to railway management, and now permits the railway to establish its own 
rates. Any corporate restructuring should ensure this is maintained. 

With respect to routes, under the present structure the Government determines the routes
and schedules of the railway. The railway does not have the ability to concentrate on profit­making routes or to provide only those services which make commercial sense, to the exclusionof unprofitable or "social good" services. A corporate structure which gave the railway
discretion over its routes, and compensated the railway for any loss specifically related toproviding services at the Government's direction, would be more conducive to operating in a 
commercially viable manner. 

Other important areas of autonomy not realized by the present structure include decisionmaking-power over the selection of the Chairman, nembers of the Board of Directors, top andmid-level management, long-term investment plans and other financial issues. 

B. Options for Alternative Corporate Struct re 

In the section, four alternative corporate structures are identified and evaluated. 

OptionOne-- Reinorporateand Vest the Assets 

The first option for the corporate structure is to dissolve the current entities (MalawiRailway Limited and Malawi Railway Holdings Company), incorporate a single new private
corporation in Malawi and vest all of the U.K. company's assets in the new corporation by Act
of Parliament. All of the shares would still be owned by the Government. 

Advantages 

There are several advantages to this proposal. It eliminates the statutory holdingcompany and the railway would no longer be directly subject to the requirements of that statute.
The company would be incorporated in Malawi and its connection to the U.K. is severed. Theassets of the old company would be simply vested in the new company by an Act of Parliament 
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which declares them to be transferred, eliminating the need for numerous conveyance documents
for the many parcels of land and other assets owned by the railway through freehold, leasehold or possession. Finally, it gives the appearance of starting over with a clean slate, and may act as a catalyst for undertaking significant financial restructuring earlier than might otherwise be 
the case. 

Disadvantages 

There are several disadvantages to this option. All shares of the company would bedirectly owned by the Government, instead of through a holding company, giving the appearance
at least of "nationalizing" what had technically been a private company. 

Severing connections with the U.K. has nominal legal significance. At present therailway simply files fairly straightforward returns. However, there are strong feelings in theGovernment and the railway that it should be a domestic concern and reincorporation in Malawi 
would accomplish this. 

Since Malawi Railways Limited is an "external" company under the Companies's Act,1984, it must declare solvency before it can be dissolved. In essence, all of its creditors mustbe paid before it can go out of business. Thus, simply vesting the assets in a newly created company does not address the railway's financial problems. Vesting the assets also does notprovide a tax benefit since the railway would in any case be exempt from taxes in accordancewith both the Stamp Act and the Railway Act. In addition, transfer taxes and other outstanding
taxes could simply be waived since the property belongs to the Government. 

Significantly, the company would still be a statutory body and subject to regulation under
the Railway Act. 
 Thus, the main issues as outlined in the previous section concerning extensive
Government control would still exist, and this restructuring would not ensure that the railway
would operate in a commercial way or provide a basis for private sector participation. The onlynew autonomy gained would be from the Memorandum of Understanding (Section V). 

The Case of Air MaNlawi 

A review of Air Malawi's corporate structure indicates that the same approach (ie, OptionOne) was taken when it was restructured and the results may be instructive here. A new company was formed, the assets were vested by Act of Parliament, and the Government owned 
100 percent of the shares in the new company. 

The results to date are not very encouraging. While the stated original intent was tocreate a more autonomous, commercial entity, that goal has not largely been achieved inpractice. The airline is Government owned and controlled today and still considered a statutorybody. It does not set its own rates or appoint its own directors, and it is not a profit-making
company. Only one of its directors is a business person, the others are Government 
representatives or non-business private persons. 
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However, the airline has a better chance to operate commercially than other statutor'bodies because it must comply with stringent international regulations and compete for skilled
labor in the international market. Consequently, it is allowed to pay competitively and is given
ample funds from the Government to purchase expensive up-to-date equipment. These elements 
may not be present in the case of the railway. 

Evaluation 

The proposal to incorporate a new company in Malawi and vest the assets does not assure
that the railway will operate commercially or efficiently. It also does not the companymove
closer to privatization or incorporate elements of privatization. If anything, the relationship toGovernment is closer in that they own the shares outright and more directly instead of through
a holding company. Ownership of land and other assets is not clarified because all assets aretransferred without conveyance deeds. The cost and time to reincorporate and enact vesting
legislation is likely to be significant under current political conditions. The company would stillbe a statutory body and subject to extensive control by the Government. The Board of Directors
and management will still be appointed by the Government. Except to the extent agreed uponin the Memorandum of Understanding, no additional autonomy is given the railway. Finally,
a specter is raised that once restructured in this way, commitments to operating as a private 
company in the near term may be diminished. 

Option Two -- Reincorporate in Malawi and Railway Holds Its Own Shares 

A second option is to establish a new company in Malawi and have the company hold
its own shares until it can be sold to a private person/concern or the shares made available to
the public. The assets could be transferred by conveyance or by Act of Parliament.
Conveyance might be preferable to ensure proper and clear title exists, thereby making theproperty more attractive to a private purchaser. The Government would no longer own the
shares outright. However, some arrangement for equity in the new company may beappropriate, particularly as Government may want to convert debt to equity.' The company
would be declared to no longer be a statutory body, subject only to safety regulations under the
 
Railways Act.
 

This is the most progressive aiternative but may not readily meet with Government
approval. There seemed to be strong opposition in Government that it should ever relinquish
more that 49 percent of the shares in the railway. However, it is also the structure most likely
to ensure continuation of the company's momentum towards privatization. Railway management 
are likely to be favorably disposed to this option. 

1/ The Consultant Team was informed that Government already hasthe intention of converting debt to equity. However, an exact timetable has not been established nor the exact amount of debt to be
converted determined.
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Advantages 

There are many advantages to this proposal. It provides a structure most conducive tooperating a commercial enterprise. The railway would have the freedom to pay competitively.
charge based on cost. choose profitable routes, determine its own investments, and conduct acompetitive and efficient operation. Arrangements could be made to provide services at thedirection of the Government and to be compensated for resultant losses. The Board of Directorsneed not be predominantly Government representatives, but instead private well-established
business persons, and could maintain true executive powers to make decisions and appoint other
members of the Board anid senior level employees. 

It also is the most consistent with Government's stated commitment to commercialdevelopment in the Investment Development Act, and may enable the company to take advantageof changes from the new Capital Markets Act. It would provide the railway with time to find a competitive and appropriate buyer, perhaps attract a foreign partner for a joint venture (asgenerally encouraged by the Investment Development Act), or sell stock on the open market.Thus, it should be consistent with the spirit of the Government's stated policies regarding private
sector development more generally. 

Disadvantages 

The primary disadvantage is that it may be hard to convince the Government of thisalternative. As noted earlier, it would mean relinquishing more than 51 percent of the shares,
and there appears to be strong opposition to doing this. 

It may also require legislative amendment, since under the current law a company maynot own its own stock. However, Article 73 of the Companies Act, 1984, provides that acompany may own its own shares for up to twelve months when it acquires the shares of another company. While subject to interpretation, this provision indicates that self-ownership is notstrictly ruled out. Furthermore, in this respect, Malawi law is considered out-dated. The U.K.and the U.S. already have amended their laws to allow a company to hold its own shares. Thus,it would be a progressive move in a positive direction and enhance the overall investment climate
in Malawi. Any delays resulting from legislative amendment, therefore, may be worth it in this 
case. 

Finally, the exact mechanism by which the railway holds its own shares needs tc be givencareful consideration. Initial outright ownership of the shares by management and/or workersis not advisable or practical. In the first instance, an arrangement should be sought whereby theshares are held in escrow, or as private Treasury stock, or a similar instrument. 



Option Three -- Dissolve the Holding Company: U.K. Company Holds Shares 

The third alternative is to dissolve the holding company and transfer the shares back toMalawi Railways Limited. Again, the Government could be compensated by an equity
arrangement. This would remove the restrictions of the holding statute and Governmentownership. To be fully effective, Malawi Railways Limited would also have to no longer be 
a statutory body. 

Advantages 

This achieves some of the same benefits as Option Two. The company is givenautonomy and freedom to operate in a commercial manner. It has an additional benefit of notrequiring amendment of legislation, since under U.K. law a company may own its own shares. 

Disadvantages 

The strongest disadvantage is that it still is not a Malawi company. Given the strongsentiment in favor of domestic incorporation, it may not be worth the trade-off to reincorporate
in the U.K., simply in order to avoid changing the Malawi law which prohibits a company to 
hold its own shares. 

Option Four -- Restructure without Reincorporation 

A final option is to pursue the railway restructuring plan without reincorporating the company in Malawi or dissolving the holding company. This would be appropriate if a private
sale is the end goal and restructuring is viewed only u; temporary, in any event. Since theMemorandum of Understanding is intended to allow the Company to operate commercially,
cosmetic restructuring (which would result under one of the other three options if the railway
is not in fact given more autonomy but simply reincorporated) accomplishes little and is likely

to be costly and time-consuming.
 

In addition, as a survey has been concluded which largely determines what property
belongs to the railway and its value', further assurance in this respect for a private buyer maybe unnecessary. Also, a sale to a private buyer would most likely include a plan to form a new
corporation which would make reincorporation at the current time somewhat redundant. 

2/ The survey addresses a significant share of the railway's
real estate assets. However, some further work will be needed tobuild consensus for the basis of valuations, to include all assets,and to conclude unresolved issues (e.g., 
 compensation for
properties transferred to the Port Authority.)
 

9
 



Advantages 

The advantage is that this option saves time and money which, if changes through another
option are cosmetic only. is a practicable approach. It also eliminates the need for vesting assets 
through an Act of Parliament and retains at least the appearance of some distance between 
Government and Malawi Railways Limited, i.e. it does not look like the company and its assets 
were nationalized. 

Disadvantages 

The disadvantages are that it does not eliminate Government control or involvement and
does not move the company towards privatization, except insofar as restructuring will make the
railway more attractive to a prospective purchaser. It also does not satisfy the sentiment that 
the railway should finally be a Malawi company incorporated domestically. P should at best be 
considered a temporary solution. 

C. Competition Concern 

To the extent that tariff control is lifted under corporate restructuring, the railway is 
likely to have a significant amount of monopoly power on certain routes and with respect to
certain services. At present, Malawi has no competition commission and no law which prohibits
abuse of monopoly power. Thus, except insofar as other modes of transportation serve to
provide competition and to keep the railway's tariffs competitive, the railway will be free to 
charge whatever tariffs it chooses without any limitation. 

Addressing this concern will not be simple. The railway should be encouraged to operate
in a way that maximizes profits and responds to market forces. This is especially true at the 
beginning stages of its recovery. The railway's own history is evidence of how stifled a
company's incentive to be efficient can become if its potential to maximize profits is curtailed. 
Thus, any attempts to dictate tariffs should be avoided. 

Nevertheless, it may be appropriate to come to some agreement as to a rate formula, such 
as cost plus a maximum stated rate of return, in those areas hi which it is unavoidable and 
practicable to have a natural monopoly. As quid pro quo for the monopoly power, the railway
should agree not abuse such power in its rating policy. ' 

3/ A similar formula should be used for services provided at
the Government's direction 
-- the railway is compensated for its

losses up to the cost of providing the services plus 
a rate of
 return necessary to cover general operating expenses. see,

Memorandum of Understanding, Paragraph 6. Tariffs 
for services
provided under a natural monopoly situation are addressed in

Paragraph 7 of the Memorandum of Understanding.
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Further attention needs to be given this issue. It may not be resolved until the
restructuring is underway and the exact nature and structure of the markets in which the railwavwill operate arc known. At present. it is an issue that needs to be raised and kept in mind 
throughout the process. 

D. Conclusion 

The present corporate structure may facilitate distribution of government funds to therailway, but falls short of providing an appropriate framework for restructuring and participation
by the private sector. Under this structure, Malawi Railways Limited is owned, directed andcontrolled by the Government of Malawi, as a statutory body and as a wholly owned subsidiary
of a statutorily created holding company. 

All of the options presented have advantages and disadvantages. In terms of moving in 
a positive direction toward private sector participation, Option Two may provide the best basis
in the long-run. It would establish a new private company in Malawi whose shares were notheld by the Government, but rather by the company itself, and available for private sector
purchase at any time. Although it may require legislative amendment, it would be a progressive
change which would provide a means of facilitating other parastatal companies in the future to 
move in the direction of privatization. The disadvantage is that Government may not readily
approve of this option. In any event, further development of this possibility would be valuable. 

Option One may encounter the least resistance from Government and be a viable
alte,-,iative. However, it also runs the risk of being no more than a cosmetic change if it isviewed as permanent and not merely a holding position during restructuring, in which case it
is questionable whether time and money should be spent doing it. If cosmetic only, it may be 
more practicable to maintain the status quo, as discussed in Option 4. Either option would still
provide the mechanism for facilitating financial support from Government and/or donors. 

Regardless of the technical structure adopted, the key qualifications of any plan are to 
remove the company as a statutory body and allow it the freedom to determine the level oftariffs, choose the services and routes offered, attract and maintain skilled workers and qualified
management through competitive pay and other financial incentives, and implement an executive
board of directors with responsibility and incentive to operate on an efficient and commercial
basis. A corporate structure which embodies these factors will make a more competitive
enterprise and be more attractive to private investors. 
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V. 	 MIEMORANDU.M OF UNDERSTAND-NG 

The objective of the Malawi Government and the railway is to establish an "arms-length"
relationship which better enables the railway to operate on an independent and commercial basis.
The Memorandum of Understanding (MOU) will set forth the nature of this relationship and
affirm each party's commitment to it. A draft Memorandum is attached as Appendix A. 

In particular, the Memorandum will set forth the following essential elements. 

Railway Obligations: 

i. 	 To provide services on an efficient and cost-effective manner. 

ii. 	 To meet stated operational targets and stated rates of return. 

iii. 	 To implement a revised corporate organizational structure, revised capital 
structure and manpower reduction plan. 

iv. 	 To determine its rates on a cost based formula and not discriminate with respect 
to users. 

v. 	 To provide certain services at the direction of the Government with the 
understanding that the Government will compensate railwaythe for resultant 
losses as agreed upon. 

vi. 	 To not abuse monopoly power or purposely engage in anticompetitive conduct. 

vii. 	 To take reasonable measures to comply with international agreements to which 
the Government is a party. 

viii 	 To file progress reports with the Government on a periodic basis, reflecting 
financial and performance conditions. 

Government Obligations: 

i. 	 To provide support facilities and other resources as needed by the railway to 
carry out its revised corporate organizational structure and capital structure. 

ii. 	 To allow the railway sole discretion with respect to tariffs, routes, types of 
services, schedules, terms and conditions of providing rail transport, and 
compensation to employees and selection of staff. 
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ill. 	 To compensate the railway for losses incurred in providing services at the
direction of the Government for passenger services on the core routes, and for
staff on routes West of Lilongwe and south of Limbe. 

iv. 	 To compensate the railway for losses incurred as the result of providing services 
at the direction of the Government and in accordance with bilateral agreement
with Mozambique. 

V. To allow the railway freedom to undertake investments in support of its 

operations. 

vi. 	 To assure access to import licenses necessary to maintain its operations. 

vii. 	 To allow the railway to freely enter into commercial contracts as necessary for 
the operation of the railway, notwithstanding the provisions of the Statutory
Bodies (Control of Contracts) Acts, Cap. 37:01. 

The Memorandum of Understanding takes on an even greater significance in light of the
fact that few options for altering the railway's corporate structure (see Section IV) are promising
with regarding to engendering greater autonomy or commercialism at the railway or providing 
a strong basis for private sector participation. 

Selected technical details in the MOU will require further specification, especially withregard tt: the operational performance set for the railway and the measurement of profitability 
or return on capi'al employed. 

VI. 	 REVIEW OF BI-LATERAL AGREEMENT PROVISIONS 

In this section, the agreement between Malawi Railways Limited (MR) and the Direccao
Nacional dos Portos E Caminhos de Ferro (CFI) of Mozambique are reviewed with respect to
cooperation on inter-rail services between Malawi and Mozambique along the Nacala and Beiracorridors. The objective of the two parties is to establish a cooperative agreement and toachieve efficiency of operation with respect to rail transportation between the two countries. 

Present Agreement 

There is presently in force an "AGREEMENT OF COOPERATION ENTERED INTO
BETWEEN THE DIRECCAO NACIONAL DOS PORTOS E CAMINHOS DE FERRO ANDTHE MALAWI RAILWAYS LIMITED", which 	was dated and signed by the two parties onOctober 22, 1984, in Limbe. This agreement is fairly comprehensive in nature and contains numerous provisions regarding cooperation and mutual assistance, fimances, rates, use andmaintenance of equipment and vehicles, accounting procedures, liability, and railway personnel. 
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The execution of this agreement has not been fully successful in achieving the cooperativerelationship envisaged. Two significant issues arose with respect to its implementation. The
first issue involved retention by CFM of vehicles owned by MR. MR suffered financial loss as 
a result. This was primarily due to the civil war in Mozambique and nay be an easily avoided 
problem in the future. 

The second issue arose from the collection of joint tariffs. MR was responsible
collection of tariffs for services provided jointly by CFM and MR. 

for 
However, MR did not fullyremit to CFM its full share of the collected tariffs. The reason for this seems to be acombination of seeking compensation for the losses from the retention of vehicles noted above.

and later, an inability to pay because of MR's own financial problems. This second issue has
been exacerbated by the fact that MR must settle the amount owed in US dollars, while the
tariffs were collected in Kwacha. The amount due has substantially increased due to thedevaluation of the Kwacha against the dollar since the tariffs were collected. MR now owesinterest and must spend substantially more Kwachas to pay the amount owed in dollars. 

Suggested Improvements to Future Bi-Lateral Agreements 

An improved agreement among the two companies would provide for a seamless transferof rail services at the border and, to the extent possible, door-to-dook service for the carriage
of goods between Mozambique and Malawi, as well as to destinations in third countries to which cargo is being shipped. The door-to-door service should incorporate all forms of intermodal 
transport as a single service to shippers. These objectives would have a substantial impact on
the efficiency and competitiveness of the services provided by the railway system. 

With respect to CFM, it seems essential for their agreement that MR be operating
commercially 

as a 
viable enterprise with significant elements of privatization. This condition isunderstandable given MR's history and current condition. A commitment to operating as aprivate enterprise would provide CFM assurance that the success of a joint effort would not be

hindered by Government interference or lack of incentive MR's part to be profitable.on Anarrangement which gave each party a direct share in the profits from an efficiently run joint
effort would also provide incentive to operate efficiently and to not obstruct the other party's
schedule or delay return of vehicles. 

With respect to the financial operations, an arrangement providing for collection of a
joint tariff by either party in a neutral, hard currency, and immediate transferral of the funds to 
a mutual account from which the respective payments can be drawn should be considered. Thiswould resolve some of the previous accounting and reimbursement problems. Logistically,
either party could collect the amount from the liable party (shipper, receiver or passenger, as 

' 
At the time of writing this report, the Consultant Team was
informed that a settlement had been reached with regard to accounts
due, and the Government of Malawi agreed to fund the settlement in

installments on behalf of MR.
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the case may be) in dollars and immediately deposit it in an account in a major bank inMalawi/Mozambique. At the end of the month, an independent auditor/accountant would justify
the amount owed against shipping receipts (or other applicable document) and pay MR and CFM'1separately. 5 A similar arrangement is currently being successfully used by Mozambique and 
Zimbabwe. 

Details of this financial arrangement would of course still have to be worked out and may
prove difficult to get off the ground initially. In addition, a similar proposal had be-n suggested
some time ago, but ran into strong objection from shippers and buyers due to a prepaymentrequirement. Shippers claimed that normally the buyer paid upon receipt of the goods and thatthey (the shipper did not want to be out-of-pocket. The buyers, on the other hand, did not wantto pay for the transportation costs until the goods had arrived. This might be remedied by MR
and CFM each initially depositing a certain amount into the account to serve as a base until 
payments could be made by the responsible party (shipper or buyer.) 

To facilitate cooperation, a percentage of the tariff deposited into the account should be
attributed to joint expenses, including administration of the account and joint investments inmaintenance and acquisition of vehicles and other equipment. This would provide financial
incentive to both parties to operate cooperatively, and it would be a positive step in the direction 
of operating both railways as one endeavor to the extent possible. 

Finally, a forum for dispute resolution must be readily available and binding on the parties, and

enforceable sanctions imposed for non-compliance with respect to financial or operating

provisions.
 

In sum, an agreement between MR and CFM should contain provisions concerning the need for
(1) a seamless transfer of carriage of goods or cargo; (2) door-to-door service; (3) intermodaltransport elements efficiently and as a commercially viable enterprise with significant elements
of privatization; (5) collecting joint tariffs and depositing them into a joint fund for appropriate
distribution and investment; and (6) providing a procedure for dispute resolutions and imposition
of sanctions. 

5 An alternative proposal suggested is to have CFM collecttariffs owed on ascending traffic (imports) in dollars, and for MR
to 
collect tariffs on descending traffic quoted in dollars but
collected in Kwacha and accounted for at the official Reserve Bank
exchange rate. 
 A similar mechanism used for remittances to the
other party, as is currently followed in theory, would be used.
However, under this proposal, no one party would have exposure to
the other for the full amount of tariffs, irrespective of the
direction of traffic. 
The process would be even further simplified
when Malawian 
 firms can, in practical terms, hold dollar

denominated accounts domestically.
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Proposed Provisions of the Agreement 

The following paragraphs reflect the parties' commitment to operating on a 
commercial/private basis and also address suggested provisions for joint tariff collection and
establishment of a mutual fund. The remaining agreement as it stands will need to be updated
and simplified to facilitate easy compliance and to address the other concerns noted above. 

1. Preamble The following commitments should be included in the preamble. 

WHEREAS the Governments of the Republic of Malawi and the People's Republic ofMozambique desire to promote and facilitate international rail services by and between their two 
countries on an efficient and commercial basis; 

WHEREAS the Governments of the Republic of Malawi and the People's Republic of
Mozambique have affirmed their commitment to promoting maximum cooperation between theDIRECCAO NACIONAL DOS PORTOS E CAMINHOS DE FERRO (CFM) of the Peo le's
Republic of Mozambique and MALAWI RAILWAYS LIMITED (MR) of the Republic of 
Malawi; 

WHEREAS the Government of the Republic of Malawi has entered into an agreementwith MR to recognize it as an autonomous, commercially operated enterprise in accordance with
THE AGREEMENT BETWEEN THE GOVERNMENT OF THE REPUBLIC OF MALAWI
AND MALAWI RAILWAYS LIMITED, and MR and the Government of the Republic of
Malawi have agreed to otherwise fulfill their respective obligations in accordance with such 
agreement; 

AND 

WHEREAS the parties hereby affirm their commitment to the above objectives and
recognize the expediency of promoting and establishing cooperative rail service on traffic 
between the two countries; 

WHEREAS the parties hereby affirm their commitment to operating their respective
railways, particularly with regard to through-traffic, on an efficient and commercial basis, and 
in the manner of a private enterprise; 

WHEREAS the parties hereby affirm their commitment to establish an arrangement
whereby rail service between the two countries will operate as a joint enterprise to the extent 
necessary and practicable in order to achieve efficiency.and improve competitiveness of both 
companies in the transportation sector; 

The DIRECCAO NACIONAL DOS PORTOS E CAMINHOS DE FERRO (CFM) of the
People's Republic of Mozambique and MALAWI RAILWAYS LIMITED (MR) of the Republic
of Malawi hereby agree to the following: [provisions of agreement....] 
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2. Joint Tariff Collection and Fund The following paragraphs should be included in a section 
concerning financial cooperation and rates. The tariff formula could be amended te pro. ide 
more discretion to either party but should ensure that rates will be competitive. 

2. 1 Joint Tariff Schedule - The parties agree to establish a Joint Tariff Schedule reflecting
the sum of the amount that each party has separately determined to represent the cost of 
providing transportation services within its boarders, plus a reasonable rate of return 
based on a commercially justified and customarily accepted standard. The amounts in 
the Schedule shall also reflect a 5% surcharge in excess of the full tariff in order to cover 
the cost of administering the fund and auditing the accounts on an independent basis as 
set forth below, as well as joint investments to facilitate through-traffic. 

2.2 Joint Bank Account Fund - The parties hereby agree to establish a joint bank fund in the 
National Bank of Malawi/Mozambique. Each party agrees to initially deposit into this 
account an amount equal to $ X. When either party contracts with a passenger or shipper
of goods to provide cross-boarder transportation services, i.e., from Mozambique to
Malawi along the Nacala or Beira Corridor or vice versa, such party shall collect the 
applicable tariff, as set forth in the attached Appendix A (appendix to the bi-lateral 
agreement would be the Joint Tariff Schedule), from the passenger or shipper with whom 
it has contracted. The party will deposit within three days the full amount collected into 
the fund. At the end of each month an independent accountant shall determine the 
amount due each party based on invoices received from the parties and in accordance 
with the tariff schedule. 
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Preliminary Draft' 

MEMORANDUM OF UNDERSTANDING, dated. 1994 
BETWEEN

THE GOVERNMENT AND REPUBLIC OF MALAWI 
THROUGHTHE MINISTRY OF TRANSPORT AND COMIUNICATIONS (MTC) 

AND 
MALAWI RAILWAYS LIMITED (MR) 

1. The Government, consistent with the Railways Act 69.03, is desirous that MR providerail, freight and passenger services on an efficient and commercial basis. 

2. In conformity with this, MR will undertake all necessary actions within its powers, inter 
alia, to: 

(a) 	 closely plan its level and pattern of services to meet the changing needs of its 
customers; and 

(b) 	 manage its operations so arethat services provided efficiently and in a cost­
effective manner. 

3. 	 MR will carry on its operations and conduct its affairs in accordance with soundadministrative, financial and operations management, assisted by competent staff in adequate
numbers. To that end, MR will implement: 

(a) the revised corporate strategy, organizational structure, and operational
improvement plan; and 

(b) 	 the manpower restructuring program. 

4. The Government shall ensure that MR's revised capital structure is implemented. 

5. In carrying out its operations and financial affairs, MR will use its best efforts to achievestated operational targets and stated iates of return on total capital employed. It is understoodthat such performance shall be subject to review and to amendment pursuant to the provisions 

I This is a very preliminary draft1994). 	 (draft date: 18 March,Once 	 the railway restructuring program is defined with moreprecision, and performance targets and measurement of profitability
established, then a substantive revision of this document should be
undertaken prior to negotiations.
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of Paragraph 15 of this memorandum. Further, it is understood that the stated rates of return 
on capital employed shall be subject to amendment, to take account of the revaluation of fixed 
assets to be undertaken as may be required by law. For purposes of this Memorandum. capital
employed means the sum of capital. provisions, long-term and short-term debt. accumulated
profits and losses and any other terms deemed appropriate. Profits to be taken into account in
determining the rate of return shall be profits before interest on debt and before loss from 
depreciation due to foreign exchange. 

6. The Government shall support and provide all the facilities and other resources required
by MR in the implementation of the revised corporate organization and capital structure referred 
to in Paragraph 4. To ensure that MR can implement its restructuring plan. MR may
accordingly sell or dispose of any assets it currently owns, including any land subject to approval
of the Ministry of Lands, equipment and subsidiary companies as necessary for efficiency and
commercial purposes. Likewise, to ensure that MR can continue to adapt its manpower levels 
to changing commercial conditions, MR may reduce its staff complement as necessary forefficiency and commercial purposes. Accordingly, MR shall implement the manpower
restructuring program referred to in Paragraph 3 above, which may be revised following a 
manpower reduction study. Any plan to reduce staff levels will be in accordance with an agreed 
upon retrenchment plan. 

7. Notwithstanding any existing law, rule or regulation to the contrary, including those
contained in or adopted pursuant to the Railways Act 69.03, MR shall be solely responsible for
determining the cost of its services, including any usual and customary terms and conditions
relating to its services, and its schedule and routes of transit, except as set forth in Paragraph
8. MR hereby affirms that in costing its services or determining terms, conditions, schedule and 
routes of transit, it will not discriminate with respect to users, except to the extent that such
discrimination shall be commercially justified. To the extent that the Government directs MR 
to provide certain services or to operate on certain routes, in particular for passenger services 
on core routes, and for staff on routes west of Lilongwe and south of Limbe, the Government 
shall cover losses incurred by MR in accordance with Paragraph 10 below. 

8. Where conditions exist which make it unavoidable or practicable for MR to enjoy natural
monopoly power, and MR is essentially free from competition from other transport suppliers inthat market, MR railway affirms that it will not abuse such monopoly power and will not cost
its seivices in excess of the amount reasonably believed necessary to meet its targeted rate of
return on its investment. MR further affirms that it will not engage in any other conduct,
whether individually or in collusion with others, with the aim of distorting or restricting
competition in the field of domestic and international transport of passengers and freight,
including those services provided via air, shipping or road transportation, or any sub-market
thereof, unless commercially or economically justified or directed to do so by the Government 
in accordance with other paragraphs of this Memorandum. 
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9. MR hereby affirms that at the direction of the Government it will use all reasonable 
means to fulfill the obligations of the Government in accordance with the AGREEMENT 
ENTERED INTO BETWEEN THE GOVERNMENT OF THE REPUBLIC OF MALAWIl AND
THE GOVERNMENT OF THE PEOPLE'S REPUBLIC OF MOZAIMBIQUE IN RESPECT OF
THE ROUTING OF RAIL TRAFFIC THROUGH THE PORTS OF NACALA [AND BEIRA]AND THE PAYMENT FOR RAIL TRANSPORT SERVICES. and any future amendments to 
or revisions of that agreement. To the extent that MR provides services in accordance with this 
agreement. the Government shall cover respective losses incurred by MR in accordance with 
Paragraph 10 below. 

10. The Government hereby affirms the principle that MR in costing its services shall make
full provision for the earning of a rate of return on its fixed assets, as periodically revalued, (oras its surrogate, an agreed definition of capital employed) sufficient to cover its financing
charges on existing assets and ensure that its cash flow generation will be sufficient to cover the
financing charges related to the cost of replacing its fixed assets. Efficient operating conditions 
means that MR shall be in compliance with its stated performance targets. 

11. Losses incurred by MR when providing services at the direction of the Government will 
be determined on a three monthly basis by MR and presented to the Ministry of Finance.
Payments to MR to make good such losses will be made to MR pursuant to the appropriate
Government budgetary procedures as decided by the Ministry of Finance. The Government
hereby undertakes that such payments will be subject to audit and that adjustment will be made 
on the basis of such audits. No other losses incurred by MR in its operations shall be 
reimbursed by the Government. 

12. The Government hereby permits MR to undertake investments in support of its 
commercial operations subject only to: 

(a) the agreed upon debt to capital employed limitation; and 

(b) submission to MTC, as part of the railway's annual capital budgeting process,
technical, economic and fiancial evaluation of any investment exceeding US $1 
million, which the railway proposes to undertake outside of the planned program
of investments under the proposed Railways Restructuring Plan. It is understood 
that this latter figure will be subject to review on an annual basis, taking into 
account changes in tne prices of major classes of transport services assets. 

13. The Government assures the availability of any necessary import licenses with respect
to items required by the railway for maintenance of equipment and assets. 

14. The Government hereby permits MR to enter into commercial contracts as necessary for
the operation of the railway, notwithstanding the provisions of the Statutory Bodies (Control of 
Contract) Act. 



15. In order to assist Government to determine progress made in meeting its obligations
under this Memorandum, MR shall prepare promptly at the end of each six months during itsfinancial year. but in any event, not later than 45 days thereafter, and furnish to MTC. a report
setting forth, inter alia: 

(a) its performance as against stated operating targets; 

(b) its profit and loss and cash flows for the six month period, cumulative statement 
of profit and loss and cash flows for the year to date and, if relevant, revised 
projections for the financial year as a whole; 

(c) statement of progress on key capital projects under implementation and compared
to those contemplated in its capital budget by MTC; and 

(d) any actions which it proposes to take to remedy any major deviations which have 
been identified in the report. 

16. Promptly at the end of each of MR's financial years and in any event not later than six
months after such year end, MR shall prepare and furnish to MTC a report on its performance,
an independently audited statement of its financial position, and a narrative report on the causes
of deviations of actual performance from the agreed performance. 

17. The Government and MR shall cooperate fully to assure that the objectives of thisMemorandum are accomplished. To that end, the Government or MR, as the case may be, willpromptly inform the other of any condition which interferes with the achievement of the objects

of this Memorandum.
 

18. The Government and MR agree to use their best efforts to amicably resolve any disputeswhich may arise in the performance of each party's obligations under the Memorandum. In the 
event that any dispute cannot be amicably resolved, the parties shall apply to an Arbitration
Tribunal for resolution of the dispute. The Arbitration Tribunal shall consist of one or morearbitrators selected from a panel nominated by or on behalf of the railway, and an equal number
of arbitrators selected from a panel nominated by the Minister. The Chairman of the tribunalwill be appointed by [an independent arbitration association in Malawi]. The tribunal's
conclusions shall be final and binding upon both parties. 

19. In the event that MR violates the prohibition against abuse of monopoly power or
collusive behavior set forth in Paragraph 8 of this Memorandum, MR will be liable to pay tothe Government any amount charged in excess of the cost of providing such services. Inaddition, the railway will be liable to pay a fine of not more than KW2,000 for each suchoffense. A determination that MR has violated the prohibition will be determined by the
Ministry of Transportation [or Justice?] and will be final. 



20. This Memorandum shall become effective on the date on which it is signed by the parties
thereto and shall remain in effect for a period of five years. 

21. Any amendment to this Memorandum or the Schedules thereto shall be effected by 
mutual agreement of the parties through an exchange of letters. 

On behalf of the Government On behalf of the Railway 
of Malawi 

Dated: 1994 
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APPENDIX B 

BIBLIOGRAPHY AND SLMMARY OF SELECTED RELEVANT LAWS 

This bibliography contains a list of the laws which relate to establishing and operating 
a business in Malawi. Those laws which are especially pertinent to the railway and the 
circumstances of this case are discussed in relevant part. 

1. The Railways Act, 1907 as amended through 1975.' Cap 69:03 

The Railways Act regulates the construction, control, management and operation of
railways in Malawi. It presently applies to Malawi Railways Limited and would apply
to any newly formed corporation operating the railway, regardless of who is the owner. 
It also applies to the Lake Services to the extent that it is used for railway traffic and 
belongs to or is hired by the railway. Section 2. 

The Act prohibits a railway from giving undue or unreasonable preference or
disadvantage to any particular person or traffic. This would apply regardless of whether 
the railway is a private or government enterprise. Section 25 (1). 

The Act prohibits a court from executing a decree to attach any of the railway's rolling
stock, machinery, plant, tools, fittings, materials or effects used in operation of the
railway. Section 33 (1). However, the earnings of the railway may be attached. Section 
33 (2). This seems to apply when creditors attempt to attach property of the railway in 
settlement of debt owed. 

2. The Companies Act, 1984 and Subsidiary Legislation, 1986 

Except those companies created by Parliament, any new company incorporated in Malawi 
would be incorporated under the Companies Act, 1984. The existing Malawi Railways
Limited, although incorporated in the U.K., is subject to the provisions of Part XIII of 
the Companies Act, 1984, which relates to "external companies" (see below.) 

Private v. Public Company: A private company restricts the right to transfer shares,
limits the number of members (shareholders) to fifty not including employees, and
prohibits public invitations to acquire shares or debentures. All other companies are 
public companies. Sections 5(2) - 5(5). 

I/ Not published in the Railway Act are rules and regulations
made by the Railway Administration under the Railway Act that
relate solely to the internal management of the railway and charges

and tariffs.
 



Limited v. Unlimited: Either a private company or a public company may limit theliability of its members to an amount unpaid by the shares ("limited by shares") or to anamount the members respectively undertake to contribute to the assets in the event of itsbeing wound up ("limited by guarantee"). There may also be no limit to the liability of
the members ("an unlimited company"). 

The type of company can be changed (i.e., from a limited to an unlimited company) afterincorporation in accordance with Sections 24-28. However, there seems to be no
provision allowing for the conversion of a company limited by guarantee to a company
limited by shares. 

Nothing in the law seems to preclude joint ventures. 

Share ownership: The law prohibits a company with a share capital from acquiring orholding "any interest in its own shares, either directly or indirectly through nominees orotherwise." Section 73. However, a company may hold shares of another company inwhich it has acquired a controlling interest, for twelve months from the date the company
acquired or held such interest. The second sentence is subject to interpretation as towhether this might include Malawi Railway Limited from receiving its shares back fromThe Malawi Railway Holding Company and holding them for twelve months (as opposed 
to being held by the government.) 

External Company: Malawi Railway Limited is an "external company," which is definedunder the law as "a body corporate formed outside Malawi which establishes or maintains 
an established place of business in Mal?,wi." Section 306(2). 

To hold land - An "external company" has the same powers to hold land in Malawi as
if it were a company incorporated under the Companies Act, 
 1984. 

To wind up - An "external company" may be wound up in Malawi whether or not it hasdissolved or ceased to exist in its country of origin, and is subject to all of the provisionsof Part XII which sets forth the coiditions for winding up a company incorporated under
The Companies Act, 1984. Section 319. 

A further condition with respect to external companies is that they may only be wound up "on a petition to the court." A court may wind up a company when it is beingdissolved or wound up in its country of incorporation, when it has ceased to do businessin Malawi, when it is unableto ay its dets, and inter alia, when the court is of theopinion that it is just and equitable that the company should be wound up. Section 319.For winding up purposes, an external company will be treated as if it were incorporated
under the Companies Act and only the assets and liabilities situate in Malawi shall be
considered the company's assets and liabilities. 

-




Winding Up Provisions - Chapter .Xr 

A company is prohibited from transferring shares once winding up has commenced. 
Section 247 (2). 

The Directors must make a declaration of solvency and state that they will be able to paytheir debts and liabilities within twelve months after commencement of the winding up. 

If the winding up is ordered by a court, a liquidator is appointed and the court may vestthe company's assets in the liquidator. Section 227. The liquidator may sell all real andpersonal property and resolve any debts and liabilities to creditors or others with justified
claims. Section 230. 

Statutory Bodies - winding up: a body corporate created by law is not subject to thewinding up provisions if the law under which it was created makes specLic provisions
for winding up. 

3. Malawi Railway Holdings Company Act, 1968 - Cap 69:04 

The Malawi Railway Holdings Company Act incorporates the Malawi Railway HoldingsCompany by Act of Parliament, creating a statutory body in the true sense of the word.Liability of the Company is limited to the amount of unpaid shares. The principal objectof the Company is to hold shares on behalf of the Government of Malawi in anycompany engaged in railway or other transportation operations (including by air andwater.) Section 4(1)(a). Its purpose is not restricted to the U.K. company MalawiRailway Limited, but presumably could hold the shares of any subsequent or similar 
company. 

Transfer of Shares - This Act instructed the Government of Malawi to transfer all ofits shares in Malawi Railways Limited in the Malawi Railway Holding Company. Thistransfer included shares which were held by Lonhro and which would be bought by the 
Government. Section 5 and 6(3). 

Board of Directors - The Act provides that the Chairman and the Board of Directorsshall be appointed by the "Minister" (which is not defined here, but is defined in theStatutory Bodies Act as the Minister "charged by the President"), and shall include atleast three Government representatives - one from each of the following: the Ministry ofFinance, the Malawi Development Corporation, and the Agricultural Development and
Marketing Corporation. Section 8 (2). 

The Board is specifically required to perform its functions "subject to the special
general directions of the Minister." 

or 

Borrowing Powers - The Board is precluded from exercising any borrowing powers
without prior written consent of the Minister. 



Taxation - The Company is not subject to any stamp. income or other tax in Malawi. 

Section 15. 

4. Statutory Bodies, including 14-12-90 amendment notice. 1966 - 18:07 

The law allows the appropriate Minister to control all commercial contracts made by astatutory body by requiring prior written approval of the Minister of aiiy contract the
Minister deems it to' be "in the public interest" to control. Sections 3 and 4. The only
standard for approval is "in the public interest." Even with respect to those contractswhich are approved, the Minister may attach any conditions concerning the parties or the 
terms as he deems to be "in the public interest." Section 5. 

Penalty - There are criminal penalties (K2,000 or two years in prison) for any company
officer who enters into a contract for which he should have received prior written
approval. The contract is void with respect to the other party and can not be enforced. 
Section 7. 

Statutory Body - This includes "every corporation ... incorporated within or outside
Malawi" and specified in the "schedule" (attached to the act). Section 2 (1). The 
Schedule includes "Malawi Railways Limited." 

5. Investment Promotion Act, 1991 - No. 28 of 1991, Published January 31, 1992. 

This Act begins with a statement regarding investment policies and procedures. 

The Act creates the Malawi Investment Promotion Agency - a body corporate.
principal objective is to ive practical 

The 
and prompt effect to the Government's stated

commitment regarding investment in Malawi. Section 5. 

One of its functions is to identify partners in or outside Malawi for joint venture business 
opportunities in Malawi. Section 8. 

One of the stated Government policies is deregulate the private sector, including
divestiture of state-owned companies. It notes that steps have been taken to rectify the 
external transport situation. Schedule, Paragraph 3. 

Freedom to Invest - Domestic and foreign investors may invest in any sector of the 
economy, with no restriction on ownership, size of investment, or source of funds. Jointventures between domestic and foreign investors are encouraged. Schedule, Paragraph 
5 

Company Formation - Investors will only be required to provide the Registrar of
Companies with basic information on proposed business activities. Schedule, Paragraph 
6. 



Railway specific - Government is taking initiative to develop the Northern Corridor route 
to the port of Dar-es-Salaam in Tanzania and the rehabilitation of the Nacala Railway
Line to the port of Nacala in Mozambique. This is noted in the Act as recognition of
the railway's role in supporting private sector development. Schedule. Paragraph 9. 

Investment Protection - "The Malawi Constitution and existing laws and regulations
provide further assurance that investors' assets are protected." Schedule. Paragraph 17. 

6. Capital 	Markets Act, 1990 - Cap 46:06 

This Act provides the framework for developing a capital market and sets forth the
conditions for a self-regulatory organization (like a securities exchange commission.) 

7. 	 Treaties and Conventions Publication, 1984 - Cap 16:02 

This law enables the publication by the Minister of the bilateral agreement with 
Mozambique. 

8. 	 Conveyancing and Lands Acquisition Act, 1952 and 1957
 
Cap 58:03 and 58:04, especially Sections 9,10 & 11.
 

9. 	 Land (property law), 1965 - Cap 57:01, pages 1-16. 
Specific areas 	of land are addressed in the subsidiary legislation. 

10. Open 	General Import License, 1967 - Cap 18:18 

11. 	 Labour related laws: 

Labour Legislation (Misc. Provisions), 1964 - Cap 56:01 
Employment, 1964 and 1939 - Cap 55:02 and 55:04 

Trade Unions, 1959 - Cap 54:01 

Trade Disputes (Arbitration and Settlement), 1952 - Cap 54:02 

Regulations 	of Minimum Wage and Conditions, 1958 - Cap 55:01, pages 1-13 
only 

Workmen's 	Compensation, 1946 - Cap 55:03 

12. 	 Stamp Duties, 1969 - Cap 43:01 

Section 88 of this Act expressly exempts Government from payment of the tax. 

13. 	 Environmental Laws - none found. 



14. National Airline Act, 1967 - Cap 70:03, pp 1-4 

Section 5 of this Act vest the assets of the Corporation of Malawi in Air Malawi. 

!5. Malawi Road Transporters Authority, 1970 - Cap 69:05 
This Act vested assets of limited company in the authority created by this statute. 
Authority is now defunct. 

The 

16. Bankruptcy Act - Cap 11:01 

17. Deeds of Arrangement - Cap 11:02 

18. Factories Act - Cap 55:07 

This Act contains safety provisions only. 



APPENDIX C
 

LIST OF CONTACTS
 

In preparation of the legal aspect of the restructuring project, meetings and/or interviews 

were conducted with the following individuals. 

1. 	 Mr. Savjani, Counsel for Malawi Railways, Savjani and Co., Blantyre, Malawi. 

2. 	 James G. Naphambo, Company Secretary, Air Malawi, Blantyre, Malawi. 

3. 	 B.Y.M. Makwinja, Deputy General Manager, Malawi Railways, Limbe, Malawi. 

4. 	 Enoch R. Limbe, Deputy General Manager, Malawi Railways, Limbe, Malawi. 

5. 	 Robin Foster-Brown, Finance Manager, Malawi Railways, Limbe, Malawi. 

6. 	 E.C. Nkhoma, Company Secretary, Malawi Railways, Limbe, Malawi. 

7. 	 Mr. Markham, General Manager, Malawi Railways, Limbe, Malawi. 

8. 	 Chris Morgan, Financial Management Advisor, Department of Statutory Bodies, Office 
of the President and Cabinet, Lilongwe, Malawi. 

9. Mr. M. Chitimbe, Chief Transport Officer, Ministry of Transport, Lilongwe, Malawi. 

10. 	 Mr. Magalasi, Treasury Department, Lilongwe, Malawi. 

11. 	 Frank Kippax, Commercial Officer, British High Commission, Lilongwe, Malawi. 

12. 	 E. Bousfield, First Secretary, British High Commission, Lilongwe, Malawi. 

13. 	 Ben Lyster-Binns, Third Secretary, British High Commission, Lilongwe, Malawi. 

14. 	 Peter K. Pohland, Deputy Resident Representative, World Bank Mission in Malawi. 



APPENDIX D 

CORPORATE DOCUMENTS OF MALAWI RAILWAY 

This appendix sets forth the Articles of Incorporation and Memorandum of Association.to the extent available, of the following companies: (1) Malawi Railways Limited, (2) NyasalandRailways Limited (the original company), and (3) The Central Africa Railway, Limited, awholly owned subsidiary of Malawi Railways Limited. It also contains other pertinent corporatedocuments such as Special Resolutions by the Board of Directors and important agreements to 
which the company is a party. 

I. Malawi Railways Limited 

A. Memorandum of Association 

As adopted by Special Resolutions passed December 28, 1950 and August 11, 1966.
The objects of the Company are "to acquire not less than 90 per cent of the issued sharecapital of Central Africa Railway Company, Limited and to acquire the undertaking andassets and to take over and discharge or satisfy the debts and liabilities of Shire Highlands
Railway, Nyasaland, Limited ...... 

B. Special Resolution regarding the qualifications of Directors. 

C. Special Resolution regarding the power of Directors to borrow money, and to 
mortgage or charge its undertaking property and uncalled capital. 

D. Special Resolution regarding the qualifications of Directors (Passed June 25, 
1968), and Special Resolution to extend business into manufacturing. 

E. Lease Agreement between Malawi Railways Limited and Tanzania Zambia 
Railway Authority. 

F. Agreement between the Government of the Republic of Malawi and theGovernment of the People's Republic of Mozambique. Unsigned (1983 approximately).
Passed August 11, 1966. 

G. Form 288 indicates that Mr. John Edward Smith of Lonrho (Malawi) Limited is 
the Company Director. 

Schedule to Form 363s indicates the following Members (Shareholders): MalawiRailway Holdings Company holds 417,675 shares; Secretary to the Treasury holds 400shares; Christopher Barrow, Naming Lomba [?] Tea Estates holds 100 shares; and Harry
Thindwe holds 100 shares. 



I. 	 Nyasaland Railways, Limited_ (Original company) 

A. 	 Certificate of Incorporation. October 3, 1930
Memorandum of Association, as altered by Special Resolution passed on December 28. 
1950. 

B. 	 Special Resolution changing the name to "Malawi Railways Limited." Passed 
September 17, 1964. ' 

II. 	 The Central Africa Railway, Limited 

A. Memorandum of Association and Articles of Incorporation

Adopted by Special Resolution April 27, 1931.
 

B. Share Capital - 525,000 Ordinary Shares authorized and issued. "All held by
Malawi Railways Limited" (1968, approximately) 

C. Special Resolution regarding Director qualifications.
 
Passed June 25, 1968.
 

D. Special Resolution allowing for pensions for employees.

Passed December 28, 1950.
 

E. 	 Memorandum from F.W.Markham, Gen:ral Manager, regarding the filing ofNotice of Change of Directors pursuant to Section 288 of the U.K. Companies Act 1985(sic). Document indicates that The Central Africa Railway Company Limited is a wholly
owned subsidiary of Malawi Railway Limited and incorporated in the U.K. The company owns only a short section of the track within Malawi that is south of Nsanje andis no longer operating as a separate company and is "effectively dormant." 

Markham indicates that it still is a separate legal entity with some 	assets, includingdebentures in Malawi Railway. Therefore it must still hold a Directors' Meeting at least 
once a year. 

Director: The "288 Forms" indicate that Mr. John Edward Smith of Lonrho (Malawi)
Limited is the Corporate Director (as of 9/23/93). 

Members (Shareholders): Sun Insurance Limited (London) holds 	 524,800 shares;
Christopher Barrow, Naming Lombe [?] Tea Estates holds 100 shares; Enoch Raphael
Limbe holds 50 shares; and Harry Thindwa of Limbe holds 50 shares. 

IV. 	 Roadmarc Limited (unclear of relationship) 

Memorandum and Articles of Association 
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TECHNICAL WORKI-NG PAPER
 

fIL'MA.N RESOURCES DEVELOPMfENT REPORT
 

LNTRODUCTION 

1.1 Background 

Malawi Railways (MR) is in the process of restructuring and has requested donor assistance. 
A Project Appraisal Mission, with joint representation from the World Bank. USAID and the
ODA, is scheduled to visit MR in April 1994. In preparation for this Mission, USAID funded 
a consultant team to draft various technical working papers on a number of issues related to a 
possible project. 

1.2 Scope of Work 

The present paper covers the human resource aspects of the MR restructuring. The main issues 
identified in the Scope of Work include: (i) an assessment of the effect of the proposed project 
on the workforce of MR; and (ii) a review of how the effects of retrenchment can be mitigated. 

1.3 Methodology 

Information was collected from: managers of MR through discussion with them and from 
documents produced by MR; consultants' reports written for MR; personnel managers in other 
industries in Malawi; and representatives of various government departments. 

1.4 Structure of Report 

This report first looks at the retrenchment exercise that took place in MR between November 
1993 and April 1994. It then assesses the effects of the program as well as possibilities for 
improvement in the future retrenchment exercise. This is followed by an analysis of the 
prospects confronting redundant staff and proposals for ways in which donors could assist. 

The report continues with a brief discussion of the other aspects of MR's restructuring exercise,
including: the management of change process; organizational change; the employment package;
and training needs. The report concludes with a summary of recommendations made. 



2 THE RETRENChIMENT PROGRAM 

2.1 Background 

One of the findings in the Transmark Report' was that productivity was extremely low. Largely
as a result of the closure of the Nacala line (due to the war in Mozambique), operational activitywas minimal and staff numbers were high as staff had been retained in anticipation of a re­
opening of the line. Under the circumstances, the consultants recommended a reduction from 
the 1990 figure of 3,998 employees to 2,500. 

2.2 Staffing Requirements 

At the commencement of the current fiscal year (1993/94) there were 3,019 employees inrailway service. A determined policy of retrenchment that commenced in November 1993 has
reduced staff by 1,100. The expressed intention was that by 1st April 1994 there would be
2,152 people in employment with MR. In fact, there will still be 2,382'. 

The draft Corporate Plan (February 1994) assumes further reductions through natural wastage, 
or retrenchment if necessary, of between 100 and 200 each year until by 1998/99 there will be1,460 staff left on the books. In the first breakeven year (1996/7), there will be 1,800 staff still 
in employment. 

Two alternative scenarios of the scale of MR's operations was put together by the General
Manager at the request of the World Bank. These give, respectively, a slightly less optimistic
view cf railway performance (the "Middle" scenario) and a much less optimistic view (known 
as the "Doomwatch" scenario). Lower freight traffic volumes have been assumed than those
anticipated in the Corporate Plan and in the Doomwatch scenario all passenger services have
been closed leaving only the "core railway". In the first the breakeven year is, again, 1996/7
and the General Manager estimates that staff required to implement that scenario will be 1,602.
In the Doomwatch scenario, the breakeven year is 1995/6 at which time it is estimated that 
1,110 staff will be required. 

Report on Malawi Railways commissioned by ODA from Transmark, UK in 1990/91. 
It will already be seen that staffing figures do not always tally. Such discrepancies remain 

unexplained. Detailed information on staffing matters is available but it is not systematically 
collated or presented. 
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There are, therefore, three different possibilities for staff requirements envisaged over the next 
few financial years: 

1994/5 1995/6 1996/7 1997,"8 

(Target) 

Corporate plan 2152 2000 1800 1660 

Middle scenario 2152 1602 

Doomwatch scenario 2152 1110 

The Scope of Work did not require the consultant to make an independent assessment of staffing
needs. Projections by MR have therefore been accepted as given. 

2.3 The Severance Exercise 

2.3.1 Selection of Staff
The recent retrenchment exercise was a straightforward shedding of staff and not conducted as a coherent and systematic reflection of other restructuring activities. Some of the employeesretrenched worked on the passenger service between Salima and Mchinji, which has been closed. 
Others came into one of four categories: 

- retirement because they were over 60 (the official retirement age); 

- early retirement for "non-key" staff who were over 55; 

- less than 5 years service with no special experience or training; 

- poor disciplinary or health record. 

The retrenchment has been undertaken in 6 phases between October 31st 1993 and March 31st
1994. (In practice, Phase 6 was split into Phases 6a and 6b.) 

2.3.2 Profile of Redundant Staff 

Details of staff retrenched by department, by age, by skill level or by salary were not readily
available at the time of the analysis, but the following information was obtained: 

897 staff were shed up to and including Phase 6a of the retrenchment program.
Of these: 

- 255 people were retired as over 60 years of age; 

40 people between the ages of 55 and 60 were given early retirement; 
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602 were made redundant. 

the majority of redundawt staff are said to have been unskilled workers from the 
permanent way (Civil Engineer's Department); 

ages of the 897 staff retrenched in the first six phases ranged between 26 and 60: 

years of service ranged between 3 and 41 years; 

- the majority of staff were relatively junior. Salaries ranged between MKw 197 permonth and MKwl,539 per month, the average salary of those dismissed being MKw600; 

278 were classified as skilled staff; and 

135 were displaced from urban centres (Blantyre, Lilongwe and Salima) with the 
remainder based at rural stations or depots. 

2.3.3 The Severance Package
 

Redundant Staff. 
 It is specified in the MR Conditions of Service that redundant staff receive a lump sum which is equivalent to two weeks' wages for each year of service that they havecompleted with MR. In the present exercise the MR management found that the redundancy
terms for government employees were slightly more generous in certain circumstances than theMR formula. The government scheme offers 3% of the annual wage to employees with lessthan 5 years service per year of service, paid as a lump sum; 5% to those with 5 - 9 yearsservice: and 6 % to those with over 9 years service. The most generous of the two schemes was 
applied on a case by case basis. 

Pension contributions, which are paid by staff at 5 % of salary, are returned as a lump sum.Senior staff with long service can, at management's discretion, receive the employer's share of
the contribution as well (between 8% and 12%). 

Redundant employees also receive a relocation allowance which is the amount considered necessary to move the employee, his/her family and their household goods back to their "home"village. This allowance is given whether or not the employee plans to move location and canbe received in kind (MR has taken out a contract with a trucking company to provide theremovals service), or in cash if the employee prefers. If a retrenched employee decides not torelocate, they must at least vacate their house which, in most cases, is supplied by MR. 

All of the costs of the retrenchment exercise to date have been borne by government. Thisamounts to an approximate total of MKw5.7 million (about US$1 million, depending on 
exchange rate used). 
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The Railway Workers' Union of Malawi has asked that the severance package be doubled to onemonth's salary for each completed year of service. This has been rejected by management and
the Union has appealed to the Ministry of Labour. which is currently considering the 
proposition. 

Retired Staff. Retired staff receive a pension which amounts to approximately one third of their
salary. This pension ceases when the employee's contributions to the scheme have been used 
up. It is not. therefore, a generous pension scheme and it is also adversely affected by inflation. 

Staff who were retired early had their pension made up as if full contributions had been made
until the age of 60. All retired staff also receive the relocation allowance. 

Many staff who were retired early were unhappy with being given a pension and made requeststo be treated as redundant rather than retired so that they could have the lump sum of moneyrather than the meagre pension. The Trade Union supports this request on the grounds that suchworkers are being denied their expected earnings for a number of years. A textile company in
Malawi. David Whitehead & Co. Ltd., did, in fact, make this provision when they laid off a 
number of workers in 1992. 

2.3.4 Effects of Retrenchment 

Retrenched Employees. Those employees who are made redundant lose not only their job but
also their homes, health care (MR owns and operates clinics in Limbe, Lilongwe and Salima),free travel on the railway network as well as certain other services (subsidized canteen. etc.).

Staff w-ho are retired retain health care.
 

This affects not onily themselves but all members of their family who are considered to be
dependent on them. The Trade Union estimates that, if 1,000 people are made redundant, a
total of 4,000 people are directly affected and effectively lose their livelihood. This is 
considered by the consultant to be a conservative estimate. 

Staff Continuing in Employment. The protracted nature of the retrenchment exercise has had 
a deleterious effect on morale of remaining employees who now see their "jobfor life" as beingpotentially insecure. There has been little communication effort to explain that the retrenchment
is part of an on-going process to which they can contribute and which will, in the long term,
make their jobs more secure. What is more, despite an "implied" increased workload, they are 
receiving no additional reward. 

It is recommended that any future retrenchment only be undertaken as part of a structured plan 
to reshape railway operations. 
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2.4 Future Retrenchment 

Natural wastage is running at approximately 10% per year. Once that is taken into account on 
a staffing figure of 2.382, the alternative retrenchment programs for the three different scenarios 
supplied by MR (see 2.2 above), exclusive of natural wastage and including the outstanding need 
to achieve the 1994/5 target figure of 2,152. would be: 

1994/5 1995/6 1996/7 1997/8
Corporate plan 230 Nil Nil Nil 

Middle scenario 505 275 

Doomwatch scenario 1272 

Unlike the Corporate Plan, the latter two scenarios do not specify if further retrenchment will
be necessary or desirable after breakeven point is reached. Annual retrenchment is similarly not
specified for the middle scenario, so 50% of the total reduction required to achieve the
breakeven position has been assumed for each year (plus, in the first year, the number required 
to get to the target start point). 

The same proviso regarding acceptance of MR's figures at face value pertains (as in 2.2 above).
The actual numbers for retrenchment will not be known until the nature of the restructuring
project is defined, including what services are to be kept in-house, what contracted out, hived 
off, etc. 

2.5 Options for Support 

It is recommended that support be given to create improvements in the severance package. A
question to be answered before decisions can be made on the level of support required for the 
severance package is whether support is only to be for future retrenchment or whether it is to 
be retroactive for those who have already been retrenched. 

Support for future redundant staff, as well as those aiready retrenched, is recommended as, by
standards in other countries in Africa, two weeks' salary per year of service is very low. A 
recent USAID project in Mozambique recommended 3 months' salary per two years of service 
for redundant staff. Salaries of railway employees in Malawi are extremely low, even by
Malawi standards, and an average severance payment (of approximately MKw3,000) would not 
purchase a roof for a house. 
Support could be in the following forms. 
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I1. Increased severance payments to staff to be retrenched in the next three vears.
It is recommended that the formula for calculating payment per year of service be: 

Less than 10 years 4 weeks' salary 
10 and less than 15 5 weeks' salary
Over 15 years 6 weeks' salary 

In the absence of knowledg of grade, etc. of the future retrenched staff.calculation of cost can only be very approxi ate. Assuming the government and/or donors
continue with payments at the current rate, approximate support costs would be: 

Corporate plan scenario: MKw690,000 
US$130,000 

over one year. 

Middle scenario: MKw2,340,000 
US$ 435,000 

over two years. 

Doomwatch scenario: MKw3,820,000 
US$ 710,000 

over one year. 

2. Payment of a housing allowance to enable purchase of appropriate materials to
build a house. At present costs, MKw6,500 per employee is recommended. 

Costs of this support would be: 

Corporate plan scenario: MKwl,500,000 
US$ 280,000 

Middle scenario: MKw5,000,000 
US$ 940,000 

Doomwatch scenario: MKw8,270,000 
US$1,500,000 

3. Retroactive support to those 	staff already retrenched. 

Severance payment addition: 	 MKw3,500,000 
US$ 650,000 

Housing allowance: 	 MKw6,700,000 
US$1,240,000 
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3 NTIGATION OF EFFECTS OF RETRENCHI-ENT 

3.1 Housing 

It has already been recommended that staff who are retrenched be paid a housing allowance to

enable them to purchase construction materials for a house in the area to which they move with
 
their families after leaving the railway's employ.
 

An alternative form of assistance with housing would be to set up a low interest credit fund to

assist those employees who do not wish to move from their railway house to purchase that house
 
from MR.
 

MR would like to keep a number of houses for key employees (as yet undefined) but has

expressed a wish to div est itself of considerable numbers of its houses and has already offered
 
some to other government departments. MR's own parlous financial state means that the houses
 
cannot be given free to long serving employees but a suitable credit scheme made available to
ex-employees could assist both the 	railway's financial position and the displaced empiou e. 

A recent Valuation Report commissioned by MR puts a nominal average value of MKwl8,000

(US$3,300) on railway houses. 
 A credit fund could be established and held by MR such that

MR has the houses removed from its books and receives compensation for them while the

employees pay back the money on long-term loans at advantageous rates of interest. 

It is recommended that the houses be sold off to ex-employees at a discounted rate for a number 
of reasons. 

(a) The nominal values quoted are probably above actual market price.
(b) It would be an additional advantage to staff losing their job. 

(c) Some of the houses are likely to be located in areas that would not make them readily
saleable to other people. 

(d) The railway would incur administrative (and perhaps transaction) costs if it had to sell 
the houses on the open market. 

Assuming 25 % of those made redundant might wish to take advantage of this opportunity and
assuming a discounted sale price of 60% of nominal value, the approximate total cost of the 
initial credit fund would be: 

Corporate plan scenario: 	 M]Kw630,000
 
US$116,000


Relocation savings: 	 MKw 35,000 
US$ 6,500 
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Middle scenario: MKw2.106.000 
US$ 390,000

Relocation savings: MKw120.000 
US$ 22,200 

Doomwatch scenario: MKw3,435.000 
US$ 640.000 

Relocation savings: MKw 195,500 
US$ 36,200 

Retroactive establishment of the fund to benefit those who have already been made redundant(where that might still be of some benefit to ex-employees who have yet been able tonot
relocate) would involve the following approximate cost, assuming take-up rate of 15 % of those 
laid off: 

Fund requirements: 	 MKw1,670,000 
US$ 310,400

Relocation savings: MKw95,000 
US$ 17,500 

3.2 Employment Prospects 

MR's assumption at this point in time is that most retrenched personnel will return to their"home" village where they will take up subsistence farming either on family land or on land thatthe village Chief assigns. This represents a distinct reduction in standard of living. 

Other employment prospects are bleak in Malawi at present. Several parastatals and privatecompanies have recently laid off workers (for Air Malawi,example, 	 Admarc). Theunemployment rate is clearly very 	high but it is impossible to put an accurate figure on it asthere is no clear assessment of the 	labour force participation rate. The job base in the formalsector is around 169,000, so few opportunities are likely to arise. 

It is said that there is a shortage of technicians in the country. With some additional researchthis could be confirmed and specified. If the shortage is a reality then support should be givenin terms of funding for training in the appropriate skill for suitable candidates selected fromthose displaced from the railway. Until recently little reputable adult vocational training existedin Malawi but this sector is now receiving donor support, notably from the United Nations andthe German government, so suitable training may be available. 

The amount of support would depend on the type of skills needed, the suitability for retrainingof those people made redundant, and the nature of the training facilities. This cannot bespecified until the detailed retrenchment program is available. 

In certain circumstances the railway's training school may be suitable to provide skills training 
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facilities using visiting specialist trainers. 

Where suitable candidates are identified consideration should also be given to the provision of 
scholarships to enable ex-employees to follow studies of their choice for which they did not have 
the opportunity prior to their railway career. 

3.3 Small Business Development 

The most promising hope for future employment is for assistance to be given to retrenched 
employees who wish to develop small businesses. 

Clearly this is not an option that will appeal to a majority of staff, although the "entrepreneurial
spirit" is present in Malawi as in many African countries. It is, moreover, government policy
to encourage small business development which is seen as potentially making a long-term
contribution to growth. However, research in other in Africacountries has shown that
microenterprises have only a small role to play in the generation of employment. 

Those retrenched staff who want to invest their severance pay in a business enterprise or who
wish to develop some activities they or their families may already be pursuing in the informal 
sector, will require assistance both in terms of finance and advice. 

3.3.1 Available Resources 

The structures already exist in Malawi to administer such assistance. Several small agencies,
established by the government but largely donor supported, exist with the express role of 
supporting small and medium size enterprises. 

The most appropriate agencies to be used by this project seem to be SEDOM (Small Enterprise
Development of Malawi), DEMATT (Development of Malawi Traders Trust) and MEDI
 
(Malawi Entrepreneurship Development Institute).

SEDOM holds a fund (when donors' money is available) and assesses small business schemes
 
and makes loans to appropriate projects at interest rates that are well below bank rate. 
 Bank rate
is currently 26 %. SEDOM loans money at 18 % for urban projects and at a slightly lower rate
(16%) for rural projects as it is government policy to encourage rural development. In Blantyre,
SEDOM run an "industrial hive" where small workshops can be used by nascent industrial 
businesses. 

DEMATT gives advice to anyone who is interested in establishing a business venture. They are 
able to give both business management and technical advice and they help with the development
of a Business Plan and with market analysis. 

DEMATT also arranges training in business management skills either under their own auspices 
or by using other agencies like MEDI (Malawi Entrepreneurship Development Institute) which 
runs 3 month business management courses and tailor-made courses, as appropriate. USAID 
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has supported DEMAIT for a number of years. 

3.3.2 Opportunities for Small Businesses 

It is impossible to anticipate what business ideas may be forthcoming but some possibilities seem 
to be particularly feasible. 

Industrial. Craftsmen and skilled artisans could receive support in the opening of small 
workshops and in marketing their craft either as individuals or in groups. 

Groups may wish to pool resources and purchase redundant workshops or other facilities from 
the railway, once MR has determined what facilities it wishes to divest. The motor vehicle 
workshop, the foundry and the canteen are possible examples of this. 

Agricultural. Rather than remaining in subsistence farming, there may be some retrenched 
employees who, as individuals or in groups (where, for example, they have worked together in 
the same rural depot), may wish to develop some form of agri-business. 

In some areas the railway has exceptionally wide reserves alongside the track. The Valuation 
Report assessed there to be in the region of 3,800 hectares of spare land. MR appears to have 
no legal title to this land but it may be possible to make some of it available to agricultural
enterprises. Loans could be made for the construction of animal sheds, the purchase of 
irrigation equipment, etc. 

3.3.3 Assistance and Institutional Arrangements 

i) It is recommended that donor assistance be given in the form of a (revolving) credit fund,
to be administered by SEDOM, which is geared solely towards retrenched railway workers. A 
member of the Railway Workers' Union should be invited to sit on the SEDOM loans committee 
to have an input to the equitable and secure distribution of loan. 

ii) Further assistance should be given to DEMATT to enable them to provide advice and all 
necessary training, commencing with outreach work with redundant railway workers before they
actually leave MR's employ. 

GTZ (the German aid agency) has pioneered 4-week courses for redundant workers 
which enable identification of those candidates who demonstrate some entrepreneurial flair. This 
may be considered useful in the circumstances of MR. 

DEMATr could be contracted to undertake overall direction of the advice and training 
aspect of the project. 

iii) Surplus railway assets that are sold to employees should be sold at nominal sums and on 
the guarantee that sufficient credit will be available to invest in upgraded facilities. Where 
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workers invest their severance pay in the purchase and development of the business, a fund 
should be established to underrite their investment such that if the business fails within the 
lifetime of the project they receive a certain percentage of their severance pay back (perhaps 
60%). 

iv) The railway should be willing to give preferential contracts to workers who either take 
over and operate railway facilities or who go into appropriate businesses -- such a, the
manufacture of components and spare parts, or the supplying of food to the canteen, etc. 

v) Where surplus assets are sold off to outside investors, guarantees should be received that
those investors are willing to: (a) make the investments necessary to ensure that the business
becomes a viable concern; (b) retain all or most of the current staff; and (c) guarantee training 
for staff. 
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4 RESTRUCTURING ACTIVITIES 

The reorientation of the enterprise from one which operatedhas in a heavily regulated.bureaucratic environment, with corresponding low demand on individual responsibility and
accountability, to one which is a business led commercial enterprise will require the development
of a new management culture which will need to permeate the organization. 

4.1 The Management of Change 

In order to achieve the desired changes in MR the management team at MR has a number of 
tasks: 

- they must draw up detailed organization charts which serve the organizationalgoals as expressed in the draft corporate plan3. The new organization, as well as the goals, 
must remain "owned" by the managers and staff of MR and must not appear to be imposed bydonors or other external bodies. New relationships must be developed in a structured way; 

- a work analysis must be undertaken throughout the new organization to determine 
exactly what jobs are required and where; 

a job evaluation exercise must be carried out to assess accurately the rewards
appropriate to the responsibility levels in each job; 

a new grading structure and remuneration package must be designed and made 
available; and 

- a massive training exercise must be undertaken which involves all interestedparties: government, management, staff at all levels and locations, major users. The purposeof this training will be to change attitudes and gain commitment of all those who can affect the
running of the railway to the new orientation. 

This change activity must be completed as soon as possible for two main reasons: (a) the parlousstate of MR; and (b) in order to capitalize on the huge retrenchment exercise that has alreadytaken place. Ideally it should start immediately and be complete by the end of the 1994/5
financial year. 

4.2 The Employment Package 

Staff in MR are very poorly paid. At senior levels it has become near impossible to recruit and 
retain qualified staff at the salary ranges offered. At lower levels, the security of employment 

I Further work on this document is required to better define the overall strategy, mission and 

top level goals of the restructured railway. 
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went a long way towards compensating for the low pay, but that is no longer the case. Staff
have lost that security, they are aware that one third of the salary bill has been saved, their
workload has, in some cases, increased but they have received no net incremental compensation. 

An entirely new employment structure is required. At present there are over 200 grades, each 
of which has a range of salary points. There should be no need for more than 6 - 10 grades
below management level and a similar number within management. Each grade should have a
fairly narrow salary range associated with it. The money saved from the retrenchment exercise 
should be redistributed such that an appreciative raising of salaries can take place. Such a
change to grade and salary structures, whilst untypical in a parastatal company, should not cause 
any legal problems as MR is technically a private company registered in the UK. 
It has been suggested that senior managers should be placed on a contract basis so that qualified
Malawians can be recruited at the same pay scales as the current ex-patriate managers. Other 
parastatals (for example Malawi Housing Corporation, Admarc) already use this system for 
General Managers or accountants. 

It would be unfortunate to have to resort to this method of remunerating senior staff as it reduces 
the cohesion of the workforce and may set up resentments at the next layer down of 
management. As a strictly temporary measure, contracting senior staff may resolve some 
immediate problems but it should be possible to establish a pay structure that is able to 
adequately reward all staff. Such a structure would need support initially from government and, 
almost certainly, from donors as well. 

It has been suggested that an Employee Share Ownership Plan might be appropriate in MR. 
However, it is considered that, while this may be an option in a future privatized railway, it 
would have little or no relevance at present. 
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4.3 Retrenchment and Recruitment 

While natural wastage will take care of much of the numerical reductions required in the
workforce (see 2.4 above), it will not necessarily remove the right people from the right places
whilst at the same time it will remove some people who are crucial to the railway's functioning. 

Future retrenchment must, therefore, be selective and a recruitment plan should be drawn up.There has been an effective ban on recruitment for a number of years now, with the result that
there are no employees under the age of 20 in MR. This will cause problems in the near futurewith skills shortages, especially taking into account the high natural wastage in MR, unless
recruitment at key entry grades is recommenced. 

4.4 Skills Training 

An important part of the retrenchment and restructuring exercise should be the reskilling andrefresher traiping of the remaining workforce. Some staff must be performing additional duties
in the slimmed down establishment or will require new skills in the restructured organization.
Railway operations, for example, have been performed less than at full efficiency for some time
and many of the traditional operating skills have gone into abeyance or have been lost with 
retirements. 

An exhaustive skills training package should be drawn up and implemented by the railwaytraining center. This would operate as a motivational tool as well as having practical use. Itmust be remembered, in retrenchment activities, that it can sometimes be useful to retain some
of the better older supervisors as trainers, either in the classroom or on-the-job, as such people 
are often the last repository of traditional railway skills. 

4.5 Training for Change 

An integrated plan for cha.ging the direction of the railway, the attitudes within it and the"culture" of it must be drawn up. 

This will involve a program of seminars, workshops and training sessions which commence with 
government and senior management and which spread throughout the organization. This program must be designed to enable participants to define the problems and design the solutions.
It will be an on-going program over a period of 2 - 3 years. 

4.6 Donor Assistance 

4.6.1 Financial 

Until the railway starts to break even (1996/7 in the draft corporate plan), some assistance may
be needed with salary payments if a new structure is implemented as recommended. Theamount of this assistance depends on a number of factors (salary levels, continued government 
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subvention, etc.), but could be approximately M]Kwl.5 million (US$250,000) per month. Over 

a period of 2 years this would amount to US$6 million. 

4.6.2 Technical Assistance 

It is not recommended that ex-patriates be retained in line manager positions after the 
termination of the current donor supported contracts (the General Manager, the Assistant General
Manager (Finance) and (yet to be appointed) the Marketing Manager). During the remaining
time on their contracts the ex-patriates should do everything possible to train counterparts and 
to build future sustainability of the restructured organization. 

Technical assistance will be required to assist with development of the new employment package.
the work analysis and the job evaluation exercise. It is recommended that this consist of an
initial input of 3 months followed by up to 3 further visits of up to one month each during the
lifetime of the project to ensure smooth and sustained implementation. This advisor should also 
assist with developing an appropriate training program. 

Assistance will also be required with the change management process, including the development
of the new organization. It is recommended that 2 advisors at senior level be appointed,
working as counterparts to the General Manager (after the departure of the present ex-patriate
General Manager in January 1995) and to the Commercial Manager. Both advisors should have
experience of managing change and of the commercialization process in a railway. They should
be appointed for an initial period of 6 months with up to 3 follow-up visits of up to 3 months 
each during the duration of the project'. 

The MR management should have access to a specialist in the management of change on whom 
they can call for development and delivery of workshops, specialist advice, etc. 

A practical railway operations specialist should be appointed as advisor to the Chief Traffic 
Manager for a period of one year with the specific remit to re-introduce efficient operating
practices throughout the railway network. 

' This should be taken as an indicative level of effort. The timing of the TA may be more 

sporadic, depending on the exact nature of how the assistance is designed. 
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5 	 SUMMARY OF RECOMIENDATIONS 

A summary of the key recommendations made in the various sections of the report above are 
as follows. 

I 	 Severance package
 

b Financial support to be given to increase 
severance payments. 

-- Requires input from donors and may depend on continued support at
current level from Malawi government. 

2 Housing allowance 

b Payment of a housing allowance to enable retrenched staff to purchase building
materials for a new house. 

--	 Requires input from donors. 

3 	 Housing purchase 

b Establishment of a credit fund to enable retrenched staff tc purchase their railway
house at a discount and at low interest rates. 

Requires financial input from donors and agreement from Government of 
Malawi that railway houses can be sold and that they can be sold at a discount to staff. 

4 Retraining for rff 

b Provision of training costs and living allowance for retrenched staff who can be 
retrained in an area of skills shortage. 

b 	 Provision of scholarships to retrenched staff who wish to develop their education. 

Requires f'mancial input from donors and commitment from Government
of Malawi to provide training places for appropriate candidates. 

Small 	business development 

b 	 Support to retrenched workers who wish to establish a small business. 

-- Requires establishment of a (revolving) credit fund with SEDOM andfinancial support to DEMATr for provision of assistance, and requires Government of Malawi 
to make facilities of SEDOM and DEMATT available. 
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6 Purchase of surplus railway assets 

b Financial assistance to groups of workers who wish to purchase redundant assets 
(once defined), probably through same mechanism as above. 

-- Requires Government of Malawi and MR to define surplus assets and to 
agree to sell them at a discount to ry-trenched railway staff. 

7 Release of railway land 

b Development of spare and unused railway land as agricultural and agri-business 
sites. 

-- Requires agreement of Government of Malawi to use of railway land in 
this manner. 

8 Technical Assistance 

b Provision of 5 technical assistants to work as advisors. 

-- Requires provision of personnel by donors and commitment from 
Government of Malawi to the process of change in MR. 

Advisor to General Manager 6 months + 3 x 3 months 
Advisor to Commercial Manager 6 months + 3 x 3 months 

Human Resource Specialist 3 months + 3 x 1 month 
Advisor to Chief Traffic Manager 12 months 
Change Management Specialist(s) Total of 3 months 
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Technical Working Paper 

Procurement Report 

I. Introduction 

Malawi Railways (MR) is presently undergoing a process of restructuring in order to achievea more commercially viable rail transportation system. A multi-donor group, led by the WorldBank, is presently formulating a proposed project to assist MR with the anticipated restructuring 
process.
 

In advance of a final joint World Bank 
- USAID - ODA appraisal mission, a consulting teamwas contracted to undertake a number of technical analyses. These analyses were designed to
provide the basis of project appraisal and preparation. 

This report presents the consultants findings, conclusions and recommendations with regard toselected aspects of procurement. The consultant team's specific tasks in this area were to: 

I. Assist the Malawi Railway in the preparation of a procurement plan on the various 
components of the project. 

2. Advise the Malawi Railway on the following procurement aspects: 

a) 
b) 
c) 
d) 

establishing a basis of the procurements;
determining the exact number of procurement packages and lots;
establishing standards and special conditions of procurement; and 
developing a time-table for monitoring the procurements. 

Ii, addition to assisting MR to prepare a procurement plan and procedures for the donor-fundedproject, the consultant team also assessed the railway's institutional capacity to perform theoverall procurement function. This broader analysis was deemed appropriate because: (i)preparation of procurement plans for the donor-funded project should not be developed inisolation of the overall institutional context; and (ii) the railway should use the donor-funded
project as a "building block" for enhancing procurement functions more generally as part of the 
restructuring effort. 

The remainder of this paper is organized as follows. Section I describes the overallmethodoiogy and approach used to gather data, conduct the analysis, and begin to buildconsensus at the railway. In Section III, selected aspects of the proposed procurement plan are 
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presented and discussed. An overall assessment of the railway's institutional capacity to perform
the procurement function is provided in Section IV. Finally. in Section V. recommendations 
are presented. In addition, the paper contains a number of Appendices which provide further 
details on organizational needs and proposed procurement plans. 

H. Methodology and Approach 

The team was briefed in Washington, D.C. by the Task Manager at the World Bank and again
by the USAID Mission in Malawi. A comprehensive background to the project was provided
and an initial list of people to meet was discussed. 

The team then met with representatives of the Malawi Railway in Blantyre and was briefed on
the various aspects of the project by the Deputy General Manager. Counterparts were assigned
to work with the various team members. The procurement consultant was introduced to his 
primary contact, the Supplies Manager. 

The procurement consultant visited and interviewed the following with respect to operational
conditions at the railway: (i) Supplies Manager; (ii) Chief Civil Engineer; (iii) Chief Mechanical 
Engineer; (iv) Chief Telecommunications Engineer; and (v) USAID Technical Advisor. 

The same interview format was followed throughout. Persons interviewed were asked to
describe their present operational methodologies and identify the areas that they felt needed 
improving and how they felt improvements could best be addressed. 

In addition to interviews and data collection activities, a series of seminars were conducted at
the railway on procurement and related topics. This was undertaken to better surface key issues 
and to build consensus among key managers with regards to procurement needs and procedures.
These efforts were conducted in coordination with a Senior Procurement Specialist from the staff
of the World Bank. This specialist's visit was aimed at orienting and training railway staff in 
Bank procurement practices and procedures. 

World Bank Seminar: A two-day seminar was conducted by the World Bank representative on 
March 8th and 9th. The seminar described in detail the World Bank procurement procedures
and policies. The seminar format was open and conducted in a manner that allowed for 
participant interaction, and was structured so that questions were not only encouraged but were 
generated as a natural part of the informational process. 

The following topics were discussed: (i) World Bank Organization; (ii) Introduction to World
Bank Policy Guidelines; (iii) World Bank Tender Documents; (iv) World Bank Contract 
Documents; and (v) Special Conditions of Contract. 

Each of the above subjects were covered in detail and the methodologies for document 
modification were discussed and explained in detail by the World Bank representative. Aspects 
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of Special Conditions of Contract were addressed as they related to the specific needs of the 
Malawi Railway. 

Copies of all documentation discussed and presented were left with Malawi Railways. withinformation and documentation provided in both a printed format and on diskette. Additional 
items left were the seminar work sheets in transparency format so that additional seminars could 
be provided to additional staff members. 

The following people were in attendance of the seminars. 

Mr. Dick Msyani Supplies Manager

Mr. Mike Kuntiya Senior Telecommunications Engineer

Mr. Elton Kuyenda Financial Accounts/Acting Chief
 

Accountant 
Mr. Kendrick Chenjerani Chief Mechanical Engineer
 
Mr. Stowel Mponera Expenditure Accountant
 
Mr. Evans K. Shaba Cost Accountant
 
Mr. Stephen L. Takomana Corporate Planning Manager
 
Mr. George J. Kavwenje Chief Civil Engineer
 
Mr. Boyd Bavlani Data Processing Manager

Mr. S.L. Mponela Expenditure Accountant
 
Mr. Gracewell Chimphamba Revenue Accounts
 

The seminar attained a high degree of participation. There were a number of questions posed.
Most were directed at what MR's new role would be and the degree of control that MR would
be permitted to exert in the procurement process. Initial impressions were that the World Bankwould give them a set of documents and that they would be required to adhere to them in detail.
The concept that the documents were to be used as guidelines, with certain key elements being
required, and that Malawi Railways would be constructing their own procurement documents
based on these guidelines was something that they clearly did not expect. 

The fact that MR would be left to their own devices and that if improperly modified 
procurement documents writtenwere procurement would be delayed or even worse not
approved was cause for some concern. In response to these concerns, it was stated that the
possibility of assistance existed and that documents, policy and procedure would be reviewed
by the World Bank for acceptability and once approved these documents would provide the basis 
for all procurement. 

It was further explained that a fully operational procurement process must be in place within the 
organization, setting policy, procedures and standards which would be followed throughout theorganization. A system of audit and control must be re-instituted and full accountability must
be instituted across all departments. A system of reporting, inventory control and department
accountability must be in place. Further the World Bank policies and procedures could and
should serve as the basis for all international procurement and these policies and procedures 
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could be modified to needs of Malawithe specific Railways for international and domestic 
procurement. 

Working Group Seminar: The World Bank seminar was followed by a working group seminar
conducted by the consultant team's procurement specialist on the 10th of March to discuss theWorld Bank policies and procedures av-' how they could be modified to meet the particular.procurement needs of MR. Addition .,, the criteria for defining the initial and subsequentprocurement in light of railway restructuring was discussed. The session was chaired by the
procurement specialist with the assistant of the World Bank representative. 

Issues addressed included: (i) base line documents; (ii) modification of base line documents forMalawi Railway use; (iii) international procurement; (iv) special conditions of contract; and (v)
modification of base line documents for domestic procurement. 

Other institutional and procedural aspects of procurement were discussed, including: (i)inventory control; (ii) procurement process; (iii) audit and control procedures; and (iv)
departmental communications and interaction. 

Again it was noted that there was overall apprehension in addressing these tasks independently.
The concept that MR would be the defining authority in how their policies and procedures wereimplemented was alien in respects.some While MR was enthusiastic about the prospect ofexerting more independent control over their operations, the idea that they would be theresponsible agents of these activities was cause for mild concern. A repeated question was onof assistance during the transitional phase. Associated with this concern over the need foroutside assistance was a strong concern that the assistance provided be of such a nature that theappropriate skills were transferred so that they could carry on independently at the end assistance 
period. 

It was evident throuL.1out that there was a high degree of commitment and dedication torevitalizing the railway. A high level of interest was evidenced in the institutional reforms and
capability enhancement possibilities that exist under the envisioned restructuring. 

1. Procurement Plan and Procedures: Selected Elements 

It is premature to define a specific procurement plan for the Malawi Railway restructuring
project, as the precise details of the program have yet to be fully defined and agreed to by allparties concerned. Consequently, in this section, on overall procedure and set of criteria fordefining the procurement program is developed. Exact, finalized lists of goods, by lot, will haveto be developed at a later stage. Further technical assistance is likely to be needed at that time.
Draft terms of reference for the TA are provided in Section V: Recommendations. 
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A. Establishing a basis for procurements 

Initial investigation indicated that a triage method of procurement be initiated as there was no
clearly defined project time line. However, if the railway restructuring plan can be fully
identified and agreed to by end April 1994 or mid May 1994, then the procurement process can 
be addressed and provided for on a more reasoned, logical, and rational approach. 

Discussions were held with Malawi Railway management personnel to define the rationale for 
initial and subsequent procurement packages. There was general agreement that the initial 
procurement would be directed at supporting those activities that the railway is tasked with 
conducting and providing at the base Line level, with subsequent procurement being defined and 
driven by the overall restructuring plan. 

There was some disagreement as to what presently constitutes a base line activity but there is
general consensus that these issues can be resolved through a cooperative assessment of the 
overall needs of the railway as described by the department heads and general management. 

In the opinion of the consultant the initial procurement and subsequent procurement packages
should be prioritized in the following manner. 

Initial procurement 

The initial procurement should be dedicated to those items that are critical to the safety and
operational aspects of the rail systems ability to conduct identified "core" activities. Associated
with this procurement should be items identified as "morale builders". These items should be
 
safety related 
 and be indicative of the changes that will be forthcoming under restructuring.

Such items can be identified as protective work clothing, hand tools, fire extinguisher and hand
 
soap, etc.
 

Items critical to base line operations would be the rehabilitation of track, conversion to roller 
bearings, and dependable communications. 

An initial list of items to be procured was drawn up by top railway management and submitted 
to the World Bank in January 1994 (see Exhibit 1). Many of the items identified therein are
appropriate for early procurement, using the above criteria. Others should be reviewed once 
specifics details of the restructuring plan are known. In addition, a fuller list should be"screened" against the requirements of the restructuring plan and against the phasing scheme 
proposed in this section. A fuller list :an be readily constructed by incorporating departmental
procurement lists (Appendix B) and the capital investment plan of the railway (Appendix A). 

Subsequent Procurement 

Second level procurement should be driven by railway needs identified under the adopted and 
approved restructuring plan. These items would complement the initial procurement package 
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EXHIBIT 1 

'"Core " Railway: Immediate Procurement Needs 

Item Estimated Cost ' 
(Millions of Kwacha) 

Comments 

Permanent Wa 

1. RehaD of 40km of railway 
(rail. ballast, sleepers, accessories. 
labor) 

10.92 Three-year Prog, 
starting FY 95/96 

2. Two years tamper hire &support 2.40 Austrian aid being 
sought 

3. Replacement of 15.000 wooden 2.80 
sleepers on approaches &bridges 

4 Remodelling of yards at Blantyre 1.40 
ano Muai 

5. Rehab. of Salima sleeper plant 
to produce concrete sleepers 

7.50 Essential that MR 
have sleeper plant? 

6. Replace welding equipment 

Telecommunications 

7 Replace Limbe PABX 2.00 

8 Renab telecomms route, or provide 3.20 
micro link on Nkaya-Nayuchj 

9. Telecomms. test equipment 0 750 

Mechanical 

10. Purchase roller banngs to convert 3.70 

100 brass Deanng wagons 

11. Provision of test equipment 0.342 

12. Re-equipment of mechanical & 
motor velicle workshops 

13. Rehab. overfloor w lathe 0.720 Rehab vs. replace? 

14. Srengthen Rail Tarcker mgmt. 1.30 Being reviewed byequipment USAID 

15. Re-establish core-stock levels. 3.37 Estimate from draftincluding uniforms budget: Feb. 1994 

16 General repairs to buildings 1 50 Estimate from draft 

17 Motor vehicle replacement budget: Feb. 1994 

'OTAL 41 895 

Source: MR General Manager's letter to World Bank. 17 January, 1994. 



and address second level needs under restructuring. 

Third level procurement would more fully address the needs of the restructured rail system and 
move the railway closer to more normalized operations. 
Fourth level procurement would bring the railway to identified normal stock levels as defined 
by the needs of the restructured railway. 

B. Defining exact number and composition of procurement packages 

At the present time it is difficult to determine exact numbers and items of procurement due to
the lack of a definitive restructuring plan. Initial procurement packages can be defined only in
general terms as there is still some disagreement within the managerial ranks as to what 
priorities will drive the procurement process. 

C.. Establishing standards and special conditions of procurement 

Issues relating to this particular term of reference was addressed in the seminar conducted by
the World Bank representative and subsequent meetings held with department heads. Further
assistance may well be needed in this regard and should be provided at the earliest possible
opportunity. This early assistance should be directed at providing an institutional foundation and 
framework for a professional procurement system. 
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D. Developing a time table for monitoring procurement 

The time frame for procurement should be phased so as to provide the initial procurement at the
earliest possible time after notification of loan and project approval. There may well be a need
for pre-project assistance in defining procurement packages. developing institutional procurement
capabilities, and preparing the initial procurement documents so as to be able to forward them
for approval and processing immediately upon notice of loan and project approval. 

Generally the consultant, in consultation with the World Bank representative and Malawi
Raihkay management, estimates that a time frame of fifteen months for total procurement
through the four phases would not be overly aggressive, with the first two phases of procurement
being completed within the frst eight to nine months of the project. 

Procurement beyond the initial four phases would be minimal and would be activated on a need 
to resupply basis by Malawi Railway personnel with said personnel independently administering
and monitoring the total procurement process. 

IV. Procurement: Institutional Assessment 

Procurement is a central function at the railway. Almost every aspects of railway operations,
be it line, administrative or management, has procurement needs. Any effort aimed at enhancing
procurement needs to be cognizant of the overall organizational context. This requirement is
of heightened importance when the organization operates under severe financial constraints and
is seeking to restructure, as procurement is the "gate-keeper" on expenditures and critical inputs
for restructuring. 

At Malawi Railways the institutional structure for all operational activities has deteriorated over
the years and is now represented by a system that is driven by crisis management methods. The
lack of financial resources has hampered the procurement process as well as all supporting 
activities. 

Inspection and maintenance procedures are not well attended due to a basic lack of spare parts
and maintenance equipment. This lack of resources has to a great extent caused the normal
inspection and maintenance systems to degenerate into a indifferent set of operational
procedures. Normal procedures are hindered by the knowledge that spare parts and maintenance
items are not available to address noted discrepancies. This is true at both the operational and 
management levels. 

Presented below are some of the key issues related to procurement and supporting activities at 
Malawi Railways. 
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A. Procurement 

Procurement procedures are informal and are crisis driven. At present most. or all. departments
have the ability to procure directly and there is direct supplier contact with the departments interms of procurement. Departmental accountability is virtually non-existent. The ability to track
actual procurement across departments is difficult due to the want of a viable audit and control 
system. Additionally there is no central procurement office where MR procurements areprocessed. The Supplies Department acts as a quasi-central control office but is "out of the
procurement loop" at times due to the ability of the departments to procure directly. 

At present all requisitions exceeding K250 must be approved by the General Manager. These 
requests do not naturally flow through the supplies office. 

B. Inspections 

Inspections are carried out on a scheduled basis. However, inspection forms are segmented in
their structure and do not provide information on any piece of equipment in a comprehensive
manner. The actual inspection process is questionable given the conditions under which
inspections are carried out. Inspectors are subject to conduct inspections in a less than attentive 
manner owing to the fact that they realize that repair and replacement parts are seldom available. 

The inspection reporting process does not presently allow for a historical record of repairs tobe maintained on any particular piece of equipment. The inspection forms provide information
in a fragmented fashion and a comprehensive assessment of equipment condition requires thesearch of a number of forms in order to compile a complete picture of equipment condition andhistorical maintenance. Automation of inspection has beenrecords not instituted to date.Records are manually recorded and stored in files in various offices throughout the department. 

C._. Condition Survey 

A general listing of equipment assets serves as a pseudo form of condition survey. This listing
classifies equipment by age, normally more than and less than 30 years old. There is no detailed
information available on the specific condition of any particular piece of equipment. 

D, RN~uisitions 

The requisition process is crisis driven. Again most departments presently have direct accessto local suppliers. Necessary equipment and supporting spares are acquired through this direct 
process. Prices are negotiated directly with suppliers and requisitions requiring the expenditure
of more than K250 must be approved by the General Manager. 

Supplies is sometimes cut out of the requisition and procurement process and serves to record 
these activities after the fact. 
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E. Reporting and Control 

Reporting and control procedures have not been formally introduced and there is little
communication between departments relative to general operations and how the departments
interact in the overall scheme of things. Departments act independently without coordinating
their operations with other departments with respect to procurement and maintenance of
operational assets. While there is consolidation of organizational information at the upper levels
of management, operational managers are severely lacking in their understanding of how their 
particular operation impacts other departments and MR as a whole. 

Individual department managers are often of the financialunaware costs associated with their
departments operations. They are painfully aware of the general poor f'mancial condition of the
MR in general, but the specifics of departmental costs are not normally viewed in relation to the 
present financial conditions affecting MR. 

F., Audit and Control 

Audit and control procedures cannot be effectively implemented under the present organizational
structure. Departmental operations are carried out with little or no communication between the
departments. The organizational information flow is vertical with little or no corresponding 
horizontal information flow. 

Managers below senior management levels, normally the operational managers, have reported

little access to horizontal information.
 
The present situation does not allow for comprehensive audit and control procedures to be fully

and effectively introduced and implemented at operational levels. 
 Restricted information adds 
to the segmented manner in which operations are conducted and serve to cloud the view of 
departmental interdependence in MR operations. 

G. Financial Conditions 

It is evident that MR operational activities are severely curtailed by the poor financial condition
that plagues the railway. Access to local markets is all but impossible due to the inability to
maintain accounts h, a current fashion. Credit within the local domestic markets is non-existent 
at this point in time. This situation has had a negative impact across a broad range of activities
within MR and has adversely affected the general morale of management and operational
personnel. International funding has been available but has had little or no impact on day-to-day 
operational needs. 

Substantial funding will be required to correct critical operational deficiencies and move MR
towards some sort of normal operational level in terms of operational equipment, support
material and stock levels. 
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H. Computerization 

Present hardware and software is reported to be unreliable and unsuitable to the needs of thedepartments visited. Supplies reported that the system is down approximately 50% of the timeand does not provide informational outputs in a format suitable to their needs. The MechanicalDepartment reports similar conditions and experience with their hardware and software.
Inventory control is difficult to maintain due to the format in which the information is structured.Civil Engineering reports little use of its system. Telecommunications reports no system use 
whatsoever. 

Throughout the departments visited, the present hardware and software was reported to be oflittle use in departmental operations with literally little or no horizontal or vertical information 
flow. 

L. Repairs 

Repairs are conducted on the basis of availability of spare parts. Safety related items receivefirst priority, all other needed repair is conducted based on the availability of parts. If parts arenot available to attend to needed repairs then only the repairs for which parts are available areundertaken. In the case where parts are unavailable and the repairs are safety related, then the
equipment is sidelined until the safety related parts are available. 

Parts are sourced through whatever means possible, with the second hand or used parts marketbeing used extensively. This situation calls into question the suitability and reliability of therepair and overhaul work being conducted. Indeed, there have been cases where repairs havelasted less time than the time required to carry out the initial repair. In one case a locomotivespent days in repair only to have the repair fail in less than 15 kilometers of operation. 

A substantial amount of rolling stock and support equipment is idle due to a lack of repair parts,

tools and associated shop materials.
 

J. Workshops 

Workshops are in poor condition. Unsafe working conditions exist due to the conditions of thebuildhigs proper, leaking roofs, frayed wiring, poor drainage are but a few of the items thatneed to be addressed under restructuring. Recently acquired shop machinery is inoperative dueto the lack of electrical stabilizers and some of the equipments' automated (computerized)
features have been destroyed by electrical surges. 

Arc welding is conducted under unsafe conditions caused by leaking roofs and poor drainage.There is a lack of fire fighting equipment within the shops. Mechanics and foundry personnelare required to work without access to protective clothing and safety related items, such asgoggles. Eye wash stands were not in evidence nor were first aid kits. Basic safety items did 
not seem to be present anywhere in working areas. 
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K.- Telecommunications 

A substantial amount of the communication system requires rehabilitation in order to restorereliable communications along the permanent way. Of primary concern is the telecommunication 
route between Nkaya and Nayuchi and the replacement of the Limbe PABX. 
Again this department lacks basic test equipment, protective gear for workmen and as expected, 
repair and replacement parts and equipment. 

L., Permanent Way 

Civil Engineering reports the need for immediate rehabilitation of 40 kilometers of permanentway and the need for associated work on bridge approaches. Ballast is reported to be in short 
supply. 

Financial concerns are again identified as the main reason for permanent way deterioration. 

Trains are presently required to operate at substantially reduced speeds over a large portion ofthe permanent way due to the deteriorating conditions being experienced over the line. 

Permanent way inspection and routine repair has been curtailed due to the unavailability ofinspection trolleys. These trolleys are in the workshops at present awaiting repairs and spareparts. There is major concern within the Civil Engineering Department over the inspection andmaintenance of track and bridges. Prime to these concerns are safety matters. 

There is no automated inspection and maintenance reporting or recording system in place toaccurately track and monitor permanent way conditions. Inspection procedures are in place intheory but the actual system is questionable at best. All reporting of track conditions is done

by word of mouth.
 

V. Recommendations 

A number of recommendations are made in this section regarding procurement practices,
procedures and related issues at Malawi Railways. 

A. Professional SystemofInspection 

First and foremost a professional system of inspection, maintenance, reporting and controlshould be instituted across all departments. These systems are key to the primary procurementsystem as they provide information as to what the organizational needs are in terms of theprocurement process and also serve to identify the time frames under which the procurement will 
be made. 
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A formalized system of condition survey should be designed and followed for each class andtype of asset. This condition survey should provide the following information: 

a. Year in which the asset was acquired 
b. Equipment type 
c. Make 
d. Model 
e. Classification of general condition 

1.Excellent: new 
2. Good: available for normal use with substantially no defects 
3. Fair: available for normal use with minor operational defects
4. Poor: unavailable for emergency use only and having substantial 

defects 
5. Disposal: asset has passed its economic useful life and/or has substantial 

major defects making it economically unfeasible to invest in repair 
or rehabilitation. 

The condition survey report should be supported by a comprehensive inspection form outlining
in detail the defects of the asset. These inspection forms should logged into a central filingsystem, manual or automated, with the original reports being retained by the originating
department. 

The condition survey and inspection forms should serve the basis for assetas maintenance,rehabilitation, overhaul, and 'eplacement activities. Base Line data or original report formsshould be retained by the department in charge of the asset in question. Information flowing tothe next highest level of management should be transmitted in a automated condensed format,providing only information necessary to clearly determine the general status and condition of theasset. At this point, details of particular defects need not be included as they can accessed at 
any time should senior management have such a need. 

B. CentralProcurement Office 

All procurement should pass through a central Procurement Office. 
Individual departments should not have direct access to suppliers. 

The condition survey and inspection forms act as the basis for all organizational procurementactivities. These documents provide supporting evidence of need for requested items.need not be provided when initiating a request, but should be referenced as documents 
They

in
existence supporting the request. 

The procurement process should be centralized and staffed by dedicated personnel who havebeen trained in approved formal procurement procedures. Such a departnient could either bepart of the existing Supplies Department or structured as a separate department. This decision
would be left to MR management to identify the organizational structure of such a unit. 
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The unit would require a staff level of no more than one senior manager, two support managersand three to four senior and junior clerks. This unit would be supported by staff assigned toother departments but trained in the piocurement process. 

Each department would have staff knowledgeable in the technical aspects of procurement andwhat information and format is required to accurately complete the procurement documents.These people would taskedbe with providing technical information to the procurementdepartment in the format dictated by the procurement documentation. 

Additionally each department would have within their respective departments personnelhave been trained in the monitoring who 
process so that the procurement can be checked forcompleteness and technical specification compliance. 

All of the above procurement activities should be supported by a dedicated Contract Controloffice whose job it will be to administer the contracts for legal compliance to the terms andconditions. Technical compliance concerns will be addressed by the technical personnel of eachdepartment and they shall act as support to the Contract Control office in technical 
matters.
 

Procurement Office (Department) 6-10 dedicated staff 

Contract Control Unit 4-6 dedicated staff 

Line Departments: 

Administrative Civil Mechanical Telecom Supply Traffic 

Departments Heads - familiar with procurement documents 

2 Technical writers - familiar with technical requirements of procurement
documents (part-time) 

2 Procurement Monitors - familiar with technical specifications of procurement
for monitoring purposes (part-time). 
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C. Departmental Budgets 

Departments should have a defined operating budget set by' management and based on actual
need as identified by the overall restructuring. Department heads should be required 
to knowand track all department expenditures in light of their departments budget. Budget requestsshould be based on real anticipated need, they should be developed on a Zero-Based budgeting
 
system.
 

Every effort should be made to avoid the concept that budgets grow in straight line projections
every year. Managers should be assured that adequate funding will be made available foroperational activities and that these budgets will be need driven based on actual need. Budgetswill sustain peaks and valleys over time and this should be viewed as closer to realorganizational need rather than increased expenditures in every department every year. Whileoverall organizational expenditures may increase from year to year, departmental expenditureswill fluctuate as assets are moved along to a more normal condition relative to the restructured
 

MR.
 

D. Technical Support 

Technical support may well be needed in the above areas and activities. These institutionalcapability building support activities should be undertaken at the earliest possible time so thatthe MR will be positioned to move quickly and efficiently once loan and project approval are 
authorized. 

Technical assistance should be concentrated on re-instituting comprehensive inspection andcontrol systems, identification of assets by condition survey, and ti.e institution of a professional
procurement system using the World Bank guidelines for international and domestic 
procurement. 

It is recommended that technical assistance in these areas be started prior to final project andloan approval, as most items needing to be procured are critical to operational activities andmost have a direct affect on operational safety. Additionally these are systems and proceduresthat MR will in general need in order to provide the organization with good procurement, audit
and control, and inspection and reporting procedures. 

Suggestedschedule of technical assistance: 

Procurement Advisor - Two person-months
 
Equipment Specialist - Two person-months
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Terms 	of Reference (abbreviated): 

Procurement Advisor: 

a. 	 Institute a formal procurement system based on World Bank policies and 
procedures. 

b. 	 Assist the MR with inspection and reporting systems.
C. 	 Assist the MR is the design of inspection and report forms. 
d. 	 Assist the MR in revising inventory control systems. 
e. Assist the MR in the design and implementation of reporting and control systems. 

f. 	 Assist the MR in the design and implementation of audit and control systems. 

Equipment Specialist: 

a. Assist the MR in the conduct of a complete asset condition survey.
b. 	 Assist the MR in the design and implementation of a comprehensive inspection

and reporting system for assets. 
c. Assist 	the MR in the design and implementation of inventory control systems. 

E. 	 Local Currency Domestic Procurement Account 

A local currency domestic procurement account should be instituted so that MR has ready access
to the local markets for locally available parts and supplies. The account should be under the
control of the procurement office with specific spending authorization limits being set by senior 
management. 

Appropriate audit and control systems irust be in place before the account is authorized and/or
funded. Individual department heads should be allocated a portion of the total local currency
domestic procurement account and should be held accountable for the expenditures made on 
behalf of their department through this a,.count. 

Monies requested in excess of allocated dz-partmental budgets should be reviewed and approved
by senior management utilizing their own selected budgetary guidelines. 

Spending limits should be realistically set for all departments. Suggested limits could be
K10,000 for department heads, K25,000 for the Procurement office, and amounts in excess of
K25,000 would require management review and approval. These levels are obviously subject
to review, and may be lower in the first instance while MR is still in a critical financial 
condition. 

The establishment of such an account would substantially enhance the MR ability to procure
within the local market thereby providing ready access to a multitude of small items that can be 
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described as consumable or small items of immediate suchneed. as hand tools, parts and 
lubricants, and so on. 

Initial funding for such an account would require that present debts be cleared with local
suppliers and procedures to reestablish the credit of MR with local suppliers. 

With relation to this account, all prospective suppliers would have to be pre-qualified and a pricerange for all procured items would have to be established. The Procurement Office would not
be able to procure an item if it was not from a pre-qualified supplier or if the cost of that item 
was not within the approved price range. 

Procurement of items on an emergency basis not readily available under the above conditions 
would require management approval. 

F. Procurement Levels 

Levels of procurement are of prime concern and there are a number of thoughts on what isneeded and under which time frame certain procurement should take place. In light of therestructuring process, it is the consultant's opinion that initial procurement should be dedicatedto those items central to core rail operations and track safety concerns. Additional consideration 
should be items relating to worker safcty. 

Items that may be considered as related to support activities, such as the rehabilitation of thesleeper plant should be given secondary concern and may even be eliminated under restructuring. 

Certainly shop repair would be of initial interest and should be attended to in the initial roundof procurement. Here access to local contractors would be the preferable method ofprocurement. While there is some institutional capability to undertake these repairs, it wouldbe best to view MR operations under the planned restructuring which might conceivably spin-off
ancillary activities. 

Procurement of goods and services should be attended to by outside suppliers to the greatestextent possible with MR concentrating their efforts to core freight services. MR activities
should be restricted to inspection and routine maintenance only, with higher levels ofmaintenance being primarily being undertaken and provided by contract. To be sure there arecertain activities that only MR can attend to and these capabilities should be maintained andsupported, but any other activities that can be attended to by outside contract should be
aggressively ,noved into the private contract sector. 

There is a range of opinion as to what items represent critical procurement needs. Appendix
B provides details on items departments deemed as necessary in the near-term. These lists need
to be reviewed with top management and made consistent with the specifics of the finally agreed
restructuring plan. 
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%PPE\DIX % 

Malawi Railways Liitted Cap tai invesutents (K6l4 

Investmnnt 

Re-establishment otstores core- stock leels 


Replacement of I .00, .ood sleepers at approaches to raila%
 
brideI____________________
 

iStrengthenin! of RailTracker Wagon rrackine and
 
\Ianacement S,. tem 


Replacement of Limbe P-\BX 


Serice Motor .ehicle replacement programme 


Remodelling and emlension of BlanrTe station %ard 


Remodelling and extension of Mudi station %.ard 


Purchase of roller bearing axle boxes for 100 %a2ons 


Provision ofelect-ic power suppl% and general facilities to
 
Nkhomba quamr, at Sharpevale 


General rehabilitation of buildings and ancillarv works 


Rehabilitation of Telecomms route beteen Nka'a and
 
NaYuchi 

Provision of equipment to undertake fal, detection in pistons.
 
piston honing and lubrication oil testing
 

Purchase of power driven track maintenance equipment
 
handheld
 

Purchase of a ne, flash-butt equipment 


Rehabilitation of the sleeper plant 


Additions and extensions to the Mechanical workshops at
 
Ltmbe: Remodelling and refurbishing of motor vehicle 

servicing bays
 

Purchase of additional test equipment for telecomms network 

Rental of Tamping Machine 

Rehabilitation of overfloor wheel lathe in Mechanical 
workshops at Limbe 

Additions and Extensions to the Mechanical workshops at 
Limbe: 

(A)Wagon repair facility shop rehabilitation 

(B) Office Accommodation CME and SM Alterations and 
extension 

Permanent-way renewals programme: Northern Section 
Track rehabilitation including new concrete sleepers Lube to 
Lirangwe 

Purchase of four main - line Diesel Electric Locomotives for 
Replacement 

1994/

1995 

I3t8 

,-i) 


1.500 


3.120 

370 

450 

I.0
 

1.500 

10.500 

3.750 

262 

750 

810 


6.000 

0 

1995/ 199 
1996 1997" 

10o 

o50 

549 

150 

450 

1.260 1.260 

3.000 3.000 

2.250 1.500 

810 810
 

600 600 

4.915 

TOTAL CORE RAIL 38.372 20.064 7.461 

Source: Malawi Railways Limited Draft Corporate Plan 
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Departmental Procurement Lists:
 

Selected Items
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- T(9,- r. . . , t; ,ioU. I ~c i.
(LI rit/f 

- rot(.:Liy cloth ng ro'and( boot- : l±iemen 

-P' rar U frice a nd Iineering work 

Su Ic.r po~wer for Na ;U U U Ar r ier term ina-la 

EnLter ottIice~ Fax Fa3cilit-ie 

l(CONlID CkDEL,Q I: [ORI..'Y: 

- Replacrent of '.DE-10 carrier equipment (NE, NR, EE) 

- Maintenance Veh1cles 

Air Conditioning units 

- ofnow..of Level Cros_--sing; equlpment 

TI[RD (RDER PRIORITY:
 

- UHF'/VHF radio network (Limbe - Nkaya - Nayuchi),

with multipldfing equipment, Train 
to control Radio,
 
.nd hand portables for naintenance work.
 

BEST AVAILABLE COPY 
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7 Mar-cn tB9 

THE WORLD BANK MISSION
 

ATTENTION : Mr Geor-g Howson 

CHIEF CIVIL ENGINEER'S CAPITAL INVESTMENT CONSIDERATIONS
 

Following 
 :in The discussion vou had with the undersigneo or, 
Fr-idav. 1ar-ch 4. "394 on the sub.iect. the two elements that can
be included for consideration for caoital investment for COREthe 
RAILWAY in view of the 
Schedule B' of the General Manager-Is
memorandum to the World Bank 	 are. in the order of orloritv. 

(i) 	 Points and crossinos r'ehabilitation and replacement, estima
 
ted at K6 C)'c': . uC.
 

(ii) 	 Procurement of oower 
driven track maintenance handheld
 
eouioment. estimated at KI 311 .C.C0. 

Both estimates scneduled for
were 	 imolementation over 
 a three 
years period and both are incl'uded in the 1994-1999 draft coroor­
ate olan.
 

G J Kavwenie
 
CHIEF CIVIL ENGINEER
 

CC General Manager/Deputv General Manager 

BEST AVAILABLE Copy 
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M'lr.
G Howson.
 

: '%:.'ITCK rGNT1ZOL
 

-- f---- - arts and ::Zs.-e -z e:ept 
- . .: 'est-ee : :h :.eels of User ear:men. 

. -- -n - eZ - d " :*"e p 
e-- z tor ea-oLe *.d :.eed a =,=u -: " Leo 

fo: the L:cz:otives and a ,a-::u- f £00. 

:f WC :7 .re :,otat,:ns are :.u:ed -e-fre
 
z, : " z :.- th o t _ e e r .
 a Z r e: - r m p e t l t '; su p p l z 


.o. anaoer -s aUcwed tc ao.;::ve Zrder= o-f p to 
Z.'Eery.* :rCer-in e:cess :f this =mount is sent "o 

f -r -.zrcva, adt:ti:,o Management must approve 
Se t'E 7heu.:-. of rterZsu e : ::respecti':e -he 

=-:-;a-' the Zrter is delivered to the Supplier and 
erzas are :oilecte=. A receint voucher is :aised to 

z:o:k the -ateriasZ in the Warehouzse :r they are handed to
 
-he 'er department if they were Zpec:a::! :equestea.
 

-7wig to :ashf':w ;ct:een we are unable to keep sufficient
 
Z: z f -;are ;arts and consumables. instead we buy 
-ater:s3s henever the "ser Departients :aise requisitions. 
-e :a:: thiz LYstem "hand to mouth* purchasing. This is 
urnsatisfactorv 	 because it takes time to acquire materials. 
eSnt:-e the equzpnent Is ;:ept :dle. 

:. not ent 

-o:e ':ncer thar. they shoulo. This iz partly because of the
 
:. 0a':'bl~ty of funds. !nr a year now Management directed
 
:..: "request :rder:" Ehou: pass through the requestzng
 

-. often thar 	 zrde:sto Management for approval 

.
 to aazeeent. adcit4cn to the requisition 
:n he 2Ter 'earte:t :aize, . the uF .li-&E Dapatent 

- s,, ~aain tend the-:der to .anace-ent with a covering 
t-?:::z f.r :equisiti:ni: item'th:eoor.E 	 the 

BEST AVAII.ABLE COPY 



- he ...... e 	 :tsr. - s_ ....... -- n e= _
. . .. ... .. . :: 

"-C-	 -heir 

*eq 7efl !n. 4 e -. :-:s :eas. -'"7 - e . ' --. 

:_
Z.- er 	 :uat e at :s==. ereaf't=r '.he:rz'zs are 
.isec 	 by the Prcna>: _ect::n. 

- :. a ite-_. With the 

.f 	he Zl--:e:~sec .ore tems aret::k :ontrol 

reviewe: at n E-& &.
 

2a :..nts ln :ele s , ez_- ;te: :Z2uyina 	zard-z .. nc-nic qantit:es 

C are r ecei:ed fr:m t.e stock Contr:: Zect:c n for 
orzer:in. As 7ent:znec above a minimum of some three 
quotat::nn are ident:fied ty letter, telephone, telex, or 

' After 7s:nr , :rder :n the stre7.gth :f the Z C 2. it is 
sent to !anage-ent for apprcval vhere it "s not on:7 relayed 
ut at time_= the quantity is recuced. 

:; 	 When the Crfer is appr:ved 7ore often than not, It is handed 
over t: the User Department f:r :llection of naterials. 
7hi= is due to lack of transport in the Supplaes Department. 

:d 	 Many reputable suppliers have closed our Accounts because of
 
:ong :utstand:nc Accounts.
 

Ce) 	 When materials are not available locally we source outside
 
the country. Meantime this :s a problem not only due to lack
 
of funds but also due to lack of fore::.
 

Cf) 	 Acquisiton of the _ equipment is recommended: 

(i) 	Cne 7 - tcn Lorry 
(ii) One t.5 - ton pick up
 

(iii) 	 One saloon car
 
(iv) Two motor cycles for Zustoms documentation at Lilongve
 

and Lombe
 
'v) Separate Zmal. ccmputer with printer for Stock Control 

only. The present :o-puter has been working half the 
time since ts installation last year. 

(vi) 	 One additional 5 ton Forklift. This will help fill
 
the gap of retrenched work-nen.
 

BEST AVAILABLE COPY
 



S -.en.A:t-2	 Z:-

=-e
:- the . -'e .:%e a o..t .Zr as,.e 

e . ur:_acesea...
....


An a......r .	 KE.m 
ITT. 

{,he. .4. :,apartenta. zudets shculI also be taken into 
scz:unt to at estinates.;rrLe 	 itna.the 

' ) 	The e::penitu:e-f t, £clowing User Departnent3 need more
 

attentL:n Lnr-epe:t of acc tability: 

ri;The 'Ielfar@ Account controlled by Personnel Department.
 

i'
--	 The ot r vehicle...aIntenance Account controlled by the
 
Ch:ef Mechanical Enaineer.
 

(44i 	 The L:zccmot'::e fl Account controlled by the Chief
 
Traffic Manager.
 

(iv) 	 Motor vehcle fuel Accounts for the Pool vehicles
 
controlled by the Company Secretary.
 

(v) 	Motor vehicle fuel Accounts controlled by Departmental
 
Heads.
 

(d) 	Whenever the donated Local Account materializes the User
 
Departments should -anage their budgets unlike under the
 
current procedure when all budgets are controlled by
 
Mianaaenent. The User Department should be able to know
 
the balance of his budoet at any time unlike to-day when
 
the User Departnent Is only interested in acquiring the
 
conponent 
 or service and INCT its cost! In other words
 
the User Depart-ent should be accountable for his
 
budcet. This vii" inzti some discipline in controlling
 
Railway funds.
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aIZ _ 7- Ztn :er e:t e fepar:e: 

De a:-e nz Z'!.. : 

* e -. ",.-the s3i=t3nce Jsere '- ... a:::a.. 
Deprt~n~zznc'::-i '-Be "he issztance as f:ss 

(i- -,,-edia terzLa:2 -c,-. ze na :: i 


(i i 3aitenance " n-othr 

teve - ... . ' . 4 -or.the.
 

S: rezcmmenr that wnenever .re. .. ; .::hasezare nade out of 
-e-e ShCU-4 te u.sed.
thia acc:ount f :7Cedzt 


6. WCRL 2ANK 77...N AL.. :3TANC7 

Technical AZ iztance iz zaid to be divided intc:
 

' _-z ..... -orths
 

~b)Tor: ern' tc C "crnt;-s 

!f we ::: f:r ":rg ter- :t :3 unde:rtood that the Procurement
 
-pec:- :st would w:rk with this Departent !:r 6 to '2 months.
 

-:urz:g this pe: lZ he WI112 1-part knowledoe to us on World Bank 
Purchas:.z -r:ced.res. 

On the cthe- hand the short term :ption will involve the following
 
pr:gra-me. A c:uple :! staff from this Department would be 

attached to M:istry of Agriculture and rnistry of Transport and 

Comnunicat:ns in .i.:cngwe. These Ministries are already 
conversant with the World Bank 2uying Procedures. Thereafter a 

World Pank Prccurement Tpecialist would be attached to this 

Decartnent in order tc monitor and satisfy hinself that the 

knowledge gained at the two Ministries is adequate. He will 

inpart knowledge where he feels it is wanting and he will do this 

in 2 to G months.
 

After careful consideration I recommend the option of short
 

terT. And I have in mind of up to 3 me~ters of staf! who should
 

take up the assignment as soon as the programme is in place.
 

.... ZYA,,.
 

CC: Zeneral Manager/Deputy General -anager
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Is Guorge Howscon
 

in lx.rcn . '2,iou ,4 "ad .. di':Scu:sion On' ":cme of he eu<. 
ot 
 "n 	 "A iAW ;hu' WmCIe se MV, ~ ug q Alz Q'. 1 *1100V r2 

' 

. 0 1 L "(V4 "'"W 

.he 	 eMDr , of I low t;he or&oVees rates aY' too Tor cost "L'VO .. 
Lau lz oo'' Q l ,"- upod -0 mos t o-f t;hei r time or ,,rv 

A7bout nn'":w r" : ; evu ,b epi
"t',"', j.'. n q toc O. ic,res 
 ruwl;,on.;q, :,
 

stead ODT 'Co w:ntrauloy on who~ job. A~ person 'ma uWA 
decent wage is proud Of hLS Job and will do more wc, ran 
better wor' . He wiI'l Ue prou( of what he h,as done and th I. 
will improve productiv /. 

a.. The f.oct rh ? the rail roud nlas ve ry little credi t, caus1es the 
price of .oc.i purchase items to be inflated in price, due to 
the time too purchaoe is made and the bill is paid, the 
mercnants Tiflate th'e pri.ce to make up for interest on ;heir 
money. h in' "funds W'ouid he made ava .aol e to make these 
local purchas:es. Thiz would make the time shorter for the 
purchas ing department to issue an L P 0 number. This would 
,ut down on the down time for shop machinery, road vehicles 
and locomotives improving productivity and availability of 
locomotives and vehicles. Adding to the revenue of the 
Railway making it more self reliant.
 

.3. 	 The Diesel Shop roof is in very poor condition, leaking In
 
many places with water leaking on most of the work 
 areas 
making it impossible to work in these areas when it is rain­
ing, causing low productivity during the rainy season and for 
days after a rain because of deep pools of water on the 
floors and in the pits. 

4. 	 Cleanliness of 
the Shop is very poor because of poor drainage
 
of the pits. Also the lack of cleaning materials for the
 
floors.
 

5. 	 The locomotives are not cleaned before their monthly inspec­
tions due to the lack of proper cleaning machine and solu­
tions. This makes a lot of the inspection items hard to see
 
because of the dirt and grime. This could cause fai lures on 
the road causing late arrivals of trains which could cause 
loss of business and revenue. 

6. 	 A washing machine of some type should be bought 
for cleaning.
 
Traction motors and alternators. This machine could be 
 used
 
to wash most components of the locomotives except the trucks
 
and the engine block and these could be washed with the same
 
machine used for washing locomotives. The only washi.ng 
machine I know of is prococo iniMontreal and Jacl'.onv .].lc:., 
Florida. 

BLSI 	AVAILABLE COPY 
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Ltcc th"e :;o ecn ni i " r e Of the ,K'-a,' a.Jl, ELJ *o : t iv, 

* r " V A l 	 0 W t h e 4 . D v . 1 o : c. ­

'." :lI- S A o wac: t :hL: type o V Exci ation in used 
n," 1 	"Q. o) t- - n i trai:n.ing that could be mnaed.? .+Avai: auQL., 
ou2d,d = _ri, '...-, a rex reci expert, who has had experience 

.. n 0 . There is ri uL -er of to; Ls which Ls requi re i n fh., 
Shop. TIese Woo't:, wll LMprove productivity. Most are ,-A 
.uK t .if t;he pr,.,ent I Ojramme i.s to be effective. The ovp r -. 
ha.u z f the railij-e locvrmotives- is vo(,ry important this time. 
Due. to the 1 cP1 of s:pare part3 over the past deca.de some 01 
the locorot ives have not had a general overhaul since: they 
were new in 1980. 

E am giving you a list of tools which is critical due to lacl. 
oF cat.x(Iu,tes 1 can not give you pa'rt numbers f.'r many of t;he 
tools. 

The ]. is t is:.­

1. 	 2 welding machine with cables 
2. 	 2 3/4" drive air impact wrenche, 
3. 	 3 1/2" drive air impact wrenches 
4. 	 1 1" drive air impact wrench 
5. 	 1 complete set of impact :ockets for each size if impact
 

wr en c h
 
65. 	 2 electric angle grinder 
7. 	 2 air grinders '7" 
3. 	 1 000' of 1/2" air hose with Fittings 
9. 	 1 crimping tool for traction motor leads 

10. 2 3/8" drive drilling machines 
11. 2 1/2" drive drilling machines 
12. 3 sets of drills from 1/8 to 5/8
13. A number of drills with tapered shank between 3/4" x 2" 
14. Straigt reamers with tapered shank between I" and 2" 
15. 3 10b sledge hammers 
16. 6 pry bar 36" long 
17. 6 sets of open end wrenches from 3/8" to 11/4"
18. 6 sets of box end wrenches from 3/8" to 11/4"
19. 6 sets of 1/2" drive sockets from 3/8" to 15/16" 
20. 6 10" 1/2" drive extensions 
21. 6 5" 1/2 drive extunsions 
22. 6 1/2" drive ratches 
23. 6 1/2" drive power handles 
24. 6 13" pry bars 
25. 6 10" screw drivers 
26. 6 6" screw drivers 
27. 6 3/4" coli chisels 
28. 6 sets 8" pliers 
29. 6 1lb ball peion hanmmers 
30. 6 1." tool boxes to put above tools in 
31. 2 3/4" drive ratchett setW 
32. 2 1" drive ratchett sets BESTAVALABLECOPY 
33. 4 1.8" pipe wrenches 
34. : 14" M ue wronch(..: 



4L. 3r ou fl,.Ll ,'r a 

.rh ese too l s or. 0~cu nc in in;-e A Lco r o iJ C a talogue arnd Azz .0W 
puro thoold f;r. E1.I 

D' DESCR:IPT I 	 -: 

2 24 795z04 Wrerlcr generat;or
Z0t ' 	 2

"24" ",7'' U ron1hU.J i](-? 2c? to'r 	 , 

3 2470.16' JacP :et
 
4 24701.14-i. Engine LiFting rig 8 cyc.
 
5 2474532 11/2" drive hyd. torgue wrench I.
 
6 ,247453Z R:eac: ion arm 
 L 
7 2475323 Special s oclket
 
8 24745347 LockiLng pin and ring .
 
9 24745318 Socket set
 

10 24745339 Spare part kit: L 
I.:t 24741358 ToGrqu: auge ± 
12 2474534 Hyd pump unit air operated I 
13 24745326 Hose 20' twin line 1 
14 247453'53 Spare parts kit 1 
15 21.57111 Hyd. fluid 3 
16 2745357 Filter G
 
17 2478005 Indicator with magnetic base 6 
18 2470176 Turning plate gen end 8 cyc I 
19 2470175 Turning plate free end 8 cyc I 

9. 	 Tool Crib. It is my opinion a tool room be built and divi.­
dcl in half for mechanics tools on one end and electrical 
cools on the other. Steel shelving should be made up to 
place the tools in proper order and an inventory control 
system set up so the tools will be returned at the end of the 
work day. Also this room must be well lighted.
 

10. 	 Spare parts. The orders for spare parts for the general 
overhaul and maintenance are now arriving, but the rail road 
has been trying to operate without spare parts for some time 
causing the locomotives to get into a very run down condi­
tion. This also causes the men working on the locomotives to 
be very laxs when doing their inspections as they know there 
are no spare parts so why find any thing worn or broken. [ 
is my opinion the Supplies Department have an inventory 
system set up that has a minimum and maximum system for 
number of spare parts on the shelves. This would require a 
constant flow of funds instead of large amounts every 3 or 4 
years, also the lead time of the spare parts delivery has to 
be taken into consideration. It is also my opinion that 
more of the sub components be repaired and less new subcompo­
nents bought with the new tools. This would be possible. 
This would help the railroad to come up with a yearly budget 
for the repair of locomotives and save money in the long 
term. This would also help the railroad come to a profit 
making company. 

BEST 	AVAILABLE COPY 



- DerA-lmenta. rhe track in most area is in poor conditicn 'c 
every week or so there is a derai iment. These dera Iments 
Are very costly, both in labour and the loss of bussiness. 
rhe loss of goods on a derailed train and the time consumed 
Uetting the equipment toback on track causes the customer 
have no faith in the railroad, so they go to road transport
which cost more bu: is more reliable. This put-s the cost of 
.ood, higher in price which is bad for the economy of the 
country as a whole. 

.2. Over floor wheel lath. The present wheel lath is approxima­
teLy 30 years old and is in bad condition. This lath should 
be replaced with a new modern lath, as to spend money on thi!. 
old lath which parts can not be found without a special order 
is very costly and time consuming, causing long down times 
for the lath. I am sure a new lath could be purchased for 
less money than sending the old one back to the builder and 
having them upgrade it with the high cost of transport and 
cost of building new parts for an old machine that is no 
longer being built. 

13. Safety clothing and equipment 

lunds should be made available to buy protective clothing for 
the employy . working in high risk areas, such as moulders, 
blacksmiths, and welders. This clothing and 
equipment would 
cut down the risk of the employee burning his personal cloth­
ing, also injuries to himself by being burned, causing lost 
time accidents, plus pain and suffering. This should improve
the productivity of these employees.
 

14. Road vehicles:-
 Many of the road vehicles used to transport
 
parts and personal 
from one area to another are very old and
 
require 
 a lot of repairs to keep them serviceable with the
 
high cost of parts, and 
down time while these vehicles are 
being worked on, it is counterproductive to the railroad. 

15. Computers. 
 I think funds should be made available for the
 
supplies to have its own computer system, so 
it is available
 
at all times instead of 1/3 of 
the time as it is now. This
 
causes delays in the movement of parts and materials from 
supplies to the Shops, this slows down the repairs of rolling
 
stock.
 

A computer or some manual method should be set up to keep
records on all locomotives showing the services and repairs 
done on ea=h locomotive. 
 This would help determine the cost
 
of maintaining each locomotive over certain periods and 
 give
 
some indication as to what should be set up 
 fo, a yearly

budget, to 
 keep the Shop operating on an even flow. 
 This 
would cut down on emergency funding being required from time 
to time. 
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'.. !q -, oA.r, c:L¢., Lnborat o'' - rh l .atborator), ' rOLL ]lt i .. _:' 

JN!DO ili missing several pieces of equipment to make 1ti. 
ope'rlAtional. 1 feel th L1quipmen t ":hou. be bouglht and hav.,
the aboratory made operational. It is my understanding ou: 
lub oil U(n Le tested t.n this laboratory. I f the pr-:r~r
equipment is brought in and an expert to train a local tecn-­
nL ;ion. rihis would save the cost of sending our oil ou tolu ­
the curtry to be tested. We would have irmediate results, 
there ro" e the locomotives which whow high contant of M:etal.;
in the oil can be chec.ed and repaired beTore seriousi dam ,',q. 
LS caused which can be very costly. This would be : .Irot 
for the country and possibly outside industry would make use
of this oil laboratory. This would create a source of !a­
come. 

17. Mfovement of materials within the plant. 

A small cushman truck of come sort should be purchased for 
the movement of spare parts from the Supplies Department to 
the various locations throughout the Shop. The old home made 
rm'achine for moving wheels and tires is very old and made up
of va'rious parts which are not replaceable. This machine 
should be replaced. 

The above 
report is all of my own opinions. It is my belief that
 
if the 'restructuring of the Railway 
is to be successful, most of
 
the above matters have to be dealt with.
 

WALTER E HARPER
 

U S A I D
 
MALAWI RAILWAYS LIMITED,
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Technical Working Paver:
 
Manafement Information Systems Development and Trainine
 

Introduction 

Malawi Railways (MR) is in the process of implementing a major restructuring program in 
order to improve efficiency and carry out operations on a more commercial basis The
railway and Government of Malawi have sought financial and technical assistance from a
multi-donor group led by the World Bank, to support the restructuring efforts. 

A multi-donor team is expected to conduct a project appraisal mission in April 1994 
However, the donors requested that first a consultant team be contracted to undertake a
number of analytical studies, in !upport of project preparation activities. 

This 	 report comprises MR'sone of those studies and addresses an assessment of 
management information systems (MIS), particularly with respect to the railway's ability to 
prepare project implementation and monitoring plans. It also provides details on the 
MIS-related training conducted by the Consulting Team. 

The MIS Expert on the Consulting Team was in Malawi for a two-week period, starting
February 28th. The MIS-specific scope of work was to: 

1. 	 Conduct in assessment of MR's MIS to determine what interventions (software
and equipment) are required in order to enhance MR's ability to prepare project
implementation and monitoring plans. 

2. 	 Assist MR to prepare a project implementation and monitoring plan. This plan shall 
be in the form of a Gantt chart and shall indicate specific activities, milestones,
phasing, time and resource requirements, and critical inputs. 

3. 	 Train MR's senior staff in the use of project planning, management and monitoring
software such as Microsoft Project (Version 3.0 or later) or Time Line for 
Windows. 

The remainder of this paper is organized as follows. In Section II, an inventory of MR's
hardware and software is presented and an assessment of MR's MIS is provided. In Section 
III, an evaluation is conducted of the ability of the current system to support decision
making tools for MR. In Section IV, there is a discussion on the training seminars given on
project management and the impacts that they had. In Section V, a preliminary project
implementation plan for the Malawi Railway Restructuring project is discussed. Finally, in
Section VI, recommendations are provided for improving: (i) the overall system; and (ii) the
ability of MR to conduct project management. Included with this repor: as appendices are:
a) an overview of project management; b) the abridged user's guides to Microsoft Windows
and MS Project; and c) a preliminary project implementation plan for the MR Restructuring 
Project. 
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IU Assessment of MR Information System 

In 1991 the Overseas Development Agencv (ODA) purchased a new information system for 
.MR By June 1994. MR hopes to be fullv converted over to this new system It consists or 
a Local Area Network with TCP IP network software. a rrurucomputer, and two servers 
connected to both smart and dumb terminals located around the railway (See Exh.ibit IH
This network is used pnmarnlv for accounting, payroll, and personnel functions and for 
word processing 

The minicomputer is a DRS 6000 with a SPARC processor. 25 MHz. and 48 MB R.\l 
The servers are each DRS M75 personal computers with a 486 processor. 25 M-z. and 12
MB RAM One of the servers is located in Data Processinz and serves two functions ii)
the development of applications, and iii) a gateway into the rminicomputer The second 
server is located 'n the Supplies Department. Its sole purpose is to function as a gateway 
into the minicomputer 

This is a very powerful system with significant potential. However. currently there are 
often problems in accessing information from the network. This may be due to (i) a lack 
of understanding of hov to maintain and properly use the network; and/or (ii) the system
may be inappropriate for the railway However, it was not in the current team's scope ofwork to do an exhaustive review of the entire system, but rather to focus on how well the 
system meets the needs of project management. 

Curret.-Liv the following managers have printers and personal computers (PCs) with 286 
processors, 16 MHz, 4 MB RAM, and approximately 40 MB hard drives: 

* the General Manager, 
tthe Deputy General Manager,
 

* 
 the Assistant General Managers of Finance, Traffic, and Procurement. respectively, 
* the Data Processing Manager, and 
* the Data Processing Manager Secretary. 

In addition, there are three PCs with the same setup in the Software Development area and 
one in both Personnel and Civil Engineeiing. They can act as stand-alone PCs as well as
workstations in the network. They operate under MS DOS 3.0 and Microsoft Windows 
3.0. However, MR staff generally do not take advantage of the user-friendly software 
available in the Windows environment. Instead, the main applications used are WordStar, 
an antiquated word processing package, and Lotus 123 for DOS. 

Three years ago, when these computers were purchased, they were considered powerful
machines and were capable of supporting the software available. However, due to the fast 
pace of computer technology, these ccmputers are now barely sufficient to support the 
specifications ofmodem software. 
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The remaining workstations in the network are dumb terminals and are situated in the
 
following locations
 

I in Systems Development.
 
8 in Data Entr.,
 
3 in Mechanical Engineenng,
 
I in Ciil Engineenng
 
4 in Supplies.
 
1 in Personnel.
 
I in the Internal Auditor,
 
.3in Expenditure Accounting, and
 
8 in Revenue Accounting.
 

All of these terrmnals were purchased in 1991 except for the eight in Revenue Accounting
and six from Data Entry, which were purchased much earlier. However, the technology for 
dumb terminals does ,.or change significantly over time. Thus, these terminals are sufficient 
for their purpose of accessing the network. Unfortunately, many people. including the
telecommuricatiuns engineer, have no access to a computer or printer in their own areas 
Thus, people are often forced to physicaUy move to the Data Processing department to do
 
their work.
 

The primary tasks performed at the terminals is word processing on Fenin. the word
 
processing software installed on the network, and routine accounting work with packages

developed in COBOL by MR software developers. Currently there are no spreadsheet or
 
graphics packages available on the network. This can be problematic for some of the

engineers and accountants who need access to such applications to perform their work
 
effectively. Moreover. there are often difficulties accessing and working with Fenin. To
 
alleviate these problems, Boyd Bvalani. the Data Processing Manager is investigating the
 
possibility of installing Uniplex on the network, a combination of applications including a
 
word processor, a spreadsheet package, adatabase package, and agraphics package. 

I1 Ability of MR to Conduct Project Management 

In order to successfully manage their projects, MR managers need to have the proper tools 
tc, plan and organize their activities and to keep track of the progress made on those 
activities. Furthermore, they must be comfortable in using the tools. They also need easy 
access to company information kept on the network, for example, personnel or accounting
information. Currently, this information is difficult to retrieve and is not provided in 
convenient formats. 

Effecting a change to asystem conducive to project management would be relatively simple
from a technical (hardware and software) point of view. Each manager would need a 
computer at his desk which supports user-friendly word processor, spreadsheet, graphics,
and project planning packages. This would be compatible with and complementary to the 
current system. The computers would act as stand-alone PCs as well as workstations in the 
network. 
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IV Training Seminars 

As part of the MIS task. the consulting team gave three training seminars on proiect 
management The first serrunar was conducted in the MR training center It covered the 
basic pnnciples of proiect management, gave an introduction to MS Project. (a prolect
planning and management software package), and provided some examples of exhiblts that
could be produced using this package (See Appendix A) The attendees at this seminar 
included the Chief Civil Engineer. the Chief Mechanical Engineer. the Corporate Planner. 
the Head of Supplies. and the Data Processing Manager 

Several of the attendees commented that this was the type of tool which was acutely needed 
to hclp manage their activities and avoid delays, Some of the attendees were already
familiar with project management concepts and techniques, while to others, these concepts 
were new. Many questions were asked about how the software would be applied in specific
instances (eg How would the software be adjusted to reflect delays in shipments ' ) These 
questions showed staffs genuine interest in applying the software to their jobs. 

The second and third seminars were conducted in the Data Processing department and were 
oriented toward actual use of the software These two seminars included an overview of 
project management and provided hands-on training in operating a mouse and in using both 
Microsoft Windows and MS Project Abridged user's guides to Microsoft Windows and 
MS Project were distributed (See appendix B) along with the standard documentation 
provided with the software for MS Project. The attendees included Mackenzie Kachanje.
the Data Processing Deputy Manager, Khuma Kadongola, a Senior Analyst Programmer. 
and Aggrey Kumwima, an Analyst Programmer. 

None of the attendees had used Windows or a mouse on .1regular basis. However. the 
three attendees quickly gained a basic proficiency in Windows and the mouse, sufficient to 
access and perform basic functions in MS Project. By the end of the training, they attained 
an initial comfort level in using MS Project. At this point, the staff are able to set up a 
project in the system, including entering tasks and durations, specifying resources, and 
assigning relationships. Although there was not sufficient time to provide detailed training 
on managing and updating the projects and on producing various status reports, the 
trainees' knowledge of the package is such that they will be able to continue training
themselves with the aid of the user's guide and of the manuals. It ispossible that they will 
need more training in the future on some of the more advanced features of MS Project. 
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V Project Implementation Plan 

.-n initial draft of a project implementation plan for the Malawi Railway Restructung,
project is presented in a Gantt chart in Appendix C This isavery prelimrunary draft and %kill 
require several phases of revisions 

I 	 The first phase should take place after the appraisal rmission, when the project is 
better defined 

- The 	second phase must involve MR management It is vital that they are involved 
in the Project Definition phase It was premature for such activity toan occur 
dung the Consultant Team's visit 

The third phase w111 be agradual one. Over time, as individual project components 
near the moment of implementation, detailed tasks associated with each of these 
components will emerge 

By the end of the Appraisal ission an assessment should be made of whether MR is in a
position to adequately (i) define and plan 	 the project in a manner consistent with MSProject needs, and (ii) run the software (MS Project) A minimal amount of TA and 
training may be needed subsequent to this phase 

VI Recommendations 

ForImproviwngthe Overall Sstem: 

In order to effectively use the current information system: 

I 	 Selected ,MRstaff should be trained in how to properly maintain the network and 
how to simplify information retrieval from the network; 

2. 	 All relevant staff should be trained in using the network; 

3 	 Additional software applications including a good word processing system, a 
spreadsheet, and a graphics package need to be installed on the network. A 
combination of packages like Uniplex is ideal 

4. 	 More terminals nd printers need to be available for the staff. The computers that 
are currently sitting on the managers' desks could be distributed around the 
railway, as the managers' systems are upgraded (see below). 
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ForImprovng the .- bil, of.AIR to conduct Project. .anagemet." 

Management needs more powerful systems to support tools which wouio aid them in 
decisicn making :Al managers should have 

Access to information on the network. 
PCs with mouses and 486 processors. 
4 or 3NB R.AM. 
Sufficient hard drive space (at least 70 NIB). 
Microsoft Windows. 
Windows-based applicationb and 
Training on Windows and Windows-based applications. 

A selected group of manager, should also have a project planning and management
software package to effectively plan large projects MS Project is an appropriate package
It meets staffs project planning and management needs, runs well on the svstem 
recommended above, and MR staff have had an initial training in MS Project. More training
will be ,ecessary Once the selected staff members become more adept at using the 
software (either through additional outside training or on their own), they should train other 
staff. including management, to use MS Project. 

An overa!1 audit of the NL at ,MR should be conducted once the specifics cf a detailed 
restructuring plan are known. In addition to addressing the network, this study should also 
identifv other software packages (ie., other than MS Project) to be made available to 
managers to support decision-making and amortize the investment in their equipment 
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An Introduction To Project Management
 



An Introduction To Proiect Management
 

Abt Associates' role in the Management Information Systems phase of this joint World
Bank-USAID Project Preparation Mission for the Railway Restructuring Project is to train
the Malawi Railways in preparing a project implementation and monitoring plan. In order 
to achieve this goal, there will be three training sessions The first session will cover the
basic principles of project management: an introduction to Microsoft Project (MS Project). 
a project planning, management, and monitoring software package; and some examples of
exhibits that can be produced using this package. The second session will cover the basic 
elements of using Microsoft Windows and MS Project. And the third session will cover 
more advanced topics in MS Project. 

WHAT IS PROJECT MANAGEMENT? 

Definition: Proiect management is the planning, organizing, and managing of tasks and 
resources to accomplish a defined objective, given the constraints on time and cost. 

Managers of almost any aspect of business can use project management concepts and 
tools to manage their work. 

* 	 If a project involves more than a few tasks, or if there are several resources to track, 
one can benefit from using project management. 

* Project Management requires a team effort--everyone from managers to engineers to 
data processors should be involved. 

Goal: to achieve a specific objective within a given deadline and budget. 

• 	 The objective may be as simple as planning and designing a corporate brochure or as 
complex as restructuring a railway. 

* In each case, the project must be broken into easily manageable tasks or activities, 
tasks must be scheduled, and the progress of the work must be tracked. 

" 	 Resources such as people and equipment can also be assigned to accomplish these 
tasks. 

Project management can help answer various scheduling, resource, and cost questions, such 
as: 

0 	 How long will the project take? 

0 	 If a particular task is delayed, will it cause the entire project to be delayed? 



* Which tasks are critical to meeting the schedule' ) 

.Are there enough resources to complete the project as scheduled? 

* What are the costs of the resource for the project? 

WHAT ARE 	THE PHASES OF PROJECT MANAGEMENT? 

Defining the project: Before any work on the project itself begins, 

1)the objective of the project must be identified, 
2) the constraints must be specified; and 
3) the resources available must be defined; 

Planning the project: This is the most important phase of project management. 

It includes: 1)defining the tasks and their durations, 
2) setting up relationships among the tasks, and 
3) assigning resources to the tasks. 

All of the project's later work is directly based on the information provided
when the project is created. 

Managing the project: This phase of project management is an ongoing process that 
begins when the project is created and ends when it is complete. 

It includes: 	 1) periodically updating the project to reflect the current status, 
2) providing status reports to keep everyone informed,
3) tracking the progress against the existing plan, and 
4) adjusting the project to reflect major unforeseen changes. 

Thus, accurately defining the project is the first phase of project management. The 
management should define the project objective, constraints, and resources. Planning theproject is the 	second phase. It involves a team effort to define all of the tasks involved,
their durations, and their interrelationships. This information serves as the inputs for the
project management software, MS Project. The third and final phase is 	 managing theproject. This, like the second phase, involvts a team effort. The Data Processing
department should keep the software up-to-date based on information from the entire team
and produce status reports; management should keep track of the progress to aid in decision 
making and adjust the project when necessary to achieve the objective. 
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USLNG THE CRITICAL PATH METHOD IN PLANNLNG A PROJECT 

The Cntical Path Method (CPM) is a way of calculatini the total duration of apro*ect based on
 
individual task durations and task dependencies This model is the findamental schedulini, method
 
used in pro.iect management 
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SLACK TIME is the difference between the tune available for a task to be completed 
and the duration of the task. 

FREE SLACK TIME is the amount of time a task can slip without affecting
 
another task.
 
For example. Task Ihas 2 days free slack time.
 

TOTAL SLACK TIME is the amount of time a task can slip without affecting the
 
project completion time.
 

The CRITICAL PATH is the series of tasks that must occur as scheduled for the 
project completion date to be met, i.e. none of the tasks in its path can he delayed 
without delaying the entire project (all tasks have 0 total slack tune). 

Possible Paths: 
1-3-5-7-I1 (5+8+11+2+9) = 35
 
1-3-5-8-11 (5+8+11+6+9) = 39
 
1-3-5-9-10-11 (5+8+11+8+3+9) = 44 - Critical Path
 
1-4-6-9-10-1I (5+7+4+8+3+9) = 36
 
2-4-6-9-10-I I (7+7+4+8+3+9) = 38
 

MS PROJECT EXHIBITS 

MS Project produces a variety ofexhibits which am useful tools for project management. The following 
exhibits are included here: 

-Exhibit 1: Gantt Chart - a bar chart which shows task durations and start and finish dates;
 
-Exhibit 2: Delay Gantt Chart 
- a Gantt chart which shows resources and delays,

-Exhibit 3: PERT Chart 
- a diagra.i of the project schedule that shows dependencies among tasks; 
-Exhibit 4: Resource Graph - a graphical representation of resource information over time; 
-Exhibit 5: Project Sunmnary - a summary which tracks the progress against the existing plan; 
-Exhibit 6: Weekly Resource - a list of each resource's tasl-s by week; and 
-Exhibit 7: Monthly Calendar - a Monthly Calendar showing when tasks are scheduled during the month. 
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1 Donald Arrow DNA 
 $10.001h $0.001h $0.00 

ID Task Name Units Wort Delay I Scheduled Stan Scheduled Fntsh 
11 Buk Excavation 1 0.2 3d r Od i 1112192 8:00am 11120192 5.00m I 

2 Fred Fernsier FF $10.00/h $0.00/h $0.00 
I0 Tsuc Nome Unnsi Work I Delay I Scheduled Stan I Scheduled Fmmh i 
2 Buidmg Plans I 0.2 17.8d 0d I 1015102 9:00am i Z'4193 5:00pm 

11 COsids Lid. C $55.00/b $0.O011 $0.00 

iD Task Nam* Unito Work ty i Scheduld Start Scheduled Fimh 
2 Buddig Plani 1.3 89d I Cd I01592 8.00am 1 11719311:42am 

13 Falnkm & Sons F $100.005 $0.00/h $0.00 

ID I Task am i Unns p Work i Delay Sch*dulad Star Sceduled F.mh i
 
11 Buk Excavation I I 1d Cd I 1112J92 :00m 111120/92 5.00pm
 

Weak of Novsmiei 15
 
1 Donald Arrow DNA 
 $10.000 $0.00 ;o.oo 

ID} Test Name IUnns Work 01day Schadukd Start Scheduled Fin h 
11 BulkErcavaton 0.2 3d 8:00amCd I 1112192 1 1112092 5:00pm 

2 Fred FsmWr FF 1110.001 $0.00/1 $0.00 
10 Test Name Unis i Wok Delay I Scheduled Start Scheduled Finih 
2_ Budding Plans 0.2 17.8d 0d 10/92 0.i0am 21413 5.00pm 

11 Cosiaso Ltd. C $55.00/1 $0.00/b $0.00 
ID Task Name Units Wak Deay Scheduledl Stan I Scheduled Finsh
 

2 i Budding Plans 1.3 80d I d t 1015102 8.00sm I 11719311:42am
 

13 Fabrkem &Sans F 1 I00.00h $0.00/h $0.00 
710 1 Task Namei Unns Wat Delay Scheduled Stan I Scheduled Firh ] 

11 I BukExcavatin I 15d Od 111928:00m 1 11120192 5:00pm 

Wek of November 22 
2 Fred Fesor FF 1 $10.00/h 10.00/ $0.00 

10D Te* Name LkUit Walk I 0elaY Scilodled Stan ScheduledFinish 
2 Budding Plas 0.2 17.d Cd 10/5/92 9:00am 24193 5.o0pm 

11 Costese Ltd. C $55.00/ $0.00/h $0.00 
1D Tak Name iss Waik Dlay Scheduled Stan Scheduled Finsh
 
2 Budding PMns 1.3 BUd Od 1015/02 9:00am 11719311:42am
 
12 Budding Layout 1 3d Od 11123/ 2 8:00am 11125102 5.00pm 

14 K.C. Hayes K 1 $30.00M $0.00/b $0.00 
1T Ni a l Scheduled Stan Scheduled Fmh
 

M14 1 15d d 11126/929.'00am 12J1&925.00pm
Ecavatea~ida 

WeAkof Neavmbar 29 
2 Fred Fstsli FF 1 $I0.0h $040 $0.00 

10 ITat Name Units IWait Delay Scheue Stan Scheduled Finish 
Buddin Plans 0.2 17.1d Cd 105/92 9:00am 21493 5.00pm 

11 Costes. Ltd. C 1 155.00 $0.00/b $0.00 

ID Tea Name Unis Wat Dea Scheduled Sen Schedud Ft 
2 Badding Plan Cd 1171931.3 ONd 10/5192 9.:00am 11:42am 
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An Abridged Guide to Using Microsoft Windows
 



AN ABRIDGED GUIDE TO USING MICROSOFT WINDOWS 
(PREPARED FOR MALAWI RAILWAYS) 

Introduction 

This guide is intended to provide guidance to Malawi Railwavs (MR) on how to 
operate a mouse and how to use Microsoft Windows, a user-friendly, point-and-click operating 
system. It provides step-by-step instructions for the basic procedures necessary to organize
and manipulate programs and applications. This guie was developed in order to assist iR to 
use MS Project, a project planning and management software package which operates in a
Windows environment. For a more detailed overview, it will be necessary to refer to the 
Windows user's guide. 

Using a Mouse 

Moving Around the Screen: 

The mouse is a device for pointing at things on the screen. It can be used instead of the 
keyboard to carry out any Windows task. As the mouse is moved along a desk or any other 
flat surface, the pointer moves on the screen. If there is no more room to move the mouse. 
just pick up the mouse and move it to an open space on the desk and continue. Sometimes the 
pointer changes to an hourglass shape. This means the computer is working. 

Selecting andDraggingan Item: 

An item on the screen is selected by moving the pointer to the item and then pressing and 
releasing the left mouse button. This is called clicking. To select an area of the window or an 
icon, point to the object and click the mouse button. Once an object is selected, the mouse can 
be used to drag an item from one area ofthe screen to another. Another way to select an item 
is to rapidly click twice. This is called double clicking. 

Getting Around the Windows Environment 

ProgramManager: 

Each time Windows is opened, Program Manager is started. Program Manager is used to 
organize programs and applications into groups. Each icon in the Program Manager window 
represents a group. 

When a group is opened, the applications contained in that group are displayed in a window. 
Groups are opened by double clicking the group icon. 



Group windows contain icons. Each icon represents an application. An application is started 
the same way as opening a group -- by double clicking its icon. 

Maxtnizing a Window: 

An application may be made to use the full computer screen as the workspace by clicking the
maximize button, the up arrow in the upper right hand corner of the window If any other
applications are running, they will be behind the window The restore button replaces the
maximize button after the window is maximized. It returns the window to the previous size. 

Minimizinga Window. 

An application may be reduced into an icon by clicking the minimize button, the down arrow 
left of the maximize button. When a window is minimized, the application within it is still
running. The application can be restored by double clicking its icon at the bottom of the 
screen. 

Moving andSizing a Window: 

A window can be moved to another part of the screen by placing the pointer on the window's 
title bar and dragging the window to its new location. 

The size of any window can be changed by moving the pointer to the border of the window 
and dragging the border until the window is the size desired. The pointer will change to a
double arrow indicating the direction in which the window can be sized. 

Any window covered by another window when moving or sizing are still opened, they are just
hidden behind the window. Several windows can be sized so that the contents of more than 
one window can be visible at one time 

Menus.: 

Most windows have a menu bar across the top of the window. The menu bar contains the 
names of menus. When a menu is opened, a list of commands is displayed. To cancel a menu
without choosing a command, click outside the menu or press the ESC key. Commands are
grouped by task. For example the File menu lists the commands necessary to work with files. 
A menu can be opened by clicking the menu name. 

A command can be chosen by clicking the command name. When a command that is not
followed by an ellipses (...) is chosca, the command is immediately carried out. When a
command that is followed by an ellipses is chosen, more information needs to be provided
before the command can be carried out. A dialog box appears and prompts the user for the 
necessary information. Sometimes commands are dimmed. This means that they are 
temporarily unavailable and cannot be used. 
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Activating Windows: 

When working with Windows, it is common to 	 have more thAn one application runrung.Applications may be running in windows or minimized as icons at the bottom of the computer 
screen. The window in which work is being done is called the active window All other
windows are inactive. A window is made active by clicking anywhere in the window An
application can be closed by double clicking the control menu box in the upper left comer. 

Switching Between Applications: 

There are a number of ways to switch to another application. Any of the following ways will 
achieve this: 

" Click anywhere in the application's inactive window;
" Press ALT+ESC until the desired window is active;
* 	 Press and hold down ALT while pressing TAB repeatedly to cycle through running

applications. When TAB is released, the application comes to the foreground.
" 	 Press CTRL+ESC or double click the desktop to open the Tzak list. Select the 

application, and then choose the Switch To button or select the application and then 
press Enter. 

" Choose Switch To from the Control menu (the small white box in the upper left hand 
comer of the window) of any running application. 

• 	 Choose the application's icon. 

Note: Definitions of selected terms include the following: 

Icon: a small picture which represents an application, accessory, or document in a 
Windows group. 

Title Bar: the bar on the top of all Windos where the title of the group is written. 

DialogBox: a box that appears on screen when more information is required to perform a 
given command. 
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An Abridged Guide to Using Microsoft Project for Windows
 



AN ABRIDGED GUIDE TO USING MICROSOFT PROJECT FOR WINDOWS 
(PREPARED FOR MALAWI RAaIWAYS) 

Introduction 

This abridged guide is meant to help the Malawi Railways get started using Microsoft 
Project (MS Project). It is divided into three sections: (i) the Overview section gives an 
overall picture of how to use MS Project, (ii) Creating a Project, the second section, provides
step-by-step instructions for entering new projects into MS Project, and (iii) Managing a
Project, the final section gives specific procedures for updating and keeping track of a project.
For a more detailed overview, it will be necessary to refer to the user's guide for MS Project. 

Definition Phase: Before working wiih MS Project, several steps must be performed to ensure 
a successful project. The first step in successfully managing any project, whether the project is 
large or small, is to clearly and accurately define the objective. This is an important step that 
must be undertaken to determine the appropri.'P tasks to be implemented. In defining the
objective, it is essential to keep in mind the underlying rationale, the resources available, and 
the timing and budget constraints. 

Planning Phase: Once the objective has been defined, the next step is to specify the tasks 
necessary to fulfill the given objective. It is best to start with the largest and most essential 
activities and then to break them down into smaller, easily manageable tasks. Then, durations 
must be approximated for each of the tasks, and timing relationships must be specified among
the tasks (for example, whether one task may start only after a second task is completed, or 
whether two tasks must start simultaneously). Finally, resources (such as individuals, groups
of people, computers, or equipment) must be assigned to each of the tasks. Some tasks may
have only one resource assigned to it, while others may have several resources assigned to 
them. 



An Overview of Microsoft Project 

Views 

Following this preliminary deflaition and planning phase, it is possible to start using MS 
Project as an aid in managing the project. In MS Project. project information can be viewed in
different ways. There are three different kinds of views: Forrr.s, Sheets, and Charts. 

" Forms are used to enter detailed information. With a form, details about a single task or 
resource can be seen. MS Project includes che Task Form and the Resource Form. 

The Task Form is used to enter information for one task at a time. The task form also 
shows resource information, so that resources can be assigned at the same time that 
tasks are entered. Fields at the bottom of the form can be changed to display other 
kinds of information, or to make a place for notes with the Format menu. 

The Resource Form is used to enter or view details for a single resource. The 
Resource Form also shows details about the resource's tasks. As with the Task Form,
fields at the bottom of the form can be changed to display other kinds of information, 
or to make a place for notes with the Format menu. 

* 	 Sheets are used to enter and display information. MS Project sheets are like
 
spreadsheets, consisting of rows and columns. 
 MS Projects includes the Task Sheet and
 
the Resource Sheet.
 

The Task Sheet is a table of task information used to create a project, outline tasks,
and create text reports. The columns of information in the Task Sheet can be 
changed by applying a different table from the Table menu or by using the Define 
Tables command. 

The Resource Sheet is a view for entering and reviewing resource information and 
creating text reports. As with the Task Sheet. the columns of information in the 
Resourct Sheet can be changed by applying different tables. 

* 	 Charts provide another way of looking at project data. A graphic display of information
 
is helpful for:
 

" Looking at the broad scope of the project;
 
" Seeing relationships among tasks;
 
" Presenting the project on a timeline; .and
 
" Highlighting scheduling and resource problems.
 

MS Project chart views include: the Gantt Chart, the PERT Chart, the Task PERT 
Chart, the Resource Usage View, and the Resource Graph. 
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The Gantt Chart consists of a table of task information and a chart that graphically
displays the project schedule. The chart displays a bar next to each task showing the 
task's start and finish date and duration on a timescale 

The Palette command on the Format menu can be used to specify how the 
information should look on the chart. As with the sheet views, the columns in the 
Gantt Chart table can be changed by applying different tables. 

The PERT Chart is a graphic display of the relationships among tasks. Each task 
appears as a node, and the nodes are interconnected with lines that show task 
relationships. 

The Palette command on the Format menu can be used to specify the information that 
is displayed in the nodes. The appearance of the dependency lines and the types of 
tasks that appear in the PERT chart can be changed with the Layout command on the 
Format menu. The Zoom Out command on the Format menu can be used to see 
more nodes and less task detail for a wider overview of the project. 

The Task PERT Chart is a specialized version of the PERT Chart This view shows a 
single task and its immediate predecessors and successors. 

The Resource Usage View shows how the recourses are allocated and exactly where 
the resources are overallocated. When this view is first opened, the total work per
time unit is shown. However, commands on the Format menu can be used so that 
allocation, work, and cost information for each time period are shown instead. 

The Resource Graph uses a bar graph to display resource information over time. 
Information can be viewed for an individual resource, a group of resources, or both. 

The first view opened when MS Project is started is the Task Entry view. This is a 
combination of the Gantt Chart and the Task Form. The Task Form in the bottom view shows 
details about the task that is selected in the top view This combination view is a good way to 
begin entering tasks. 

UsingCombination Views: 

Any two single-pane views can be combined to create a combination view. In a combination 
view, the information in the bottom view relates only to the tasks or resources selected in the 
top view. In a combination view, the view that has a colored or black vertical bar at the left is 
called the active view. The other view is inactive. One can easily move between the two 
views to make one or the other active. To move to a view, click anywhere in the view. Only 
one view can be active at a time. 

To switch from a combination view to a single-pane view, hold down SHIFT while choosing a
view from the View menu. To go back to a combination view, use SHIFT while choosing 
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another view from the View menu. The view chosen will be displayed in the bottom pane In
 
a combination view, one can change how much of each view is displayed by moving the split
 
bar 

S'sefid Combination Views: 

The following are some views that are particularly effective in combination with each other 

" To review the tasks that immediately precede or follow another task, a combination view 
using the Gantt Chart and the Task PERT Chart is very effective. This is especially
useful if there is a task with more than one task preceding it. The Task PERT chart also 
notes the type of relationship between the tasks. 

" 	 Another useful combination view is the PERT chart and' the Resource Sheet. This view 
is useful for reviewing dependencies between tasks and resource assignments to tasks 
As 	each task is selected on the PERT chart, resources for that task are listed below on 
the Resource Sheet. 

" 	A good way to check how well project resources are being used is to display the
 
Resource Sheet in the top view and the Resource Graph in the bottom view. 
 As each 
resource is selected on the Resource Sheet, the Resource graph shows allocation, work, 
or cost overtime. 

Establishing Task Relationships 

When tasks are first entered in a project, they all start on the same date and appear as 
left-aligned bars on the Gantt Chart. The Link Task command on the Edit menu assigns a 
finish-to-start relationship to tasks. In a finish-to-start relationship, a task cannot start until the 
preceding task has finished. With a mouse, it is also possible to link the selected tasks with a 
finish-to-start relationship by clicking the link tasks button on the tool bar (See E)hibit 1 at the 
end of this Guide). With relationships assigned, MS Project can schedule the entire project
from start to finish. Since task relationships affect the start and finish dates of dependent tasks,
it is a good idea to check their accuracy. To see the selected task's predecessors and 
successors, reformat the fields at the bottom of the Task Form. 

Using Outlining and Subprojects 

When a project is first set-up, one way to structure it is at a single level of detail. But for more 
complicated projects, it can be helpful to organize tasks in successive levels of detail. With 
successive levels, one can choose the level of the project to work with. Sometimes the broad 
picture might be more interesting. Other times it is necessary to concentrate on the details. A 
project can be organized by using outlining and subprojects. 
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Outlining helps show how tasks fit in broader groups and allow the project detail to be
shown when necessary For example, once a task list is outlined, it is possible to
collapse it to see an overview of the project or expand it Lo show every task 
Subproiects keep detailed tasks separate from the master project. The master project is 
used when only a broad picture is desired, and separate subprojects can be viewed when 
the details of the subprojects are desired. One can create subprojects as separate
projects, then connect them as tasks to the master project using the Subproject box inthe Task Edit Form dialog box. Because subprojects are separate proiects. they can help
conserve memory by reducing the size of the main project, and subprojects make it
convenient for different managers to "own" different parts of the project. 

Customizing and Presenting Information 

By choosing different views from the View menu, one can determine how the project
information is displayed. It is possible to further specify exactly what information isdisplayed
by applying a table or a filter to any view. 

A table specifies which columns of information appear in aview. It can be applied to the GanttChart, Task Sheet, Resource Sheet, or Resource Usage view. A filter specifies what related
tasks and resources to display or highlight while temporarily hiding or not highlighting theothers. This helps to narrow the focus. It is possible to either select one of the tables or filters
included with MS Project or to create a new one, name it, and add it to the menu. 

One can report project information by printing views and reports, some of which may becustomized to show the desired information. Before printing, it is possible to use the Print
Preview command ori the File menu to see each page exactly as it will be printed. The Page
Setup dialog box can be used to change the margins, headers or footers, or orientation. Alsothe legend can be adjusted in the view or report. To print the active view, choose the Print
command from the File menu. The views that can be printed are the Garct chart, PERT chart. 
Task Sheet, Resource Sheet, Resource Graph, and Resource Usage view. 

In addition to printing views, one can printreports. A printed report can show more detailed
information than a printed view. A report uses a table and a filter to present detailed
information on individual tasks and resources. To print a report, use the Print Report
command on the File menu. MS Project comes with several types of reports to print which can 
be modified as necessary. 
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Creating a Project 

EnteringTasks 

The first step in using MS Project is to enter the basic project information To enter thisinformation, use the Project Info command from the Options menu. A Project Information' 
dialogue box will appear. The name of the project, the company, the manager, the planned
start and finish dates and notes about the project, such as the objective, can all be entered 

The most common way to enter task information is using the Task Entry view In the Name
field of the Gantt Chart table, type the name of the first task in the project. Click the enter box 
or press Enter. As each task it entered, it is a good idea to enter the task duration In theDuration field, type the estimated duration of the task, followed by a duration abbreviation
(i.e., h for hours, d for days, or w for weeks). Click the enter box or press Enter. The amount
of time a task will take to finish is initially based on an 8-hour day. Elapscdduration is based 
on a 24-hour day and it is useful when a duration reflects the number of continuous hours
needed for a task. To change a duration to elapsed time add an before thee duration 
abbreviation (i.e.. 3ed refers to 3 elapsed days). 

Milestones: 

Milestones are important points in the project. Usually a milestone represents a transition
point--the beginning or completion of a group of tasks. Since milestone usually marksa a
transition, it often has a duration of zero. One way to designate a milestone is to give a task a 
zero duration. A second way of designating a task as a milestone is to check the Milestone 
check box in the Task Edit Form dialog box. 

Insertingand Deleting Tasks: 

As a project changes over time, it may be necessary to add new tasks to the list and remove
tasks that are no longer required. To insert a task between existing tasks, select the row abovewhich the new task should be inserted, and then use the Insert command on the Edit menu. In
the blank row, type the new information. Several tasks can be inserted by selecting several 
rows before choosing the command. To delete a task, select the task and then use the Delete
command on the Edit menu. As with inserting, several tasks can be deleted at byonce 
selecting them as a group before deleting. 

Moving andCopying Tasks: 

While working with a project, it may be necessary to move tasks from one place in the task list 
to another. To move a task, first use the Cut command on the Edit menu to delete the task.
At this point, it is stored on the clipboard. Then use the Paste command on the Edit menu to 
put the task where it belongs. 
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Some tasks may be used more than once. In this case. use the Copy command on the Edit 
menu to copy tasks instead of retyping the task each time. Once the Copy command has been 
selected. the tasks will be copied to the clipboard, so that they can be inserted elsewhere. Then 
the tasks can be pasted where desired using the Paste command on the Edit menu. Copied
tasks may be inserted in as many places as desired. When tasks are copied to the clipboard.
they stay there until something else iscopied or cut. 

Outlining Tasks 

As discussed above, outlining gives a project a hierarchical structure in which it can be seen 
how subordinatetasks fit within broader groupings or ummary tasks. As tasks are broken 
down, MS Project's outlining feature organizes them into levels of detail. Tasks that are 
components of other tasks are demoted. When tasks gets demoted, a summary task and 
subordinate tasks are automatically created. A summary task is like a heading, it summarizes 
the costs, work, and scheduling information of the tasks below it. 

A summary task is o-ly completed when all of its subordinate tasks are completed. The 
duration of a summary task is the amount of working time between the earliest scheduled start 
date and the latest scheduled finish date of all its subordinate tasks. Tasks can be outlined on 
either the Gantt Chart or the Task Sheet. When either of these views are chosen, the following 
outline buttons appear at the end of the entry bar: 

__--
 Promote Button 7 Expand Button , Expand All Button 

Demote Button D "Collapse Button 

To make tasks subordinate to a summary task, demote the tasks by selecting the tasks and 
clicking the demote button. This shifts the tasks to the right. The demote button can be used 
to create an outline of up to ten levels. Each summary task summarizes all the tasks that are 
subordinate to it, including other summary tasks. To raise a subordinate task to the next 
higher level, promote the task by clicking the promote button. 

When a summary task is moved or copied, all of its subordinate tasks are copied or moved 
with it. To cut only a summary task and not its subordinate tasks, move or promote the 
subordinate tasks before cutting the summary task. 

HidingandDisplayingLevels of Detail. 

An outline structure makes it easy to create summary presentations and reports. One can show 
or hide any level of detail by expanding and collapsing summary tasks. By selecting asummary
task and clicking the Collapse Button, all levels of subordinate tasks below it disappear. By
selecting a summary task and clicking the Expand Button, the next level of detail is displayed. 
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Bv selecting a summary task and clicking the Expand All Button, all levels of detail are 
displayed. 

Assigning Task Relationships 

As tasks are entered into the Gantt chart, MS Project schedules them all to start on the same 
date by default. However, it is more likely that the tasks will occur one after another rather
than start at the same time. Assigning task relationships turns a task list into a realistic model
of the project. A task that must start or finish before another task can begin is called apredecessor task. Any task that depends on another task's completion is called the successor 
of that task. There are several ways to establish relationships between tasks. The Link Tasks
command on the Edit menu links tasks with a Finish-to-Start (FS) relationship. A task will 
start as soon as its predecessor finishes. When tasks are linked, a change in one task will affect
the other tasks. For example, if it takes longer than the specified amount of time to complete a
task. the successor tasks will be postponed. The Link Task Button (See Exhibit 1) can also be 
used to carry out the command. Just select the tasks to link and click the button on the tool
bar. The Task Form view is especially useful for assigning relationships. To assign task
relationships, enter the type of relationship in the Predecessors field. 

So far, only the simplest task relationship, Finish-to-Start has been defined. But tasks are
typically more complex than that. It may be necessary to assign task relationships in which the 
starc of one task depends on the start of another, or the finish of one task depends on the finish 
of another. 

Use Start-to-Start (SS) for a task that can start as soon as 
its predecessor task starts. 

Use Finish-to-Finish (FF) for a task that can finish as soon as 
its predecessor task finishes. 

To change the task relationships, enter the new type of relationship in the Predecessors field of
the Task Form. Sometimes it is necessary to add time between related tasks, or overlap the
timing of related tasks. In a Finish-to-Start relationship, lag time is the amount of delay time
between two activities, while lead time is the overlapping time between two tasks. To add lag
time, in the Task Form type a positive number in the Lag field. To add lead time, type a 
negative number in the Lag field. 



Entering Resources 

Resources are the people and equipment needed to complete a project's tasks Al the 
resources in a project make up that project's pool.resource To make use of resources, they
must be assigned to tasks. To assign new resources to tasks using the Task Entr, View. select 
a task to which the resource will be assigned. On the Task Form, select the Resource Name 
field and type in the resource name. Choose the OK button. Since the resource is new, the 
system will bring up a dialog box asking whether that resource should 'e added to the resource 
pool. Type yes, and the system will bring up a Resource Edit Form to fill in the maximum 
units for the resource and details on rates. After filling in this information, choose the OK box. 
and in the Units field on the Task Form, enter the number of resource units that will be 
assigned to the selected task. Finally, choose OK 

MS Project will automatically calculate the hours of work the resource will spend on the task 
based on the resource units and task duration using the equation: Work = Resource Uits 
Duration. However, the amount of work can also be entered manually, and MS Project will 
recalculate the duration of the task using the equation above. This is known as resource 
driven scheduling. Then if either more resource units are added or the amount of work is 
decreased, the duration of the task will decrease. But for some tasks, it may be necessary to 
hold the task duration constant. In this case, select the Fixed check box on the Task Form, and 
the duration will always stay constant. This is known asfixed durationscheduling. 

For a resource that will be working on more than one task, it may be easier to enter the 
resources directly into the Resource Pool. To do this, enter the resource information and the 
tasks that the resource will be working on directly into either the Resource Form or the
Resource Sheet. To assign a resource already in the pool to an additional task, bring up the 
Task Entry view, and on the Task Form, select the Resource Name field. Either type the 
resource name or choose the entry bar arrow (see picture to the right) to see a list of all 
resources, and select one of the resources. This is especially useful for resources with long or 
difficult names. Then enter the number of resource units. 

Creating Calendars 

Calendars define the days and hours that resources are available to work. One calendar can be 
created for the entire project, or if certain groups have different schedules, separate calendars 
can be created for them. Also, it is possible to schedule variations in a particular resource's 
calendar for such events as holidays or equipment downtime. 

Before beginning to work on a project, it is necessary to determine the project's working hours 
and days. MS Project is set up with a standard calendar with: (i) a Monday through Friday
work week; (ii) an 8 to 5 workday with an hour off for lunch; and (iii) no holidays. This 
standard calendar can be used as is, it can be modified, or a new one can be created. 
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To modify the standard calendar, from the Options menu, choose Base Calendar In the Base 
Calendar box, choose standard. Then click the Edit button If the work week is different from
the standard calendar (i.e.. for a 4 or a 6 day work week), select the day titles for the days to
be changed, and select the Working or Nonworking option button. If the workday is different 
from the standard calendar, select the day titles of the working days. and LVpe the wr,.-,!n,
hours in the From and To boxes. To change holidays to nonworking days. select their d),' , on
the calendar select the Nonworking option button. Once a calendar is specified for a pmoject.
tasks and resources are scheduled according to that calendar. 

The calendar sets and shows project working days, nonworking days. and working hours. The
calendar displays one month at a time. To move from month to month through the calendar. 
use the scroll bars, or the PAGE UP and PAGE DOWN keys. 

The project cale:ndar set up is called the base calendar It can be used to create calendars for 
groups of resources who have different schedules from the standard. To do this, choose Base 
Calendar from the Options menu. In the Base Calendar box, select the calendar to be copied
and choose the Copy button. Give the calendar a name and set the workdays and the working
hours for the calendrr. Choose the OK and Close buttons to close the dialog boxes. Then, in
the resource sheet, select the resources to be assigned to the calendar. Choose the Form 
button on the toolbar (See Exhibit 1) or choose Form from the Edit menu. Then in the Base 
Calendar box., choose the calendar to be assigned to the resources, and choose OK. 

Even after creating and assigning different base calendars to different groups of resources, it is 
necessary to change individual resource's calendars to reflect holidays or periodic equipment
maintenance. In this case, it is easiest to first choose a resource view. Then select the 
resource whose working days or hours are to be changed. From the Options menu, choose
Resource Calendars. Change the working days or hours, and choose OK. Tasks without
 
assigned resources and tasks with fixed durations will continue to use the base calendar.
 

Analyzing the Plan 

Once the tasks and relationships have been entered, the resources have been assigned, and the
calendars have been set up, it is important to review the project's schedule. See how much 
leeway there is,and try out alternate scenarios. Identify tasks both on and off the critical path
(critical tasks are shown in bold on the Gantt and PERT charts) to spot potential areas where
work could be held up, and to develop alternative plans. Most projects include noncritical 
tasks. Since these tasks can be delayed without affecting the project finish date, they add some
flexibility to the scheduling process. For these tasks, it is a good idea to check the amount of
slack time available (using the Schedule table or the Delay Gantt chart) because if their
durations increases by more 'chan the total slack time, then they too become critical, and the 
project will be delayed. 
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Managing a Project 

Using Tables and Filters to Emphasize Information 

Project information can become overwhelming. But commands on the Filter menu can be used' 
to find the tasks or resources of interest, and commands on the Table menu can be used to 
display the desired information associated with those tasks or resources In a sheet view.
project information is displayed in columns and rows. Each column shows one type of 
information about the tasks or resources. Commands on the table menu control which
columns are displayed. Each row shows more than one type of information about the tasks or 
resources. Use commands on the Filter menu to display groups of tasks or resources that have 
at least one type of information in common. MS Project provides several tables for use with
the Task Sheet, Gantt Chart, Resource Usage, and Resource Sheet views. It is possible to use 
the supplied tables, modify them, or create new ones. 

Tracking Progress 

While managing a project, it is imperative to monitor the use of time, money, and resources. 
During the course of a project, even the most clearly defined plans can be disrupted. This can 
result in project delays, resource shortages, and cost overruns. To set the project plan, just
choose the Set Plan command from the Options menu before the project begins. MS Project 
saves a copy of this schedule as a base for future comparisons. In tracking a project, the 
current estimate of the project's schedule is compared to the original plan. As the project 
progresses, it is necessary to enter the actual data to keep the schedule up to date. 

The tracking table is a convenient place to enter actual data about tasks. Just select the task to

update and enter the data in the appropriate column. 
 A simple way to update the schedule is to 
use the % Complete column in the table. A task's percent complete is the assessment of how 
far along the task has progressed. It is expressed as a percentage of the task's total duration.
In the Gantt chart vicw, a black bar drawn across the Gantt bar indicates the portion of the 
task that is complete. 

In addition to entering the perce-t complete for each task, progress can be tracked by updating
the schedule with the following types of data: 

" 	 Actual Start - the date the task actually started; 
• 	 Actual Finish - the date the task was completed; and 
* 	 Actual Duration - how long the task has taken up to the present time; if the task is
 

complete, how long it took to finish the task.
 

As the actual data is entered, MS Project updates the other fields associated with the task. It is 
a good idea to use the Set Actual command on the Options menu to automatically update the 
rest of the schedule. 
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To 	update only tasks that were scheduled for completion on or before the update, select the 
Set Actual Start and Actual Finish Only option button. This option copies the scheduled start 
and finish dates to the actual start and finish dates. 

To update the percent complete for tasks with actual start dates occurring before the update.
select the Set % Complete to Update Date option button. This option calculates the percent
complete as of the update date using each task's stated duration. 

To update tasks that are behind schedule, use the Schedule Remainder to Start on Update Date 
option. This option moves the tasks so that the entire task or the remainder portion is 
rescheduled from the update date. 

In addition to tracking tables, there are several other tables useful for tracking data. 

* The Cost table compares planned, scheduled, and actual costs of tasks.
 
* 
 The Variance table compares actual start, finish, duration, cost, and work information. 
* The Work table compares planned, scheduled, and actual work. 
* 	 The Tracking table compares scheduled start and finish dates of tasks with planned 

dates. 

Managing resources 

MS Project has four views that help manage resources effectively. The Resource Sheet shows
the resource pool in a spreadsheet-like view. The Resource Form shows information about 
individual resources. The Resource Usage view shows how the resources are allocated over 
time. The Resource Graph displays the maximum allocation of one resource for a given time 
period. 

One way to view and edit information for the whole resource pool is to use the Resource
Sheet. If a resource isassigned to work beyond its capacity, the Resource Sheet shows that it 
isoverallocated by displayiag it in bold type. When a resource isoveralocated, a message also 
appears in the status bar stating that the resource should be leveled. 

To see how many resources are allocated over time, use the Resource Usage view. 
Overallocated resources are shown in bold, as in the Resource Sheet. In this view, commands 
from the Format menu, such as the Percent Allocation, are valuable in analyzing resource 
allocation information. 

To view or edit more detailed information about a single resource, use the Resource Form. 
The Resource Form shows how many units of the resource are available to the project and 
gives detailed cost information. Also a list of the resource's tasks is shown. 
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To see a resource's peak usage over time, use the Resource Graph. The Resource Graph
shows whether a resource is overallocated during each time peiod. The vertical dashed line 
shows the current date. The horizontal solid line shows how many units of the resource are 
available (the Max. Units). If the total amount allocated at any one time is more than Max 
Units, then the resource is overallocated. 

Viewing CapacityandOverallocationandResolving Conflicts: 

As a project is carried out, changes to resource information may need to be made. If resources 
are overallocated, tasks can be rescheduled or resources can be added. But the tradeoffs must 
be considered. Rescheduling tasks to meet resource availability may lengthen the project's
duration. Adding resources to maintain the schedule may increase the cost of the project. 

One of the key features of resource management is resolving resource conflicts and 
overallocations. The process of leveling resolves conflicts and overallocations by rescheduling
tasks when resources are available to work. To resolve a resource conflict or ,".': idlocation, 
use the Level Now command on the Options menu. From a resource view, there is a choice to 
level all resources or only the resources selected. From a task view, MS Project levels all 
resources. Leveling works by delaying a conflicting task so that it starts later, when enough of 
its resources are available. 

Use the Leveling command on the Options menu to determine when and how leveling will take 
place. If the Manual option button is selected, leveling will occur only when the Level Now 
command from the Options menu is chosen. If the automatic option button is selected, each 
resource will be leveled automatically as soon as it becomes overallocated. 

If the Delay Only Within Slack box is selected, tasks will not be delayed past their slack times. 
With the option selected, tasks are moved only if the adjustment will not delay the project
finish date. When an overallocated resource is leveled, MS Project analyzes the resource's 
tasks to choose which ones to delay. If Delay Only Within Slack is selected, leveling will not 
delay the end of the project. 

When the Automatically Remove Delay is selected, existing delays will be removed the next 
time the project is leveled. With this option selected, delays resulting from leveling will 
replace, rather than be added to, existing delays. Tasks are delayed according to the criteria 
selected in the Order box. Use the Order box to tell MS Project which tasks to delay first. On 
the "standard" setting, the task with the latest start date will be adjusted first. If two tasks 
have the same slack time and begin and end on the same day, the lower priority task will be 
moved. Tasks with a "Do Not Level" priority will not be leveled. Use the form button on the 
tool bar (See Exhibit 1) or the Form command on the Edit menu to set a task's priority. 
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Adjusting Schedules 

As a project progresses, various events affect the schedule. A delay in completing a task or an 
adjustment in resource allocation may influence the rest of the schedule. If a task on the 
critical path is delayed. the project end date will be delayed. To bring a project onback 
schedule, efforts should be focused on the critical path. Since the critical path is the longest
path through the project, the whole project will end sooner if the critical path is compressed
To shorten the critical path, the durations of the critical tasks can be reduced by: (i) adding 
resources to resource driven tasks; (ii) reassigning resources from tasks with slack time to 
tasks on the critical path; and (iii) assigning overtime to resources. The critical path can also 
be shortened by finding tasks that can start sooner and overlap their predecessors. To make 
linked tasks overlap, it is necessary to adjust task relationships, for example, to add lead time 
Adding lead time overlaps the start and finish of the tasks. Lead time indicates that the start of 
one task leads the finish of its predecessor. 

Printing iews and Reports 

MS Project provides a variety of formats for reporting progress or communicating the needs of 
a project. Any active view of a project, except Task PERT and Form views, can be printed as 
it appears on screen by choosing the Print command on the File menu. To print specific tasks 
or resources only, apply Filters. To control the information printed about each task or 
resource, apply tables. 

In addition to printing views, reports can be printed. Use reports to print information from the 
Task Form or the Resource Form. MS Project provides several report formats that can be 
printed as thcy are, or customized to meet specialized needs. 

* Task and Resource reports can be used to print detailed information. The types of 
information correspond to the fields at the bottom of the forms and any tables and filters 
applied. 

* 	 Periodic reports are used to print a list of tasks or resources taking place during a 
particular block of time (i.e., weekly). 

* 	 Monthly calendar report shows tasks displayed as bars across a calendar. 

" 	 Base calendar report lists the days and hours for each base calendar. 

* 	 Summary reports give a one page overview of the project. 

To print a report, choose the Print Report command from the File menu and select the type of 
report to print. 
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Setting L'p a Printer: 

Before printing for the first time. it is a good idea to check which printer is selected and how 
the printer options are set. To check the printer settings, choose Print Setup from the File 
menu. The Print Setup dialog box lists the printers currently installed for Microsoft Windows 
Use the Setup button to change the settings for the selected printer. Different types of printers
have different settings. If the needed printer is not on the list, install it for Windows by using
the Windows Control Panel. For more information on the Windows Control Panel, see the 
Microsoft Windows documentation. 

Setting Up the Page: 

Use the Page Setup command on the File menu to specify how each printout will look before 
printing. Margins, headers and footers, text styles, legend options, borders, and page
orientation can all be specified. To see how the page settings will actually look, click the Page
Preview button on the toolbar (See Exhibit I) or choose Print Preview from the File menu. 
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Exhibit 1: Tool Bar 

The tool bar contains a set of buttons that are shortcuts for commands. The appearance of a button and thecommand 	 the button is assigned to run can Tobe changed by usmiz the Button Defimlrion dialog box
display the Button Definution dialog box- hold down the CTRL key and click the button to be changed The 
following buttons are included %ithMS Project. 

Button 	 Action 

i Saves the project: same as choosing a from the File menu. 
Previews the pages in the active view as they will be printed: same as choosing Print 
Prev.ew from the File menu. 

Prints the active view using the current settings in the Print dialog oox. 

f dI 	 Removes the selected information and stores it on the Clipboard; same as cnoosing Cut 
from the Edit menu. 
Copies the selected information and stores it on the Clipboard: same as cnoosing Q=y 
from the Edit menu. 

Inserts the information from the Clipboard: same as choosing .. from 	the Edit menu. 

Links the selected tasks with finish-to-start relationships; same as choosing Link Tasks 
from the Edit menu. 
Unlinks the selected tasks: same as holding down SHiFT and choosing U[nlink Taks from 
the Edit menu. 

i 	 On views with a timescale, moves to the next point in time when an overallocation occurs: 
same as pressing ALTF5. 
Displays the Ia di Form or Resource Edit Form dialog box to change task or resource
details. If the active view is a task view, clicking the form button displays the Task EditForm; if a resource view is active, the Resource Edit Form is displayed. Same as 
pressing SHIFT+F2. 

Displays the Resource Assignment dialog box to add, change, or remove resourceassignments for the selected tasks: same as choosing Assignment from the Edit menu. 

Displays tracking form :Ialog box used for entering information. 
Marks the selected tasks as complete: the scheduled finish date is entered as the actualfinish date, the percent complete is changed to 100%, and all remaining fields, such as
Remaining Duration and Remaining Work, are set to zero. 

Remaining duration on the selected tasks is scheduled to continue on the current date: 
same as selecting Reschedule Remainder To Start On Update option button in the $.el. 
Atua dialog box. 

Displays the Project Status dialog box; same as chorsing Proiect Status from the Options 
menu. 

Calculates the open projects: same as choosing N from 	the Options menu. 
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Copies the active view as an ooject: same as selecting the Linked Or EmoeaeoaOject 

option outton in the Corv Pc,tre oialog box. 

_ Starts Microsoft Grapn. 
Checks the spelling of words in your project: same as choosing $D-li from the Options 
menu.
 

Shows a smaller time unit on the timescale.
 
A70 Shows a larger time unit on the timescale.
 

Runs a macro; you can assign anything you want to this button.
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Malawi Railways Restructuring Project 

Technical Working Paper: Environmental Assessment 
(Management for Environmental Protection and Worker Safety) 

1. Introduction 

In preparation for a joint donor mission to assess the prospects for restructuringMalawi Railways, a preliminary assessment of the Railways' environmental and safetyimpacts was conducted. The terms of reference for this assessment focused on the extent towhich the Railways complies with existing environmental laws and regulations and onwhether the Railways was taking adequate precautions to protect worker safety.Recommendations for ways of addressing inadequacies in either area were to be constructed.These recommendations would be considered for incorporation, as appropriate, in a donor­funded project supporting the restructuring. The full terms of reference are provided in

Appendix B.
 

On a national scale, most detrimental environmental impacts from rail transport
appear to be low priorities relative to other environmental problems in Malawi. 
 Even withinthe transport sector, railroad impacts have not been singled out for attention in therecommendations made to date in the preparation of the National Environmental Action Plan(DREA, #9). However, the lack of urgency at the national level should not be interpreted ascause for ignoring the environmental damages from rail activities altogether. Instead, it
should be noted that these damages are typically local in scope but not necessarily
inconsequential. As a result, site-specific measures to address these ,arnages can be justified
in many instances. 

Worker safety is an important consideration in evaluating the operations of theRailways because of their scale and the variety of high risk activities undertaken. The use ofheavy machinery is routine, not only on the rail lines but also in the rail yards andworkshops. The workshops, which are primarily oriented to overhauling and repairinglocomotives and rolling stock, are essentially a form of heavy industry. Their activities poserisks of accidents that can cause severe disabilities or fatality. Consequently, the worker
safety considerations are not minor. 

This technical working paper is organized as follows. The next section provides anoverview of the regulatory context for environmental protection and safety at MalawiRailways. Section 3 presents a broad assessment of the Railways' performance in protectingthe environment and worker safety. Section 4 outlines recommended steps to be taken byMalawi Railways and the Government of Malawi to address shortcomings identified in the 
assessment. 
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Finally, a note on the scc,)e of this assessment is important. Malawi Railways, as an
organization, is linked to a myriad of activities, including the provision of housing to its
emplovees, the operation of transport on Lake Malawi, and rail activities in Mozambique.
This assessment concentrated solely on explicit rail operations in Malawi. 

2. Regulatory Context 

2.1 Regulatory Context: Environment 

A complete program for the regulation of environmental impacts from rail operations
should oversee pollutant emissions to water, air, and land. Of these, only water pollution
from Malawi Railways' operation and maintenance is currently subject to any regulation that
is really binding but even this regulation may be only irregularly enforced. Each of the

major regulatory authorities and their linkage to rail activities 
are considered in turn below. 

Although the Railways operates as a national institution, its activities are primarily

regulated at the local level. This orientation is probably fitting given the localized 
nature of 
many of the environmental impacts emanating from rail activities. There are however
inconsistencies in the ability of the local authorities along the rail line to oversee the activities
of the Railways and to restrict any detrimental impacts. Even for the largest city, limited 
resources inhibit the full inspection of environmental impacts from industrial sources,
 
including the Railways.
 

For example, primary regulation of the effluent discharges from the Limbe workshop
comes from Blantyre City Health Department and the City Engineering Department. These

discharges are mainly composed of oil-contaminated wastes to the creek adjacent to the

facility. The division of responsibility between them is unclear. 
 The Engineering
Department is responsible for sewage systems in the city and for the analysis of effluent. It 
appears that the Health Department is also charged with testing the creek for contamination.
One or both of these required the Railways to install an oil separation facility about ten years
ago to reduce the discharge of oily waste into the adjacent creek. It was asserted by MalawiRailways that the Engineering Department checks the pollution levels regularly. Other 
sources indicate that this department has severe staff shortages and that the current staffing is
inadequate for enforcing city regulations (DREA, #18, pp. 23-24). 

Regulating air emissions also appears to be the domain of local government officials.
No specific statutes or standards confirm this but one railway official indicated that air
emissions from the workshop are the responsibility of local health officials. Curreitly,
however, there appears to be little or no regulation of air emissions from the Railways or
other major polluters. While air pollution may not be a high priority environmental issue at
the national level, this does not rule out serious local impacts. Visible emissions (smoke)
from transport in Malawi have been cited as a problem (DREA, #18). While smoke from
road vehicles has been the primary concern, smoke from locomotives could be an issue as
well. Such emissions certainly have an impact on the welfare of populations living close to 
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the rail yards. Apparently, no attention has been given to this impact by either local health 
officials or the Railways. 

Land disposal also seems to be the responsibility of local government. However. it is
unclear what local oversight, if any, exists for the disposal of large quantities of solid wastes.
Currently. for example, on-site disposal of these wastes in the "graveyard" at the Limbe rail
yard appears to be subject to no governmental regulations. Smaller quantities are collected
by the municipalities for disposal. No restrictions appear to be placed on the types of
 
materials that can 
be disposed through the municipal collection. 

In addition to a review of the specific regulations related to individual environmental
media (water, air, and land), the terms of reference for this technical analysis called for an 
assessment of environmental laws and regulations related to the procurement, storage, and
disposal of chemicals, oils, fuels, and lubricants. With the exception of the regulation of
water discharges and the regulation of storage for worker protection under the Factories Act.
there appear to be no specific regulations that are relevant. 

However, an institutional mechanism does exist at the national level for addressing

these activities. 
 The Malawi Bureau of Standards has an Environmental Protection and

Pollution Control Technical Committee that has responsibility for environmental standards.
 
This technical committee has published only one environmental standard, for water quality.

However, the Bureau has published other standards which may incorporate safety, health and
environmental considerations (DREA #15, p. 43). Standards appear to exist for the handling
and use of certain substances, and, sometimes, the associated waste disposal. It is not clear

whether any of these pertain to the types of substances that MR uses (fuel, solvents,

lubricants, other chemicals). Furthermore, the Bureau does not have the capacity to apply

the standards. This responsibility is left to the relevant ministries and departments, 
 which 
may also lack the resources and authority to enforce the standards fully. Consequently, even

if relevant standards did exist on paper, it is likely that they would not be effectively applied
 
to Railways activities.
 

2.2 Regulatory Context: Worker Safety 

The Factories ACL (Cap. 55:07) regulates at a general level a wide array of activities
by Malawi Railways in order to ensure worker safety. The Factories Inspectorate of the
Ministry of Labour is responsible for conducting inspections and enforcing compliance with
the terms of this Act. The Inspectoiate can impose fines for noncompliance and ultimately
has the authority to close any facility that remains out of compliance. 

Supplementing the terms of the Act itself is the Industrial Safety Code of Malawi.
This code was prepared by the Employers' Consultative Association of Malawi, of which
Malawi Railways is a member. Although the code has no regulatory aspect, it is intended to 
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"aid management and employees in the introduction, institution, and maintenance of practical
safety systems" (Employers' Consultative Association of Malawi, No Date. p. i). In addition 
to general checklist for using in reviewing internal safety practices, the code makes specific
recommendations for the supervision of fourteen different areas of safety concern. 

3. Environmental and Safety Performance 

3.1 Review of Environmental Impacts from Workshops at Limbe 

The primary workshops for Malawi Railways are in Limbe. These workshops include 
a diesel overhaul and repair facility, an automotive repair shop, a foundry, a coach shop,
fuel tanker cleaning area, a blacksmithing shop, a structure shop, a lathe shop, a wagon
shop, and an old bridge assembly shop, where minor welding and blacksmithing are 
conducted. 

The diesel overhaul and repair workshop is housed in one building in the Limbe yard.
In this location, diesel locomotives are dismantled for general overhaul, the most extensive
rehabilitation work that can be conducted on a locomotive. Much of the initial work has to
be conducted from within pits constructed underneath track leading into the facility. Directly
outside of this building is a steam cleaning area for the engines being overhauled and a load 
box and refueling area where engines are tested. In the pits and around the building are
 
drainage and collection systems intended to capture 
waste oil spillage and rainwater. 

Until the early 1980s, oil-contaminated water drained from the pits inside the
workshop to the creek adjacent to the facility. Because populations living downstream from
the facility used the water for drinking, washing and bathing, the City of Blantyre required
the installation of an oil separation unit to reduce the amount of waste oil entering the creek.
This unit was installed at some time in the early 1980s and is still in place. The oil collected
 
in this system is sold or distributed for several different uses, 
 according to several individuals 
at the railway. The biggest environmental concern stems from individuals' using this waste
oil in household lamps. This piactice can cause air emissions of heavy metals and other
pollutants in close quarters, leading to potentially toxic exposures for househn!, residents. 

During dryer periods this system may serve as an adequate buffer for keeping large
quantities of used oil out of the creek. Problems may arise, however, during heavy rains
which overwhelm the capacity of the separator as stormwater enters the system. This can 
result in oil-contaminated water entering the creek. In response to an insurance questionnaire
in 1989, the Railways indicated that the "[d]efective oil separator spills waste oil into rivers 
at times." What was meant by "defective" is unknown but this statement suggests that other
problems which could not be uncovered during this provisional inspection may also limit the 
effectiveness of the oil-separation system. 
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Other parts of the drainage system are meant to collect ordinary rainwater and have no oil separation unit since they were not designed to handle oil-contaminated wastes. In
practice, however, waste oil can still enter the creek through this route, from at least two
 
sources. First, rainwater runoff can 
carry waste oil from spills in the shop into the gutters
around the diesel overhaul building. Oil contamination was evident in these gutters. Second.
spills of oil or gasoline in the auto repair pits can enter the same drainage system. 

The likelihood of oil contamination reaching the creek raises human health and
welfare concerns. Observations made during a rail tour of the downstream 
area confirm thathouseholds still use the downstream creek for washing and bathing and possibly for direct
consumption. Within close proximity (within 2 to 3 kms.), there appear to be a few hundred 
households that have access to the creek.' 

Several possible sources of groundwater contamination exist at the workshops. One
 
source is the refueling depot. 
 In general, refueling activities in rail operations can be asignificant source of fuel losses. Without fuel recovery systems, repeated spills can be amajor source of ground contamination. No specific estimates of fuel losses could be obtained
for Malawi Railways but visual evidence of chronic contamination at the Limbe refueling
station suggests that the accumulated amount of fuel spilled has been substantial. In theabsence of a fuel recovery system, these spills have soaked into the ground. Groundwater 
contamination is likely *o have occurred as a result. Contamination of the adjacent creek 
may also be linked to any groundwater contamination. 

Another possible source is the steam cleaning of fuel tanker cars, which is necessary
each time the type of fuel carried is changed. These tankers are steam-cleaned for 24 hours 
a day. Fuel-contaminated steam and water flow out of the tankers directly onto the ground
without any intervention. This practice has been used for years in the same location at the 
Limbe workshops. 

A third possible source of groundwater contamination, as well as surface water
contamination, is the steam cleaning of diesel engines and parts. This cleaning is conducted 
on a dirt surface outside of the diesel overhaul workshop. Water that is contaminated with
waste oil and sludge is allowed to seep into the ground. Some water may run off into the
drainage collection system surrounding the building and be emptied into the adjacent creek. 

At distances greater than 10 kms. from the yard, the population around the creek is sparser and maize 
cultivation dominates the terrain. 
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3.2 Other Direct Environmental Impacts 

3.2.1 Right-of-Way Maintenance' 

Currently, vegetation on the railroad right-of-way is being maintained manually. The
practice of spraying herbicides was ceased five years ago because it was considered toocostly. At that time, two t)es were used. 3 These were sprayed usually just before butpreferably just after the fir, ain of the rainy season. No government regulations existed to
control the uses of these he, icides on the right-of-way. Instead, only Malawi Railways
decided what constituted saf., and unsafe applications. 

The spraying was done from a moving train. Potentially, this means of spraying
could expose individuals, animals, and water resources along the right-of-way. The
Railways' procedure for avoiding contamination of surface water required shutting off the
 
sprayer as the train was about to cross any stream. 
 This approach might work reasonablywell in avoiding direct exposure but given the likelihood of subsequent run-off it does not
avoid surface water contamination. It is unknown what steps were taken to avoid exposing
individuals and animals. 

In the future, if rail operations grow and, as a result, herbicides become economically
feasible once again, it is unclear how the Railways will respond. There are diverse opinionsin the current management. Some say that herbicides would be used. Others say that thepractice poses too many environmental concerns. Without a formal statement of company

application standards and without external regulution from the government, there is little

effective guarantee 
now that, if herbicides were used, they would be used appropriately. 

3.2.2 Locomotive Ar Emissions 

Little is known about the Railways' performance in controlling these emissions. Inthe absence of any effective regulations, it is likely that little attention has been given to thisenvironmental impact. The seriousness of this omission is unknown. Judging from the U.S.experience with addressing air emissions from locomotives, smoke emissions have been thefirst target of regulation and primarily on a local level. Opacity limits range from 20 to 60percent in different localities around the U.S. (United States Environmental Protection
Agency, 1991). Regulatory control of other pollutants (hydrocarbons, carbon monoxide, and
oxides of nitrogen) has been limited and only recently came under closer scrutiny.
Consequently, smoke emissions from Malawi Railways locomotives appear to be the more 
pressing problem that needs attention. 

Malawi Railways refers to right-of-way as the "permanent way." 
The names of these two herbicides were given as Hyva-X and Die-Rite. No further information on 

them was made available. 
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3.2.3 Discharge of Human Wastes from Passenger Operations 

Human wastes from passenger operations are currently discharged onto the rail tracks.
Health risks could arise from direct contact with these discharges since the tracks areregularly crossed by local populations. The discharges may also be a small source of water
pollution but its contribution is likely to be small. 

Clearly these discharges are undesirable from a public health perspective but without
better information on the magnitude of the problem and on the feasibility of different

solutions it is difficult to gauge how serious this problem is. 
 Furthermore the marginal
improvements from reducing this contamination might be small in some locations along the
line. Other sources of contamination, primarily poor sanitation facilities for the general

population, have led to substantial bacteriological contamination of surface waters."
 

3.2.4 Hazardous Materials Transport 

Hazardous materials transport was not targeted in the terms of reference for this
technical paper. 
 By itself, a review of Malawian regulations and the Railways procedures
would constitute a significant task. 
 Still, it is important to note the potential for extensive
environmental damages from improper handling hazardous goods. Currently, the mostsignificant hazardous material being transported by the Railways are fuels. Safety
precautions are being taken in the loading and off-loading of these fuels and standards for the
marshalling of trains exist but the adequacy of these 
measures is unknown. Scrutinizing

these activities more closely could be important, especially if individuals live nearby or if
sensitive environments are involved (such as the off-loading of fuel from transport on Lake
 
Malawi).
 

3.3 Indirect Environmental Impacts 

Most of the detrimental environmental impacts associated with rail operations inMalawi are local in scope, as acknowledged above. Even when considered in the aggregate,these local impacts probably do not rank among the high priority environmental problems ofMalawi. There is however an indirect, and possibly positive, influence that increased
reliance on railroads could have on high priority environmental problems. 

The World Bank has, for example, cited soil erosion and deforestation as two keyenvironmental problems (World Bank, 1991). Potential impacts on these problems from 

In the wet season, 87% of piped water, which is the source of water for 50% of the population in ruralareas, has fecal coliform levels in excess of 50 per 100 ml, the Malawi government guideline (DREA, #13). 
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railroad activities operate primarily through the Railways' becoming a less expensive modeof freight transport. If the restructuring of the Railways accomplishes this, it should translate
into lower costs of imported cargo, including fuel and fertilizers. 

Assuming for example that the domestic prices of imported fuel decline as the resultof lower shipping costs, it is possible that reliance upon fuelwood in peri-urban areas couldbe reduced, thereby reducing one of the sources of deforestation (which is itself acontributing factor to soil 'erosion). Nonetheless, this conclusion should not be carried toofar. Although it may hold in a partial equilibrium framework, there is the strong possibilitythat other pressures on forests would actually increase when fuel prices fall. Consequentlyan environmentally beneficial outcome is possible under this scenario but not guaranteed. 

A further pressure on forest resources in Malawi comes from increasing theextensiveness of cultivation. In meetings with USAID, it was suggested that lowering theprice of fertilizer though lower transport costs could induce small farmers to use more
intensive cultivation practices to expand production rather than encroach upon forested
 
areas.' This outcome would of course 
be environmentally beneficial but more intensive
fertilizer use could lead to a negative effect too, such as an increased likelihood of
groundwater contamination. So, the prospects for an environmental benefit from cheaper railthrough this particular linkage are ambiguous. 

Less ambiguous is the impact that cheaper ral transport could have on the amount ofroad hauling of freight and its detrimental environmental impacts. La the transport sector,road transport, which competes with railroads in the movement of freight, has been singledout for its environmental effects. Assuming that a restructuring of the Railways leads tosubstantially more freight customers to choose rail over road transport, the intensity of road
hauling on Malawi's highways could be reduced. 
 While this reduction may not reduce the
environmental impacts that come from road construction, 
 one of the commonly citedproblems stemming from road transport, it could reduce the volume of freight traffic onMalawian highways, or at least the rate of increase in this traffic. 

The benefits from this impact depend on the differential effects that rail and roadtransport have on the environment and public health. Generally, rail transport produces lessair pollution than road transport. However, possibly more critical is the differential impact
on transport fatalities. In 1991, 1,117 people were killed in road accidents in Malawi
(National Road Safety Council of Malawi, 1992).6 Goods vehicles were involved in 48% of 

I It can also be argued that lower priced fertilizer would lead to the cultivation of a larger area of land,
thus exacerbating deforestation. 

6 Malawi's road fatality rate appears to be very high relative to the experience of other parts of Southern
Africa, judging from data of the mid-1980s. Malawi had 200 fatalities per 10,000 vehicles, more than 180%higher than Tanzania (71), more than 50% higher than Lesotho (119) or Zambia (113), and more than fivetimes greater than Swaziland (36) (Institute for Transport Economics, 1988). 
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these fatal traffic accidents. Available figures do not allow a suitable comparison with the

experience of railways, such as in terms of fatalities per ton-kilometer of freight. Still.

approximations can illustrate the point. Allowing for at least a tenfold difference in level of
activity, based on the relative shares of road and rail in international freight traffic
(approximately 90% for road and 10% for rail), road transport would have entailed 30
fatalities when rail transport typically has fewer than 10 per year. The real differential
between these two modes could be greater, if the experience of more industrialized 
economies provides a relevant indication. In the Netherlands, one study estimated that road 
transport of goods imposes accident costs that are 15 times higher than rail transport,
normalized to tons per kilometer (Economic Research Centre, 1994). An analogous study in
Belgium estimated accident costs from road transport that are nearly 10 times higher than
those of rail transport of freight, when normalized to kilometers traveled (Dubus, 1989).' 

3.4 Review of Safety in Workshops at Limbe 

An on-site review of these shops revealed significant safety problems in parts of the
facility. It appears that the Railways has operated the shops with minimal investment in
protective infrastructure and equipment. Compounding the problem is the fact that the
existing infrastructure has been allowed to deteriorate. Although registered in the past under

the Factories Act as having approximately 700 workers, the current configuration appears to

be no more than one third that amount. Exact figures were not available. 

The diesel workshop currently suffers from several problems that compromise safetyand the ability to work for the approximately 40 people who work in the building! The

roof of the building has extensive leaks that allow the floors and pits to flood during periods

of rain. Electrical work bei'ches are in the middle of the area 
that floods the most. As a

result, work must be conducted with the risk of electrical shock or be suspended until the
water can be cleared. Although a drainage system 
was built into the pits, they have been
clogged for some time. During the rainy season, the pits are flooded, leaving difficultworking conditions even after the pits are cleaned out manually. Even during the dry season,
other factors, such as congestion and oily floors in the work area, make safe operation 
difficult. 

7 The ratio of road accident costs to rail accident costs is far higher (480) when costs are normalized to
tons per kilometer. This high figure should be viewed with caution since the study compared all utility vehicles on the road with rail transport of freight and was unable to focus solely on comparable modes of transport
(lorries versus rail freight). 

I All of the problems cited in this review are at least generally and sometimes specifically included ineither the Factories Act 55:07, the Industrial Code of Malawi, or both, as safety issues to be avoided in 
Malawian industrial operations. 
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The overhaul work entails substantial lifting of heavy locomotive components(including the engine housing, the engine itself, wheel bogies, among other things) byoverhead crane assisted by a work crew on the ground. Running repairs are also conductedin this same building but do not involve the same heavy lifting. Instead, the repair work isconducted mostly from work pits underneath the track. 

The lifting configurations used in the workshop have some immediately apparentshortcomings that raise the risk of accident substantially. Ramshorn hooks suspended fromthe crane have no safety catches to prevent a load from slipping off. The steel slingswrapped around the load itself are aged and need to be replaced. The implications of theresulting higher risks of a lifting accident are even more serious because of the absence ofcertain types of protective equipment. For example, no hard-hats were available to preventhead injuries from falling objects, which is a critical gap for a shop where the lifting ofheavy loads by crane and working under heavy machinery are routinely involved. 

Other conditions outside of the diesel workshop also pose safety risks. Next to thebuilding is the "load box" where locomotive engines are tested. Directly adjacent to this unitis the fuel stand where locomotives are refueled. A USAID consultant engineer singled outthis configuration as a particularly dangerous one (Harper, 1994). Although it is unknownwhat the Railways experience has been, a 1989 insurance questionnaire indicates that MR
recognized that "sometimes locomotive engine crank case explodes" indicating justified
 
reason to be concerned. 

In several other workshops at Limbe, the most pressing safety concern relates to
protective equipment. Stoking the cupola-style furnace in the foundry requires close
proximity to very high temperatures in confined quarters at the mouth of the furnace. 
 Noprotective barriers are available to the workers. The furnace operates only once a week nowso it was not possible to determine how adequate the protective clothing of the workers is.Given the chronic shortfall of all types of protective gear at the Railways, it is likely that
insufficient gear are provided for this work too. 

In the coach shop, where woodworking equipment is used, there was signagereminding workers not to smoke and to "Use the Guards" for eye protection at the table sawsbut there appear to be an insufficient number of eye guards for the number of workers in theshop. In the blacksmith shop, workers also had insufficient protective clothing. Inadequateventing of smoke could be a problem. One blacksmithing location had no chimney, allowing
smoke to accumulate within the building. 

In the structure shop, where major body work is done, including painting andwelding, no fire extinguishers were available. Protective eye gear and gloves were beingused by welders but some shortcuts were being applied in the absence of other properequipment. Used 55-gallon oil drums have been used to hold up heavy equipment. Theirdamaged condition seemed to indicate that they have failed on numerous occasions to provideadequate support and have collapsed. In the wagon shop, certain types of important 
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protective gear were absent. No protective eye gear was worn by the lathe operator, rivetersworking with heavy metal plating wore no hard-hats, and welders and other workers worestreet shoes in circumstances where steel-toed boots would have been more protective. 

3.5 Inspections under the Factories Act 

Malawi Railways' past experience with inspections under the F-'ctories Act providedinsights into longstanding safety problems that are still present in Railway operations. After an inspection is conducted and if the Railways is cited for problems, an official notice is sent
from the Factories Inspectorate in the Ministry of Labour. The Railways was very open,

allowing the examination of such notices and the internal and external correspondence it
generated. Correspondence over the past ten years was reviewed. This review led to the
 
following findings.
 

Inspections at least appear to generate internal discussion of cited problems and invarying degrees of completeness over the years, initiate some steps to address these
problems. Given the constructive role that these inspections play and the current,
deteriorated conditions in parts of the workshops, it is important that they take placeregularly. Therefore, it is disturbing to note that it has been some time since an inspection
has taken place, or least one that uncovered problems. The last general inspection to
 
uncover problems at the Limbe workshop took place in 1989.
 

From the correspondence files, it appears that the last steam boiler inspection took
place in 1991. A follow-up inspection was supposed to have taken place in 1993 but no

record indicates that it did. The boiler in question has been in service since 1958. 
 The

apparent lack of inspections means that opportunities have been missed. 
 Boiler problems
appear to arise with regularity. In the past, though, MR has shown a willingness to addressat least some of the problems identified during inspections. For example, an earlier
inspection of this same boiler uncovered operation problems that internal records indicate were addressed. There was an inspection of explosives magazines conducted in 1993 as 
directed under the Explosives Act. 

According to the correspondence files, some imported air receivers were inspected in
1990 and were supposed to be re-examined in 1992. 
 There is no record that this inspection
took place. Two locally-made air receivers were targeted for a hydraulic pressure test by theFactories Inspectorate in 1990 as well because earlier records showed that there were leakingportions requiring rerirs. No paperwork indicates that this inspection ever took place. 

Drainage of floors and pits has been a persistent problem in Lilongwe as well as
Limbe. Calls by the Inspectorate for redesigning the drainage system to avoid the
accumulation of rain water in te workshop,, especially in the locomotive inspection pit, dateback to 1988 at least. As noted abovi, the problem is even more pronounced today in Limbe 
because of roof leaks. 
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A related problem is the condition of the floors in the diesel workshop. Oily depositsare universal. To a degree, the spillage of oil is unavoidable but some form of regular

cleanup is necessary 
 to ensure safe and productive operations. This is difficult in an
environment where other contamination problems, especially those stemming from poor

drainage in the pits, are left unresolved. 

Protective clothing has also been a persistent problem, since at least 1984.
Inspectorate has called for the following steps, 
The
 

some on more than one occasion. Worn outoveralls have needed replacement. Employees handling batteries should be issued acid-proofoveralls and gloves. All workshop employees should be issued steel-toed safety boots. Onthis point, MR has consistently resisted issuing all workshop staff with steel-toed safety boots 
as called for in several inspections. 

The need to recharge and service fire extinguishers has been cited frequently, since1987 at least. Given the frequency of citations for inadequate fire protection equipment inthe past, the lack of general inspections in the past five years could mean that there areproblems today too. Even the most recent inspection, conducted pursuant to the ExplosivesAct, indicated that there were inadequacies in the fire protection equipment provided at theexplosives magazines. Some problems could be resolved simply (by covering pails of sand)and others require the expenditure of funds (equipping the magazines with fire extinguishers,
which Malawi Railways asserted would be done in 1992 but never was). 

Improper storage of materials (parts, tools, etc.) has been cited on occasion. Thisproblem appears to arise regularly. From the internal correspondence, it appears thatMalawi Railways usually musters some form of remedial response to the problem. However,the fact that it continually arises indicates that these remedial measures are short-lived. TheRailway's experience with first aid boxes is similar. Once cited for having improperly

stocked first aid boxes, it appears that steps are taken to restock them. 
 These steps aretypically not sufficient. What appears to be lacking is a systematic effort by the Railways touncover these problems on its own, such as, in this case, by instituting measures to assure
that the first aid boxes arp appropriately stocked. 

In sum, compliance with some of the Factories Inspector's recommendations has been a problem. Furthermore certain inadequacies have been chronic. It is worth noting thoughthat Malawi Railways has actually responded to at least some of the problems as they areidentified. In this process, however, the Railways appears to have taken a very reactivestance, waiting to respond to problems as they are pointed out by the Factories Inspectorate.It should also be noted that the Railways typically responded to the types of problems thatcould be readily resolved and that were not resource-intensive and not necessarily to the
problems that were most critical to increasing worker safety. 

Finally, the apparent lack of general inspections by the Government of Malawi inrecent years is a serious shortcoming. Given the critical role that inspections have apparentlyplayed in inducing Malawi Railways to redress at least some safety problems, the absence of 
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inspections has probably contributed to a significant deterioration of safety conditions in theRailways. The fact that the Railways does not systematically monitor workshop accidents
and near-misses means the costs of these poor safety conditions, to workers and the
 
Railways. are unknown.
 

3.6 Procedures to Monitor Workshop Safety 

The Industrial Safety Code of Malawi recommends that medium to large industrial
 concerns 
should assign one employee at least part-time as safety officer. One of thesuggested duties of such an officer is to maintain accident records. The Code also suggests
that such historical accident information can provide an empirical basis for identifying the
particular types of safety problems that impose costs on a given facility. 

While a position for an accident prevention officer has recently been established at theRailways, it appears that the responsibilities of this officer are focused exclusively on

derailments and do not include other workplace accidents that threaten worker safety. 
 Nor isthere any other management entity systematically generating reports on the Railways'

experience with workplace accidents. 
 Though required to submit reports on major individual
accidents to the Ministry of Labour, Malawi Railways does not appear to generate explicit
suiamaries of its experience with workplace accidents (e.g., in the form of aggregate
statistics). One railways management official indicated that there were approximately 100accidents per year. Another put forward an estimate of 2 to 3 per month, which translates
into only 24 to 36 per year. No further information was made available to derive firmer
estimates or to elaborate on the Railways accident experience. 

Greater attention appears to be given to derailments, since the Railways' working
capital is involved, than to workshop accidents. While the protection of rolling stock isfinancially important to the Railways, this bias raises the question whether there is sufficient
recognition within the Railways of the potential costs posed by safety risks. These potentialcosts include workmen's compensation, medical attention, lost productivity, and damages toRailways property, among other things. While workmen's compensation is negligible except
where losses of limbs are involved, and even then the compensation is low, the overall total 
costs from an accident may not be small, especially if damage to property is involved.Whether this is the case or not remains unknown until a more systematic approach is taken to
monitor workshop accident experience. 
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4.- Recommendations 

Resolving some of the inadequacies identified in Malawi Railways' environmental andsafety performance could be accomplished by reallocating resources within the organization.
In many cases though, additional fimancial resources will be required. The following

recommendations 
are made under the assumption that a donor-initiated effort will assist
Malawi Railways not only to get on a more sound economic footing but also to make
investments in environmental protection and worker safety that are not currently affordable. 

4.1 Recommendations: Environment 

4.1.1 Steps to Be Taken by Malawi Railways 

Of the inadequacies in Malawi Railways' environmental performance, it is
recommended that the following be addressed in the near term via a donor-initiated effort
(the first three to six months). Although they are at times made with specific reference tothe Limbe workshops, they apply to analogous situations at other locations as well. 

- Identify sources of pollutant discharges to surface water adjacent to railroad 
workshops. 

- Correct defects in oil separation system that allow oil-contaminated discharges into the 
adjacent surface water. 

- Where possible, channel oil-contaminated water that now passes directly into the
surface water through the oil separation system once it works properly. 

- Identify sources of groundwater contamination (such as refueling, tank cleaning, and
engine washing) and develop a plan for intercepting this contamination, such as
through recovering fuel product and capturing and treating wastes. 

Currently Malawi Railways does not have an explicit plan for assuring compliancewith environmental protection regulations. In many respects this shortcoming is a function of
the lax oversight and enforcement exercised by governmental authorities. Below, it isrecommended that the Government of Malawi address this inadequacy. As a result, it is
anticipated that Malawi Railways will have to take more initiative in anticipating andresolving environmental impacts from its operations. Consequently, it is recommended thatin the medium term (the first six months to one year) Malawi Railways initiate steps to
identify high priority environmental impacts from rail operations, that have not been
addressed in the near term, and ways to mitigate these impacts. This process may include, 
among other activities: 

A review of locomotive idling and operation practices to reduce smoke emissions. 
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A review of procedures to ensure adequate protection in hazardous material loading
and transport. 

A review of uses of waste oil captured in the oil separation system or other effluent 
treatment facilities. 

A review of the management of human wastes discharged from passenger services. 

While it is unlikely that dedicating the full-time efforts of a single individual to this oversight
will be justified, there may be economies of effort that can be achieved by combining the
environmental supervision recommended here with the safety responsibilities identified 
below. 

In the long term, Malawi Railways should have in place a procedure for anticipating
new environmental impacts that arise from changes in rail operations and for identifying
means of mitigating these impacts. For example, if the Railways returns to using pesticide tomaintain the rail right-of-way, a pesticide application policy should be drafted to ensure 
adequate environmental protection. 

4.1.2 Steps to Be Taken by the Government of Malawi 

The Government of Malawi is currently preparing a National Environmental Action
Plan (NEAP) and undertaking other environmental institution-building activities (such 
as onesponsored by the United Nations Development Programme) that are expected to change theregulation of environmental impacts from economic activities. It is premature to say exactly
how the outcome of these efforts will affect the regulation of Malawi Railways. There isfortunately a common perception of the need to bolster the monitoring and enforcement ofcompliance with environmental regulations and standards by line ministries and other
organizations with responsibilities for the environment. 

Because many of the environmeittal problems that come from Railways' activities are
local in scope, it is fitting that local health and other authorities have regulatory
responsibility. They have, however, lacked the resources or the administrative leverage to ensure that these problems are addressed. Inspections are infrequent and they have not been
able to ensure that problems that are identified get resolved. 

The effectiveness of local authorities in ensuring compliance with environmental
regulations needs to be improved. There is a risk that the institutional changes beingenvisioned in Malawi are too oriented to national entities because these are the primary target
of the NEAP process and other donor-supported activities. Because these local authorities 
are the front-line regulatory agencies with regard to Railways' operations, they should not be
shortchanged in the institution-building currently underway in Malawi. 
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4.2 Recommendations: Safety 

4.2.1 Steps to Be Taken by Malawi Railways 

In the near term via a donor-initiated effort (the first three to six months), it is

recommended that Malawi Railways address the following inadequacies in its workshop
operaio-ns. As was the case for the environmental recommendations, these are at times madewith specific reference to the Limbe workshop but they apply elsewhere as well. 

- Repair leaky roof of diesel overhaul building in Limbe. 

- Clear drainage system to make pits operable. 

- Fill long-standing and urgent needs for protective equipment, including protective
head gear (hard hats) and work boots especially. 

- Address perennial shortcomings in fire extinguishers and first aid boxes. 

In the course of the Malawian effort to draft a National Environmental Action Plan
(NEAP), which is financially supported by the World Bank, one suggestion has been put
forward to improve workplace safety. The legislative task force of the NEAP suggests that"employers could offer awards to their employees for observing occupational safety rules"
(DREA, #15, p. 20). In terms of maintaining a clean and safe workplace, this approachmight be useful. With a small amount of resources, employees could be provided incentives 
to upgrade the work environment. There are however larger problems, such as the blockeddrainage system at diesel overhaul and repair workshop in Limbe which will require more
than employee incentives. Possibly Malawi Railways could divert redundant labor to this and
G:her larger cleanup tasks. If so, the return to the Railways could come in the form of 
higher employee morale and productivity. 

In the medium term (the first six months to one year), it is also recommenaed that
Malawi Railways undertake the following activities in order to initiate and maintain a higher
level of oversight of safety needs. 

Begin a systematic and on-going analysis of the Railway's experience with workshop
accidents. 

Conduct a comprehensive audit of safety needs in the workshops. This audit should
identify the types of risks to be avoided, cost-effective means of avoiding these risks,
and the likely return to Malawi Railways. 

Establish priorities among these safety needs as the basis for a new safety investment 
program. 
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The review conducted during this mission uncovered but a few of the types ofworkshop practices that need to be addressed. Because there appear to be a large number of
inadequate practices, the ones cited here probably do not constitute a comprehensive list of
important practices that should be changed. At the same time, it probably will not be

possible for the Railways to implement simultaneously all of the changes necessary 
 to
upgrade safety couditions. Before the Railways increases its level of activity as the result of
donor funding, a thorough review of workshop practices should be conducted to determine
priorities in workshop safety improvement.9 This review should lead to the design of a
workshop safety improvement plan. The design and implementation of such a plan could be
milestones for a donor-funded project with the Railways. 

4.2.2 Steps to Be Taken by the Government of Malawi 

The primary tool of the Government of Malawi for encouraging improved workshopsafety is its authority to inspect the Railways and enforce relevant provisions of the Factories
Act. This authority is not being used to its fullest potential. Three dimensions of the
inspection and enforcement activities need further attention. 

First, most pressing is the need to undertake more regular general inspections to
evaluate safety procedures at the workshops. Others have also observed a lack of regularity
in inspections to ensure environmental safety in the workplace (DREA, #15, p. 22). A

review of Malawi Railways correspondence indicated at least a past willingness to try to
 
address some shortcomings raised by these inspections. 

Second, it is not clear how thorough the inspections are. The safety citations made

by the Factories Inspectorate reflect only a small portion of the problems that exist today.
This discrepancy may stem from an 
increase in safety problems that has occurred in the

absence of inspections. 
 Or, it may indeed be the case that the Inspectorate's citations only
reflect a modest portion of the problems existing at a given time. If this is the case, then the
inspection program needs to be upgraded to provide a m -,comprehensive and rigorous
review of the safety practices. 

The final shortcoming of inspections conducted under the Factories Act is the lack of
adequate enforcement mechanisms. Malawi Railways has chosen not to respond to certain
safety problems identified by the Factories Inspector. The primary mechanism at the
Inspectorate's disposal is the right to shut down an operation violating the Factories Act, or,
at least threaten to do so. Because this option may be best exercised as a last resort, an
intermediate mechanism should be constructed. A system of fines or penalties that are high 

' The further definition of a restructuring program for the railway overall will have implications for thesize and nature of work carried out at the workshops. This in turn will impact the safety issues. For example,the restructured railway may no longer carry out heavy overhaul and maintenance of locomotives, and instead 
contract out these activities. 
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enough to create incentives to redress safety problems but not so high that they would not beeffectively imposed could offer such an intermediate mechanism. The current penalties andincentives are too small or ineffectively administered to change employer behavior. Thefeasibility of changing these penalties or of identifying other, intermediate enforcement 
mechanisms should be investigated. 
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USAID/Malawi
 
Lilongwe, Malawi
 

Mr. W. Kent Burger
Field Coordinator, Environmental Monitoring Sub-Activity, Agricultural Sector Assistance 
Program, 
Lilongwe, Malawi 

Mr. Robert A. Cheleuka
 
Executive Secretary
 
National Road Safety Council of Malawi
 
P.O. Box 775,
 
Blantyre, Malawi
 

Mr. K.S.J. Chenjerani
 
Chief Mechanical Engineer, Malawi Railways
 
Blantyre, Malawi
 

Mr. James Chuma 
Environmental Information Coordinator 
Department of Research and Environmental Affairs 
Government of Mahwi 
Lilongwe, Malawi 

Mr. Andreas Danevad 
United Nations Development Programme/United Nations Environment Programme 
Lilongwe, Malawi 

Mr. Dan Dworkin 
Environmental Information Systems Advisor 
U.S. AID 
Washington, DC 

Mr. Wally Harper 
USAID Consultant Engineer 
Malawi Railways 
Limbe, Malawi 
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Mr. Ralph Kabwaza 
Deputy Environmental Coordinator 
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APPENDIX B
 

Terms of Reference
 

1) 	 Prepare environmental assessment of Malawi's environmental laws and regulations asrelated to Malawi Railways' operations. This assessment shall cover the following: a)procurement, storage, and disposal of chemicals, oils, fuels, and lubricants; b)
identify and assess Malawi Railway's procedures for implementing safety regulations;
c) assess Malawi Railway's procedures for controlling emissions from locomotives,
maintenance depots, and workshops; and d) review Malawi Railways' maintenance 
procedures for maintaining the railway track right-of-way. 

2) 	 Review Malawi Railways' workshop safety standards and determine if adequate
procedures are in place to implement and monitor workshop safety. Recommend
appropriate procedures and a mechanism for addressing workshop safety conditions. 

3) 	 Review Malawi Railways' environmental implementation and monitoring plan and
determine if there is adequate compliance with national and local environmental laws
and regulations. Should Malawi Railway lack proper compliance procedures and animplementation and monitoring plan, recommend appropriate mitigating procedures
and mechanisms necessary to achieve compliance. 
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Technical Working Paper 

Beneficiary Impact and Social Soundness Analysis 

1. Introduction 

Malawi Railways (MR) is in the process of restructuring with the objectives of providingefficient service in a competitive environment and becoming financially self-sustainable. MRand the Government of Malawi have sought assistance from donor agencies in support of thiseffort. A team of consultants, funded by USAID, conducted technical analyses in selected areasin support of the joint World Bank-USAID-ODA project preparation mission. This technicalworking paper resulted from the assessment of impact and analysis of social soundness of MR 
restructu ing. 

The paper is organized as follows. The remainder of this section gives a geographicalperspective of Malawi and a broad overview of the transport sector to provide the context of MR as a maor part of the sector and indeed the economy. The Scope of Work of this study is statedin Section 2. A description of the project and the main assumptions used in the study areenumerated in Section 3. The methodology employed to identify impact and analyze socialsoundness is discussed in Section 4. The main findings of the study are analyzed in Section 5,and the conclusions and recommendations are presented in Section 6. 

Malawi stretches over approximately 850 km in the north-south direction and about 300km in the east-west direction at its widest point. It measures about 120,000 square km, of which20 percent is covered by Lake Malawi. It is a land-locked country bounded by Mozambique inthe eastern, southern and south western borders; Tanzania in the north-northeastern border; andZambia on the northwestern border. About eighty percent of Malawi's population of anestimated ten million' lives in the central and southern part of the country, primarily in ruralareas. The two most populous cities are Blantyre and Lilongwe. Malawi with a per capitaincome of less than US $200 per annum is among the poorer countries in Africa, with a fragileagricultural based economy. Population growth is high and the social indicators are low. The 
economy has been stagnant for the last several years. 

The transport system of Malawi includes an infrastructure of about 2,700 km of mainroads and 8,100 km of secondary and district roads, 797 km of railroad, four inland (lake)harbors and four commercial airports. The roads are concentrated in the south, but a north­south highway (Ml) links the northern extreme of the country with the southern extreme. All
of the railway lies in the southern half of the country. 

The population inthe 1987 census was estimated at approximately eight million. 
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The main hub of the railway is in Limbe, a satellite of Blantyre' the largest city inMalawi. From Blantyre, the rail line moves to Nsanje in the southern most part of the countrybordering Mozambique, and northward toward the Lake Malawi port of Chipoka and then onto Salima. From Salima, it goes westward through Lilongwe to the Zambian border at Mchinji.Another line joins the north-south track at Nkaya with the Mozambique Railway-North (alsoknown as Caminhos de Ferro de Mocambique or CFM-N) connecting the port of Nacala at theborder town of Nayuchi. This track of railway network (with Malawi Railway and CFM-North)
is more popularly known as the Nacala corridor. 

The railway transports mainly goods, but it also carries passengers on some of its routes.In the fiscal year 1992-93, it transported 340,000 tons (52.3 million tons/km) and 859.000 
passengers (65.3 million passenger/kns). In the first nine months of the 1993-94 year, thetransportation of passengers has dropped relative to goods. Table 	1 in Appendix I, shows the
performance of the railway in more detail. 

2. 	 Scope of Work 

The key tasks listed in the Scope of Work are the following. 

1. Identify the socioeconomic impact of the Malawi Railway Restructuring project 
and conduct a social soundness analysis of the project. 

2. 	 Assess and quantify the economic and social impact on the main beneficiaries of 
the project. 

3. 	 Assess the extent to which social and economic dislocations will result from the
proposed project and make recommendations as to how adverse social and
economic consequences might be mitigated. 

The MR Restructuring Project has not been fully designed and the involvement of thedonors has not yet been completely defined. In this 	study, we have analyzed the socioeconomic
impact of the Malawi Railway restructuring project as articulated in the draft corporate planprepared by MR, defined by recent World Bank documents3 , the Transmark report, and theMalawi Government (GOM). It is understood that the restructuring program, in the process ofimplementation and further definition, will have many new elements. Therefore, the impactsemanating from it are likely to be somewhat different. But in the absence of any other clear andcomplete statement of the project, the description in the corporate plan is taken as the mostappropriate alternative. The implicit assumption here is that the restructuring process is well 

With a population of about 500,000, Blantyre represents more than half of Malawi's urban population, and
is the prime center of its commerce and industry. 

Aide-memoire of December 1993, and the corresponding Project Identification Sheet. 
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under way, and any donor supported changes in the recommended activities will increase thepositive impact and ameliorate the negative impact of the continued restructuring process. 

3. 	 Description of the Project 

The Malawi Railways has hicreasingly experienced financial difficulties, and since FY93.if not before, has effectively been insolvent. The government has kept it alive with financialassistance. Mounting financial pressures on Government, resulting from the recent regional
drought and other factors, has resulted in government being unable to continue with subsidies 
to financially "troubled" parastatals. The Government of Malawi, eager to continue with sound
fiscal management and continue with the economic structural adjustment program, was forced 
to encourage the railway to restructure in lieu of continued assistance. MR has already taken 
a number of steps towards restructuring itself and is developing a strategic plan to operate as a
commercially viable organization in a competitive environment. 

The objective of the proposed restructuring project is to improve the overall efficiency
of MR by improving performance in key result areas. Achieving specific targets in these key
result areas will involve the following changes in the structure and operation of MR: 

.	 Reduction in the workforce from the 1992-93 strength of 3,386 to 1,460 in the 
year 19984. Since October 1993, 867 staff have been retrenched and another 240 
are being served notices in April 1994'. The manpower plan for MR is given
in Table 1. 

ii. 	 The railway network will be classified into "core lines" and "retained lines". The 
core lines will be fully maintained and will see increased and efficient services
in goods transportation. The lines willcore consist of the current tracks
between Limbe-Salima-Lilongwe and Nkaya-Nyuchi (on towards Nacala). This
section of MR will operate efficiently and there is expected to be an increase in
volume and frequency of goods transportation. Tariffs here will be competitive
and the railway will not receive any subsidies from the GOM for the operation
of goods trains in this sector. 

iii. The retained lines will be maintained so as not to let the lines go into total
disrepair. They can be brought up to full operation within a reasonable time and
with minimum resources when demand increases. Both passenger and goods 

The actual number of staff required to run the restructured railway needs further analysis and definition. Anumber of scenarios for the future of the railway already exist, and each estimates a different 'optimal" level of 
staff. 

' Precise numbers are not fully verifiable. Thus, alternative estimates exist, but on an order of magnitude
basis, the various estimates am roughly equivalent. 
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transportation will be reduced in these lines. The retained lines will consist of
the existing lines between Limbe-Nsanje and Lilongwe-Mchenji. Passenger (and
accompanied baggage) services Limbebetween and Luchenza in the Limbe-
Nsanje line and between Salima and Mchinji will be greatly reduced. There willonly be special seasonal services between Lilongwe and Mchenji. particularly
during the tobacco harvest season. 

In general, there will be a reduction in passenger services in all lines and moreparticularly in the retained and therelines, will be increased services in the core LineL fortransportation of goods. The GOM will continue to provide subsides for passenger services in some routes where alternative travel options are not feasible. 

4. Methodology 

The methodology employed in this study involved review of pertinent documents,particularly relating to transportation issues and those relating to household responses to social
and economic changes. Discussions were held with key people involved with transportation inMalawi, especially the railways and the major shippers, and with a range of other people whoprovided first hand information on the condition of the people affected or likely to be affectedby MR restructuring, and their aspiration and plan for the future. Data was provided by MR,the Ministry of Labor, and collected from secondary sources like the publications of the NationalStatistical Office, Ministry of Transportation and the World Bank are used wherever appropriate.
The characteristics of the recently retrenched railway workers was analyzed from information
obtained from MR and through interview with some of the workers. 

s Fimdigo 

This section presents findings concerning the social soundness of the MR restructuring
project. The assessment of impact and social soundness analysis focuses on three areas ofchanges envisaged in the project. In each of these areas, the characteristics of the peopleaffected, the types of impact, and the adjustment process adopted by the affected people will beexamined. Due to lack of precise data and time constraints, this study was unable to quantifyimpact attributed to the project, nor is it appropriate to attempt such quantification until the
project itself is defined with greater precision. 

5.1. Impact of retrenchment 

The Malawi Railways has retrenched 867 people since October 1993 and is in the processof laying-off another 240 before the end of April 1994. They also plan to further reduce theirwork force in the next five years. Although the management has indicated that further reduction
in staff will generally occur through regular and normal attrition (that is, natural wastage), it seems unlikely that such a large reduction can take place naturally on sufficient scale. Also, the 
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restructuring will result in different configuration of staffing and skill levels. 

The manpower plan for MR in 1993-94 and the next five year is given in Table 1. 

Table I
 
Planned Retrenchment of Staff
 

By Department
 

1993-94 1994-95 1995-96 1996-97 997-98 1998-99 

General 420 378 321 273 246 221
 
Manager
 

Finance 149 95 81 69 62 56
 
Traffic 769 506 430 
 366 329 296
 
Technicl 1,983 1,404 
 1,193 1,014 913 822
 
Services
 

Pers & 191 144 122 104 94 85
 
Admin
 

Total 3,512 2,527 2,147 1,826 1,644 1,480 

Criteria for selection of staff were quite simple. Staff at the lines (station administration,
maintenance crew, traffic staff, etc.) at which services were stopped or reduced were affected
the most. Those in the upper age bracket, who were going to retire in tLe next five or fewer 
years, have received accelerated retirements. The third group of retrenched workers comes from
recent hires. The fourth group were those with poor job performance or discipline records. 

As indicated in the table, the railway is going to reduce its staff by about 2,030,nmflecting a drop of almost 60 percent in staff strength over five years from the level in 
September 1993. 

5. 1.1. Description of the affectedppulation: 

Detailed information about the personnel laid off by MR in the first six phases of
retrenchment are not fully available. Some of the information obtained from the personnel
department about the characteristic of the retrenched workers are given in Table 2 below. 
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Table 2 
Characteristics of Retrenched Staff 

Malawi Railway 

Place of Nos. Staff Urban/Rural Income per Years of Age
 
employment 
 month Service
 

Blantyre 64 
 Urban 

Lilongwe 29 Urban 

Salima 42 Urban 

Others 726 Urban/Semi 
Urban 

Total 861 Urban/Semi Min=K197 Min=3 Min=26 
Urban Max=K173 Max=41 Max=60 

9 Med=28 Med=45
Med=k600 

The monthly income of the retrenched staff ranged from K197 to K1,539, with themedian income of about K600. Typically, they have served the company for more than 20 years
and were over 40 years of age. Almost all of them had some level of education, with manyhaving secondary education and other higher level of training at the vocational institute. Only32 percent of them had some technical skills. They are generally urban dwellers, but some livedin semi-urban areas. The majority of them lived in railway owned and maintained houses, orhouses leased for long-term by the railway at very reasonable rates. Some of them however,had to rent their own accommodation. The railway houses are of superior quality compared to
houses people of similar socioeconomic conditions live in. Almost 31 percent of the retrenchedstaff were at the last few years of service before retirement. They were forced to take earlyretirement. The staff at MR had good access to outpatient medical facility and also receivedprompt and quality inpatient care once referred by company physicians. Although the average
size of the households of the retrenched staff was stated to be five, there are many householdswith more than ten members of immediate and extended family. A much higher percent of therailway staff has sent their children to primary and secondary schools than the national average
for urban population. 

5.1.2. Impact of Income loss 

The laid off staff have worked for the railway for between 3 and 41 years, with themajority working for more than 20 years. They have worked full-time with perception ofsignificant job security. Once employed, they expected to be employed until retirement. As
such, they have not engaged in any other income earning occupation or accumulated significant
savings for unforeseen events. With an average wage of the laid-off workers estimated at K600, 
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the railway workers maintained relatively comfortable lifestyles compared to national per capita 
income estimates' . As people with secure incomes, the railway workers were also able to takethe added responsibility of taking in members of the extended family. All the workersinterviewed mentioned of having extended families. 

Employment Prospect: The current employment situation in urban Malawi is poor. In
the absence of the recently collected comprehensive data on employment, it is difficult to
estimate the actual unemployment rates in Malawi. However, discussions with goventment
officials in the Ministry of Labor, large private employers and employees at the railways.
indicate that there is a serious employment problem in general and more so in the urban areas. 
The 1987 population census cites the urban population at 11 percent, or approximately 850,000.
There were about 600,000 working age people in the urban areas. With an underestimated
pa-ticipation rate of 46 percent, the tot2l number of people employed or looking for work 
amounts to 272,000. With approximately 169,000 reported as employed as wage labor, and
about 37,000 self-employed, the unemployment rate is estimated at almost 25 percent. 

Furthermore, the economic problems and population increases in the last two years are
likely to have accentuated the problem of unemployment. The real GDP in 1992 and 1993 has 
gone down. The unemployment rate therefore, is likely to be higher than the 25 percent
estimated for 1987. 

The unemployment problem is further aggravated by the fast growing population and the
ever-increasing new entrants to the work force. Every year there is an addition of 185,000
people in the labor force, but the economy is able to generate only 15,000 to 35,000 new jobs.
The laid off railway workers are generally older (more than 40 years of age), and many of them
unskilled or have skills quite unique to the railway a_,d therefore are less likely to be able to 
compete favorably in the labor market. There is a prevailing practice among many organizations
that set maximum age limit of 40 years for new hires. Many of the retrenched workers have very little prospect of employment in urban areas. Their options are generally limited to setting 
up small businesses, or to go back to their traditional villages and engage in agricultural 
activities. 

Business Opportunity: Malawi is currently going through difficult economic times. In
the face of economic difficulties and general stagnation there are fewer business opportunities.
Moreover, the unemployed railway workers had exposure to businessno practices and lack
market and business related information. Having been used to fixed and stable earning sources,
they are not used to risk-taking and aggressive pursuit of business objectives. They also lack
business skills, capital and physical assets for accessing bank financing. On the positive side,
however, the railway workers are generally more educated, are better connected, and have some 
institutional support from union and colleagues, etc. 

6 However, relative to many other workers in the formal economy, wages at MR are quite low. 
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The loss of a secure job has been devastating for the laid-off staff. The retrenched staff were generally the heads of households and most often the only formal sector income-earnin,
member of the household. The average size of urban household is five, but a large percentage
of families have in ex,:ess of nine members. Therefore. in the absence of alternate income­
earning occupation, the loss of a job amounts to the loss of sustained livelihood for five or moremembers in the households. With an estimated average income of K600. the laid-off staff
generally lived a modest but relatively comfortable life style. The loss of income will affect
most adversely on food consumptlcau (about 50 percent of income), housing (15 percent ofincome), and schooling. The impact ot !oss of job and income is further accentuated by rising
inflation and poor conditions of the current economy. 

5.1.3. Impact on Women: 

In the absence of a secure job for the traditional income earner (almost exclusively male
in the urban household in Malawi), experience in many of the East and Central African countrieshave shown that women seek income earning alternatives, particularly in the informal sector.Some have become involved in urban farming or have become self-employed. This could alsohappen in Malawi. Women typically took up activities with low capital requirements such asfood preparation, retail of fuel and consumables, and cottage industry activities. 

As women become more involved with income generating activities, and becomeimportant source of income to the family, their status in the society also changes. Thisempowerment often leads to greater economic and political dynamism in the society. However,
it also has other consequences. Greater involvement in an income-earning occupaticn leads tolesser time for the traditional role as housekeeper and for the upbringing of children. Mothershave delegated household tasks to a greater extent to children, generally to their daughters. As 
a result fatigue from household work and of helping mother were often cited as the single most
important reason for poor school performance and participation in school work. 

5.1.4. Imioact of Relocation: 

The high cost of living in the urban areas and low probability of alternative employment
or other income-earning activities would force many to relocate to traditional villages in orderto live on less, and also for an opportunity to grow subsistence crops. It is pointed out that the 
younger workers are more likely to stay in the cities and seriously pursue employment andbusiness opportunities in the urban and withareas, support will be successful. The olderworkers are more likely to retreat to their traditional villages and engage in subsistence
activities. Land for building houses and for cultivation is not seen as a major problem. Localchiefs are eager to help and are willing to provide land for homestead and garden at no cost.Clearing and development of the land and building houses are the responsibilities of the tenants. 

Housing Problems: One of the better amenities that railway employees enjoyed relativeto colleagues in comparable jobs in other industries is improved housing facilities. Relativelybetter housing facilities were provided to railway employees at low or nominal rents. Railway 
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housing had significantly superior accommodations compared to average housing available in theurban areas, let alone those in the rural areas. These houses/apartments have electric facilities.piped in water, complete sanitation facilities and adequate floor space. They are generally ofcement and concrete structure with corrugated iron or concrete roofs. Loss of housing facilitieswill be a serious reduction in the quality of life for the retrenched workers. It is very unlikely
that they will be able to afford similar housing at the market rent, 

Table 3
 
Housing Characteristics
 

Percentage Distribution of Household by Characteristics
 

Housing Characteristics Urban Rural 

Electricity 19.8 1.1 
Piped water I.6 

Access to piped water 71 17.4 

Modem sanitation 14 .6
 

Pit latrine 82.9 68.5
 

No facility 3.1 30.8 
[Avg persons per sleeping 2 7 2.8
 

room
 

even if they are able to find comparable jobs. The retrenched staff have to move from improved
housing to lesser housing in the urban areas or as is more likely to rural areas. 
 Table 3 list thehousing characteristics of urban and rural housing. Discussions with various people have
indicated that the majority of the retrenched 
 workers would be going back to their traditionalhomes. They will build houses on family land. Considering the low severance package that the 
workers were able to receive, these houses arehousing characteristics mort likely to be very modest. In general,in the rural areas is perceived to be significantly inferior to the urbancondition. Only one percent of rural dwellings have access to eiectricity, 18 percent have accessto some kind of piped water, and 69 percent have access to some sanitation facilities.Comparable figures for the urban areas are 20 percent, 82 percent and 95 percent, respectively.There is no appreciable difference in the number of people sleeping per room between urban and 
rural areas. 

Schooling Problems: Almost universally the railway workers have enrolled theirchildren in schools. Their children have planned to complete at least secondary school.Dislocation will force many of the children to drop out of schools. Although there are freeprimary schools in rural area and pub.lic school with low fees like the urban areas, they are farapart and represent longer travel. Table 4 shows the percentage of school age children enrolled 
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in schools in urban and rural areas. More than twenty percent fewer children from all agegroups a"tend schools in the rural areas. Dropping school will be one of the more seriousimpacts of dislocation and possibly the greatest loss of investment 

Table 4
 
School Enrolment
 

Percentage of School Age Population Enrolled
 

Age Group Urban Rural Aggregate 
6-10 73.9 49.6 52.3 
11-15 78.6 64.5 66.3 
6-15 76.2 56.5 58.7 
16-20 52.4 34.2 36.7 
21-24 17 8.4 9.7 

for the retrenched workers. One of the retrenched staff mentioned that he has nine children inhis household and all of them go to school. The oldest is eighteen years old and is preparingfor matriculation. He believes he has no prospect for any employment in Blantyre and hasdecided to go back to his traditional village. He needs to get all his children to the village tohelp him prepare the field for agriculture. He does not see any further education for hischildren. The most far reaching social problem arising out of the retrenchment, if long termurban residents have to move to traditional homes, will be the loss of opportunity for theirchildren who were in many cases born and raised in urban settings, and other adjustment
problems including social conflict arising out of this mis-adjustment. 

Health Care Issues: The railway employees and their families received companyprovided outpatient and ambulatory care free of charge. For serious cases requiring inpatientand specialized care services, the railway dispensary referred to St. Elizabeth Hospital, thecountry's premier acute care hospital, which provided services free of charge. Access to health care in the rural areas is less than satisfactory. The retrenched employees are going to lose thisimportant benefit. One of the employees interviewed stated that he has a good piece of land thathe could cultivate. But because his wife has a serious case of chronic asthma, he is in adilemma about what to do. He cannot survive financially in the city, but at the same time, hiswife who often needs emergency medical attention, will not survive in the traditional village. 

5.1.5. Acceptability of the Program 

The retrenchment of employees under the railway restructuring project is onlypartially understood by most staff. They saw it coming due to the ever decreasing levels ofservices from the railways since the civil war in Mozambique. However, a number of concerns 

10
 



were voiced by many of the people interviewed. Three of those concerns were raised mostemphatically: (i) the inadequacy of the severance allowance; (ii) the mis-timing of theretrenchment; and (iii) lack of communication, and representation of the employees in the 
management decision. 

Adequacy of the Severance Allowances: The railway provided two kind of packagesfor the retrenched staff. Both packages contain a 'notice pay', a relocation allowance, three'
months notice and a right to stay in railway accommodation for three months. The notice payfor regular retrenchment candidates amounts to half a month pay for every year of service. Forthe early retirement candidates, the railway pays the company contribution to the pension fundfor stipulated years remaining before the actual date of retirement and regular pensions. Forexample, a 55 years old employee who was forced retire at 55 instead of the regular 60 years,will receive an amount equal to four percent (approximately) of pay company contribution forthe remaining years (five). For relocation, the railway will either transport the retrenchedemployee's family and household furniture and other goods to the choice of place, or pay areasonable transportation fee at the choice of the employee. The transport allowance is equally

applied for both retrenched and early retirees. 

The affected people do not feel that the severance benefit is very reasonable and fair.They complain that allowances provided by other oganizations are more substantial than whatthe railway is offering them. For instance, Air Malawi has offered one month's pay for everyyears of service. David Whitehead, a private textile company which laid off thirteen hundredemployees two years ago, offered three percent of a year's salary for every years of service foremployees with less than five years of service; five percent of yearly salary for those servingfor five to nine years; and six percent for those over nine years of service. Translated into anequivalent time frame, the Whitehead allowance is equal to 1.56 weeks for each year of servicefor those under five years, 2.6 weeks for those under nine years; and 3.12 weeks for those over
nine years. 
 The retrenched workers and the labor leaders interviewed also indicated that recenthigh inflation and virtually stagnant pay level in the past few makes theyears severanceallowance inappropriate and unfair. The severance package is also subject to normal taxation,resulting in further reduction in effective compensation. The half months pay for a year ofservice was established in 1963, when about 3,000 railway workers were laid off. Both theofficials of the labor union and the employees interviewed suggested that one month salary for 
every year of service would be a fair settlement. 

The people who were made to take early retirement did not receive severance pay. Theyfeel they have been treated unfairly. They do not understand why they should not receive severance pay when technically they have been terminated because the position they occupied
does not now exist under the restructuring program. 

Thning of Retrenchment: Concerns were raised on the timing of the retrenchment.Many of the six phases of retrenchment were carried out in the rainy season. This is aparticularly bad time for travel for relocation. Roads are bad and properties are damaged in therain. Moreover, the building materials (straw for roofing) are only available after the rainy 
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season. The June to September time frame is most appropriate for travel and building houses
in rural areas. 

The Severance pay is not all paid at one time. They are usually paid over three or moremonths. During !.his period, workers are required to stay in their post. It is often traumatic forthe laid-off staff to come to work for three months, often doing no work. Lack of motivationand preoccupation with thoughts of misfortune often expose the workers to accidents particularlyin the cases of locomotive drivers or maintenance gang, and also make them more prone toerratic behavior. They risk personal injury and loss of severance compensation resulting fromaccident and disciplinary actions for untoward incidence occurring in these three months. 

Lack of Communication: The restructuring of the railway and the ofprocessretrenchment has been conducted with very litile interaction with the general employees of therailways. In the absence of proper communication, rumors were rampant, resulting in anxietyand serious morale problems. There was no representation or other forms of involvement fromthe side of the workers. There were few meetings with the workers and the union, and therewas some other discussion and dialogue. The workers voiced their concerns and stated whatthey thought was appropriate compensation. There were no other communication between thenand the time of termination notice. This resulted in soi. ill feelings'; among the workers,because they felt that they should have been informed about the consultations going on betweenappropriate government officials and the railway management. As explained by the PersonnelDirector at David Whitehead, perhaps the one single action that was responsible for smoothimplementation of worker lay-offs, was the regular communication between the workers and 
management, either through n .isletter or through regular meetings. 

5.2 Impact of Transportation Efficiency in the Nacala Corridor 

One of the main objectives of the MR restructuring program is to improve services at theNacala corrider, that is on the core rail line. MR recognizes that Nacala port can be the mostcost-effective rail oulet for Malawi and therefore it should be safe in operation, providemaximum customer satisfaction, and operate efficiently so as to reduce cost to the minimum.By providing assured and quality services at efficient cost and charging competitive rates, MRexpects to increase feight on this route from its current level of about six percent ofinternational trade volume to 40 percent of international trade volume. This will enhance revenue for MR and the GOM will save substantial money previously used to subvent the
railways excess cost over revenue. 

Malawi has the world's highest transportation cost element in the value of imports (CIF).It is estimated that currently transportation costs represent 16 percent of the commodity valueof exported goods and 23 percent of imported goods (please see tables in Appendix A).some commodities, eg. imported food grains, 
For 

transportation cost exceed the value of thecommodity. The transport burden for overseas traffic to the economy of Malawi is estimatedat K660 million ($120 million, 1990 data). The World Bank estimated that if all theinternational corridors operated efficiently, the country could save almost 24 perc, at, or K154 
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million ($28 million). The two rail routes to Beira and Nacala provided the shortest way to theports. With the Beira route out of commission for several years to come, Nacala provides thebest potential for savings in transportation cost. Unreliable services in the Nacala corridor inthe past have prevented the shippers to use this route. Recent improvement has led to morereliable services, and favorable tariffs isproviding greater incentives to shipper to use the Nacala 
route. 

5.2.1 Direct Impact 

The direct impact of efficient operation of MR will be borne by the shippers and traders.Lower transportation cost will result in higher margins for the traders. Compared to alternativeroutes, shippers at the Nacala port will save between K165 and K196 for every ton of drycommodity. The savings could be even greater for bulk exporters and importers who have beenable to negotiate favorable tariff rate for their products in return for guaranteed volume. Tradersin large consignment and bulk commodity transportation like fuel, grain, fertilizers etc. canreduce their transportation cost significantly often by more than 50 percent. A recent inquiryby USAID/Maputo indicated taat transportation costs of petroleum products can be reduced fromits current cost of KO.6 per liter to KO. 12 per liter. Similarly, trader of edible oil and tea can save K825 and K247 per ton, respectively. 

Even though the potential for saving is enormous, not many shippers have shifted toNacala Corridor. This is primarily due to uncertainty and often inconsistent services. TheOILCOM which imports 50 percent of the country's oil mentioned that they can gain significantcost advantage by using the truck route to Beira and MR to Nacala, but due to highleakage/pilferage in the Beira route and longer travel time (average of seven days) in the Nacala
corridor, they continue to use the Dar, Harare and Lusaka routes, which cost almost 50 percent
more. 
 If the railways can guarantee consignment within four days instead the current sevendays, the company can use the Nacala Corridor for 50 percent of its oil and save substantial 
amount of money. 

The Grain and Milling Company has aggressively used the Nacala Corridor and obtainedgreat results. The company has been able to negotiate a rate of K149 per ton for transportationof wheat. This rate is considerably lower than the K440 per ton they paid for shipment fromBeira. The trucking companies have since then lowered their rate to K273, but the Grain andMilling Company is happy with the MR. The company expect to import 35,000 tons of wheatin the current year saving almost K 1I million in transportation cost. 

ImporterF of fertilizer are another major stakeholder in the improvement in efficiency intransportation in the Nacala corridor. The use of fertilizer is increasing as hybrid seeds arebeing introduced and increasingly adopted by the farmers. It is estimated that 185,000 tons offertilizer is going to be imported this year. In 1992-93 year, 150,000 ton were actuallyimported. The Smallholder Farmers Fertilizers Revolving Fund of Malawi which imports almostall of Malawi's chemical fertilizers have not used the Nacala corridor since 1989, when theirexperience has not been satisfactory. The bulk of its fertilizers comes from Dar es Salaam, 
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Richard's Bay (South Africa), 	 and Johannesburg. As Table 5, below indicates transportation 
cost varies from the least 

Table 5
 
Transport Cost from Selected
 

Ports to Blantyre
 

Routes to Blantyre 	 Cost/ton
 
Kwacha
 

Dar-es-Salaam K495 

Richard's Bay- K496
 
Harare
 

Johannesburg 	 K445 

Nacala K350 

cost route from Johannesburg at K189 per ton to the most expensive route of Richard's Bay atK496 per ton. Compared to those, the posted 	rate for the Nacala-Blantyre train route is K350 per ton. Implying a savings of almost K150 per ton. With guaranteed volume, the rate can benegotiated down considerably. With an estimated import of over 130,000 tons of fertilizer ayear, transport savings alone amounts to more than K2 million. In addition the ex-port pricefor Nacala is indicated to be more attractive particularly for European imports. 

It must be mentioned cost alone does not influence the use of a specific mode or routeof transportation. Reliability, time and wastage are other major determinants. A World Bankstudy analyzed the distribution of international trade traffic among the major corridors andconcluded that if all available corridors operated optimally, the Nacala corridor will be used for58 percent of cross border transportation, as against its current handling of only six percent ofoverseas trade. The study also estimated that with all routes operating optimally, there will be a saving of 24 percent in total taansport cost. 

Increased efficiency in the operation of MR will result in its financial solvency. In theabsence of financial solvency, the government has been making up the operational shortfall fromits revenue budget. Since 1990 GOM has been supporting MR with about K1O million annuallyto support the operating shortfall. In 1990-91 GOM subvented K6 million in operating subsidyto MR, in addition to K8.8 million in development assistance. 	 With restructuring thegovernment will no longer need to provide such regular subsidies to MR to meet the operationaldeficiency. GOM however, will continue to provide financial support for passenger services in
the financially infeasible lines. 

14 

10/
 



5.2.2 Indirect Impact 

Savings from efficient and reliable transportation will initially accrue to shippers andtrader. But some of this savings will be passed on to consumers and producers in the form oflower prices. The extent of this pass through will obviously depend to large on thea extent
level of competition and the price elasticity of the concerned commodity. Reduction in inputprices and increase in producer prices resulting from transportation cost savings are likely to lead 
to higher production. 

Commodities that can be bulk handled for transportation are believed to be able to benefitmost from improved efficiency in the Nacala corridor. Petroleum, cement, fertilizer, tobaccoand wheat are some of the major candidate commodities to use MR in the Nacala corridor. Bothpetroleum and fertilizer prices are regulated by the government and therefore are not totallydependent on market condition. However, to the extent their prices reflect cost, farmers andgeneral population will benefit from reduction in cost. This study has not been able to assessthe response of fertilizer use due to changes in price, or the production response to fertilizer use.But in general, experience in other countries in Africa and Asia show price elasticity of fertilizeris significant and production of agricultural commodities has positive co-relationship with 
fertilizer t je. 

Petroleum product, particularly paraffin or kerosene is increasingly used in both rural andurban areas for ighting and cooking purposes. Price relief of these product will help thecommon people and also alleviate environment problem resulting from use of firewood and 
charcoal. 

Malawi consumes about 85,000 tons of flour annually. Less than 20 percent of the flouris milled within the country, the remainder being imported as finished flour from South Africa.Bulk handling capacity and subsequent reduction in transportation cost have made wheat millinga financially feasible operation in Malawi. Large quantities of whole wheat are now beingimported into in Malawi. The Grain and Milling Company of Malawi currently process 17,000tons of wheat and expect to increase production to 35,000 tons, representing almost 40 percentof the country's need for flour. They have been able to compete successfully with importedflour by passing on savings in transport cost to the consumers. The country also benefit from
employing labor and other resources for the processing of grain. 

Import of bulk wheat from Nacala has been able to promote milling in-country as againstimporting wheat flour. Grain and Milling company projects that if they go into full capacityproduction (85,000 tons) early next years, and they can negotiate good tariff with railway, theycan export approximately 5,000 tons of wheat bran, earning important foreign exchange for thecountry.. In the absence of sufficient market locally, wheat bran is currently used for stock feed 
at nominal prices. 
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Improvement in Nacala traffic and reduced transportation cost will increase competitionin the transport sector. Other modes of transport will compete for business and offercompetitive rates to shippers. For example, the published rate for trucking services from Beirato Blantyre has dropped from K440 to $275. There are also indications that handling cost at Dares Salaam are being reduced. These kind of competition is favorable for both producers and 
Final consumers. 

Financial sustainability of Malawi railway is Likely to result in fewer subsidy from thegovernment. As indicated earlier, GOM can save almost K9 million every year in tax payormoney. This resources can be diverted to social services like schools and health centers or intomuch needed development activities. Alternatively, it can reduce the tax burden of the people. 

5.3 Impact of reduced Passenger Services 

Passenger services in MR are considered incapable of operating profitably. However.on social considerations, passenger services mixed with some freight facilities have beencontinued but on a reduced scale on some lines while closing some routes altogether. Table 6shows current level of passenger services on specific routes and their status before October last 
year. 

Table 6
 
Mixed Train Services in Selected Routes
 

Routes Service Before Services After 

Restructuring Restructuring 

Limbe-Luchenza Daily 2 up and 2 Twice a week RiT
 
down
 

Limbe-Salima Daily 2 up and 2 Daily 1 up and I
 
down down
 

Balaka-Nayuchi Daily 1 up and 1 Twice a week R/T

down
 

Lilongwe-Mchenji Daily I up and 1 Seasonal services,
down Feb-Oct
 

Salima-Mchenji Daily i up and I 
 Cancelled 
down 

The road transport has gradually become the dominant mode of passenger traffic. But for somethe railways have remained a preferred mode of passenger traffic, while in some routes it is stillthe only conveient way to travel. In some areas, the railway line gives access to villages that 
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are inaccessible (generally or seasonally) to other modes of transport. The people who are going
to be most affected by reduction or cancellation of services can be classified into those livine
in the area that are not serviced regularly by other modes of transport. those who are able tobring large loads with them for trading or other purposes and those living close to the stations.
The first group appears to belong to such areas as Nkaya, Utale, Njarenja. Shire North. Gwaza.
Nansadi. etc. in the routes between Balaka and Limbe and between Limbe and Luchenja. The
second group of people comes from many part of the rural districts. The:e groups are largely
small traders who collect fresh produce from villages and bring them to cities and commercial
places like Blantyre, Salima, etc for sale. On their return they bring in fertilizers, sugar andother consumer goods cu villages. These people serve important function in the marketing chain. 
The railway stations often transform itself into busy market after these train arrive. The third groups are scattered along the railway line and reduction of service is a matter of some
inconvenience. They still can otheraccess more efficient modes of transport by travelling to 
nearby highways to avail of bus services. 

The tobacco growing area in the south-central region and the sugar growing region of thesouth will be affected by reduction of services. Although, MR hopes to provide seasonal
services to the Mchenji region during the harvest time, distribution of inputs during the growing 
season may be affected. Similarly the sugar growing area of Luchenza and Chloe will be 
affected by reduction of services. 

6. Conclusions and Recommendations 

The rationalization and restructuring of MR will reduce a significant financial burden of
GOM. It is likely to have some positive macroeconomic impact either through reduction in
budget deficit or by enabling the government to divert funds to more social services anddevelopment programs. Greater efficiency in railway transportation leading to lower effective
transportation cost is likely to have significant positive impact on international trade. The
shippers and traders dealing in large volume particularly in the international trade sector, are
going to benefit most. However, increased competition both among different modes of
transportation and between producers and traders will result in sharing some of the gains with 
the final consumers. 

Rationalization of MR services will adversely affect small traders and farmers who
brought produces from the farms to larger markets in the urban commercial centers and took
back agricultural inputs and essential consumer goods. It will also affect those people whose only
feasible travel route is the railway. But perhaps the most significant social impact of
restructuring will emanate from dislocation and loss of income of a large number of people
resulting from loss of employment. In the absence of many alternative employment andbusiness possibilities, the retrenched people and their dependents face severe socioeconomic 
problems. 

The rationalization of the operation of MR is overdue. There are many benefits resulting 
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from restructuring and it appears to be accepted by most of the people concerned. including thepeople adversely affected. However, both the government and the donors should look atpossibilities to mitigate the adverse socioeconomic impact resulting from retrenchment and
reduction in services in some routes. The following recommendations are made to make therestructuring project more socially sound. The magnitude of the financial burden these measure 
will take is not assessed. 

Counselling and Placement Service: The retrenched workers are very ill-informedabout employment and business opportunities. The shock of losing employment and lack ofinformation may force them to make inappropriate decisions. Beside providing some financial
compensation, MR has not addressed the issue of rehabilitation of the workers. It has not given
much attention in providing pertinent information or counseling to the laid-off workers. Afacility should be set up or an existing organization that can provide such assistance brought intemporarily to address this issue. Beside hiring or make other temporary arrangement with localNGOs or professional services, capability can be developed within the railway, or the laborunion to provide counselling and placement services. Since neither the union nor the railwayhave the financial resources to run such a service, the donors possibly have to provide technical
assistance and funds te develop such a capability. The implementing agency can guarantee their
commitment donating office bearer time and use of their dissemination network. 

Training of Workers: Some of the retrenched workers are skilled in many trades. Butthe majority of them are unskilled. Both of these types of workers may need to be trained orretrained to fit the demand of the market. In addition, some of the workers have the skills andaptitude to function as small self-employed businesses. But they need assistance in setting up
such efforts. Several existing organizations like the Malawi Employment Development Program
(MED), the Malawi Entrepreneurship Development Institute (MEDI), Small Enterprise
Development Organization of Malawi, etc. provide skill assessment and skill development
training in Malawi. These facilities can be involved in this effort. Rather than setting up a
training facility, the existing facilities can be revamped and involved in the rehabilitation of the
 
retrenched railway workers.
 

Funds/access tofunds for small business: The retrenched workers do not have manytangible assets for suitable collateral in the formal credit facilities. They may have some "seed" money that they can invest, provided they can obtain additional funds to establish viable
business. A fund can be set up to help the retrenched MR workers directly, or an organization
that will screen loan risks and provide guarantee to formal credit facilities with some operating
fund can be established. Possibilities of funding and/or assisting organizations like Malawi
Union of Savings and Credit Co-operatives (MUSCCO) and other progressive credit organization
to provide such support should be explored. 

Housingassistance: The retrenched workers loses good housing facilities with theirjobs. Many of them will relocate to their traditional villages while others will remain in thecities. Rents are high and so are the mortgages (because of current 26 to 33 percent rate ofinterest). Assistance in the form loans, access to construction materials and/or land to build 

18 

/­



appropriate houses in the rural and urban areas can be provided to improve the living condition.
Alternatively, the retrenched workers can be provide loans to buy-out MR ow ned 
accommodation in which they are living. 

Increase severance allowance: High inflation, the current low salary and the formulato estimate compensation, provide very low severance compensation for the workers. Theformula of one month salary for each year of service should be augmented to increase the social
acceptability of the MR restructuring project. Also, the candidates for forced retirement shouldbe treated equally with other retrenched staff. They ought to have the option to choose either
the retrenchment allowance without pension benefit, or the pension benefit without retrenchment 
allowance. 

Development of rural access roads in areas not serviced by MR or other means oftransportation: T"he small traders provide an essential and cost effective marketing function to
the economy. In the wake of reduced or cancelled MR services in some of the areas, the roleof the small trades and their contribution to the economy should be objectively examined.
their contribution to the economy and the opportunity 

If 
cost of other users of MR are foundsufficiently high then the possibility of developing rural access roads in the areas not properly

serviced by either MR or other means of transportation should be seriously explored. These low 
cost dirt roads were found to have substantial positive development impact in many countries.
USAID PL 480 food assistance has been effectively used to provide balance of payment support
at the same time developing rural feeder roads in many developing countries that imports food 
grains. 
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Appendix A
 
Tables
 



MALAWI RAILWAYS LLMITED 

Unit (000) 1992/93 1991/,92 

Number of Passengers Camed 859 1.282 
Passenger Kilornetres 65.362 87.6! 3 
Total Goods (Tonnes) Camed 340 337 
Total Goods Net Tonne Kilometres 52.265 56.443 
Total Gross Tonne Kilometres (Goods and C 174.062 21)3.517 

GOODS TRAFFIC (Tonnes) 

Imports 71 25 
Exports 12 13 
Local 231 252 



MALAWI RAILWAYS LIMITED
 

Goods Traffic 
Local Goods Traffic Exports Via Nacala Imports Via Nacala 

Commodity (Tonnes) 1991/92 1992/93 1991/92 1991/921992/93 1992.93 
Beans and Peas 3.188 1.099 102 20
 
Beer and Minerads 1.821 102
 
Cement 
 16.990 8.781
 
Clinker 
 79.143 88.080
 
Coal 
 19.009 14.996
 
Cotton Lint 
 6.790 4.443
 
Cotton Seed 
 10.011 5.642
 
Cotton Unginned 6.284 
 7(4
 
Empties Returned 673 0
 
Empt. Containers 
 422 1.197 
Fertilizer 16.080 10.234 9.652 9.589 
Groundnuts 1.776 298 
Maize 17.008 41,379 4.283 241 0 25.680 
Oils. Edible 0 600
Paper 0 0 
Rice 1.267 953
 
Salt 
 991 1.941
 
Sugar 
 71 145 
Tea 631 0 205 0
 
Tobacco 18,699 15,546 6.854 10.747
 
Wheat Flour 
 2.596 10,640 
Other 21.762 17.924 1.5981.527 10.995 15,899
Sub Total 222.545 213.559 13.042 12.751 23.193 62.408 

Fuel
 
Diesel 15.194 5.779 1.147 5.889 
Ethanol 5.509 5,608
Petrol/Paraffin 8,714 5.776 526 2.466
Total Fuel 29.417 17.163 

Total Public Traffic 251,962 230.722 13.042 12,751 24.866 70.763 
CompanN Traffic 0 0 0 244 

Total 251,962 230.722 13.042 12.995 24.866 70.673 



TransportRoutes from Blantyre for Mal-wi's External Trade
 

Port Served Mode (s) 
Key Points 
En Route 

Countries 
Transited 

Length 
(km) 

Beira Rail - MOZ 640 
Nacala Rail - MOZ 815 

Durban 
Durban 
Durban 
Durban 

Rail/Road 
Rail/Road 
Rail/Road 
Road 

Tete, Harare 
Lusaka, Harare 
Lusaka, Gaborone 
Lusaka, Harare 

MOZ, ZIM, RSA 
ZAM, ZIM, RSA 
ZAM, BOT, RSA 
ZAM, ZIM, RSA 

2.667 
3.467 
3,806 
3,500 

Dares Salaam Rail/Lake Chipoka, Chilumba TAN 1,728 
Road Mbeva 

Dar es Salaam 
Dar es Salaam 
Dar es Salaam 
Dar es Salaam 

Rail/Road 
Road 
Road 
Rail/Road 

Mbeya 
Mbeva 
Lusaka, Mbeya 
Lusaka, Mbeva 

TAN 
TAN 
ZAM,TAN 
ZAM,TAN 

1,770 
1,789 
3,030 
3,100 

Source: Malawi NTC Project, World Bank Staff Appraisal Report 
No. 6022-MAI, January 27, 1989 



PtoW89 Of thel0191di Vlu
*NAC DRA NTCVae 

-~~R&~L ROAD =ROAD ROAD ?ectS.ut. wl ~utoEXPORTS 
Sugar
Tobacco 	 36 35.1

14.9 12.2Tea 266 296 287 301 24.2 	 23.2Groundnuts 
67.6 579Coffee 178 200 196 
 260 
 8.7Cotton Lint 	 8.6243 293 286 300 
 19.4 18 IProduce 

14.2 14.2
Other 
 211 
 240 
 235 
 293 
 6.1TOTAL EXPORTS 	 6.1 
15.9 14.4 

IMPORTS
 
POL 


50.8 
 34.9
Fertilizer 
64.7 54.5Iron & Steel 187 293 
 233 
 251


Wheat & Flour 209 308 241 	
8.2 7.8 

229 116.5 107.4Pulp & Paper 187 293 
 233 
 251 
 10.6 8.8
Salt 97 166 297 191 
 172.4 116.3Maize 
 137 251 297 
 203 
 139.2 
 111.5
Coal & Cokes 

Lime/Cement 	 89 89 

89 89
Other 	 229 352 222 259 9.2TOTALIMPORTS 	 7.4 
_.... 
 23 
 18.2 

Source: Economist's Working Paper, November 1990 



Appendix B 
List of Contacts 

William Brands, Project Development Officer, USAID/Lilongwe, Malawi 

Roger C. Ivens, Chief Executive, OILCOM, Oil Cpmpany of Malawi, Blantyre 

Evans Y. Somba-Banda, Manager, IPSU, Industry Petroleum Supplies Unit, Blantyre 

Bruce Currie, Commercial Manager, AMI Malawi Ltd, Blantyre 

M. Boulle, Managing Director, Grain and Milling Co. Blantyre
 

Donald W. Dzaipa, Personnel Director, David Whitehead Textile, Blantyre
 

B. M. Ndisale, General Manager, SFFRFM, Smallholder Farmers Fertilizers Revolving
Fund of Malawi, Blantyre 

F. W. Markham, General Manager, Malawi Railway Ltd., Limbe 

E. R. Limbe, Deputy General Manager, Malawi Railway Ltd., Limbe 

0. S. Mkandawire, Assistant General Manager (Personnel and Administration), Malawi 
Railway Ltd., Limbe 

Harry Thindwa, Assistant General Manager (Traffic), Malawi Railway Ltd., Limbe 

Maxwell F. Mlenga, Chief Traffic Manager, Malawi Railway Ltd., Limbe 

F. L. Mattenje, General Secretary, Railway Workers Union of Malawi, Limbe 

E. L. B. Malambo, Vice General Secretary, Railway Workers Union of Malawi, Limbe 

Wesley Crighton Kondomi, Chief Inspector of Works, Malawi Railway Ltd., Limbe 

W. B. Kunjawa, Creditors Sub Accountant, Malawi Railway Ltd., Limbe 

L. G. Sinjibani, Senior Division Clerk, Malawi Railway Ltd., Limbe 

Mr. Mgomezulu, Principal Secretary, Ministry of Labor, Government of Malawi, 

Lilongwe 

C. M. Manda, Assistant Labor Commissioner, Ministry of Labor, Government of 



Malawi, Lilongwe 

M. M. Z. Mzolwa, Deputy Secretary, Ministry of Labor, Government of Malawi. 
Lilongwe 
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